
Interactive Voting System

w
w

w
.iv

sy
st

em
.n

l

IVS-Professional 4.5



  



0819 

Manual 

 

 

IVS-Professional 4.5 
 



4 

Interactive Voting System 

The Interactive Voting System (IVS®) is an interactive means of making presentations and improving 

communication in all types of groups. It facilitates contact between speakers and listeners. The lis-

tener is able to react to the speaker and the speaker is able to respond in turn, thus creating an 

interaction. In this way, the passive listener becomes an active participant, which allows him to take 

greater part in the speaker’s presentation. 

IVS® consists of a network of keypads that pass on information to the cluster. This cluster collects 

the data and sends it to the software. IVS-Professional saves the information and presents the data 

in charts. 

The IVS® knows many applications. Besides support for congresses and seminars where the opinion 

of the entire group is measured, IVS® offers several other possibilities: 

Evaluation of a meeting By evaluating a meeting with IVS® the data is immediately available. 

Therefore the processing and reporting can be done much faster. Giving feedback to the audience 

is, in this case, not always wanted or needed. With IVS® you can decide whether you want to show 

the results immediately in a chart or evaluate the results afterwards. 

Measuring consensus If you want to know whether there is a basis for a decision within the 

company or within a group, you can use a rating question. Besides the results for the given ratings, 

this question also displays the mean value and the deviation. By first asking a reference question, 

e.g. “In which sector are you employed”, you can determine if there is a basis for the decision within 

a certain group. 

Knowledge check Within IVS® you can set up a correct answer. Per question you can set up 

multiple correct answers. This way it is possible to measure the knowledge level of the audience. 

This methodology is used in education and training situations. It is also possible to measure whether 

a group of people is informed about the changes within a company or within a specialty. 

Research IVS® stores the results of every keypad individually. This means that the system is anon-

ymous but that it is possible to tell which participant voted what on a question. The results can be 

exported to a spreadsheet application (like Microsoft® Excel™) or to a statistical application (like 

SPSS Statistics). This way it is possible to easily gain lots of information. 
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Introduction 

There are several software packages available to make use of the interactive voting system. These 

packages are used to make a presentation, that is also known as a script. A script contains a series 

of slides, that allow you to ask the questions. It is also possible to add text, images or videos to the 

slides, for instance to clarify a question. 

IVS-Professional is the most used software package of the available IVS software. With IVS-Pro-

fessional it is possible to ask both anonymous and identified questions. By voting anonymously, you 

can, for example, ask opinion questions, that only display the results of the total group. With an 

identified voting, you can ask knowledge questions, or even play a quiz, that can display the results 

per individual participant, or per group of participants. 

When you have an identified voting, IVS-Professional also offers the possibility of assigning vote 

weights to the participants. This makes the software extremely suitable for supporting shareholders 

meetings. 

The basic features, such as crossing the results with a reference question, and comparing the results 

of different questions, are also available in IVS-Professional. By comparing questions, the results of 

two or more questions are displayed next to each other in the same chart. But is it also possible to 

show the results of different questions in multiple charts, displayed next to each other. By crossing 

a question, the total results of a question are split up in separate references, that were previously 

determined by asking a reference question. 

IVS-PowerPoint is a software package that can be used as a plug-in in Microsoft PowerPoint. This 

allows you to easily add slides to a PowerPoint presentation, that show a question and allow you to 

vote. All the possibilities of PowerPoint are of course available. The IVS plug-in makes it possible to 

vote, cross and compare results. 

This manual describes how to use IVS-Professional to make a script. A separate manual is available 

for IVS-PowerPoint. 

You can use this manual as a textbook. You start with the first chapter, which explains how you can 

easily create a script with a question and answers. The following chapters describe how to extend 

the script, so that it can be used in a variety of application. Next, the manual explains how to connect 

the network and how you can vote with your script. Finally, with the aid of an example script, you 

will learn how to display the results of the various participants, and how to show the score of the 

individual participants or of groups of participants. 

Each chapter contains a number of steps, for example: 
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Select the template “Empty script (Widescreen 16:9)” and click OK to create a new script. 

You can perform these steps to create an example script, as described in this manual. By means of 

this example script you learn the various possibilities of IVS® and IVS-Professional. 
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Making a script 

Before you can support a meeting with IVS® you have to create a script. This script contains a number 

of slides. These slides can be presented during the meeting. 

You can place one or more images on a slide. Or you can place texts on a slide. However, the most 

important objects that can be placed on a slide are a question and the accompanying answers. The 

question determines what you want to know from your audience, while the answers indicate the 

choices your audience can make. You can also place a result diagram on a slide, in which the results 

of a voting are displayed, immediately after the audience has voted. 

Starting with a template 
After starting up IVS-Professional, the startup dialog appears. This dialog allows you to open an 

already existing script, or create a new script. 

If you start IVS-Professional for the first time, there are no existing scripts you can open. Therefore 

you start with a new script. 

The start-up 
dialog with a 

couple of 
templates 

 

To create a new script, you can choose from a number of templates. These templates determine what 

your script is going to look like. The template defines, among other things, which fonts and colors 

are used for questions and answers. 

Select a template with which you want to start your script and click on OK to create a new script. 
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Select the template “Empty script (Widescreen 16:9)” and click OK to create a new script. 

A new script has been created with one empty slide. 

A new script 
with one 

empty slide 

 

Making a question 
A question is an object that you can place on a slide. With this object you present the question you 

want to ask the audience. Together with the accompanying answers, you can have your audience 

vote to this question. 

Choose the 
option Ques-

t ion from the 
Insert  menu 
to create a 

question 

 

To insert a question, choose the option Question from the Insert menu. Alternatively, you can click 

the Question button ( ) in the toolbar or press the  on your keyboard. 

Choose the option Question from the Insert menu. 

A text window appears in which you can enter the text for the question. 
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The text win-
dow for en-

tering the 
question text 

 

Type the following question text: “Which of the following sports is not recognized as an official Olympic 

sport?” 

After you have entered the question text, you click on OK. The question will be inserted at the top of 

the slide. 

Click on OK to insert the question. 

The question 
has been in-

serted on the 
slide 

 

A question is automatically numbered. The number depends on the position of the question within 

the script. 
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Adding answers 
An answer is also an object that can be placed on a slide. With this object you present the possible 

answers to a question, so that the audience can make a choice. 

An answer is automatically numbered. The numbers of the answers correspond with the numbers on 

the keypad. 

Choose the 
option An-

swer  from the 
Insert  menu 
to create an 

answer 

 

To insert an answer you choose the option Answer from the Insert menu. Alternatively, you can 

click the Answer button ( ) in the toolbar or press the  on your keyboard. You can also press 

the  button on your keyboard provided that the question or an answer is selected. 

Choose the option Answer from the Insert menu. 

A text window appears in which you can enter the text for the answer. 

The text win-
dow for en-

tering the an-
swer text 

 

Type the answer text for the first answer: “Greek/Roman Wrestling”. 
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After you have entered the answer text, you click on OK. The first answer is inserted at the top of the 

slide just below the question. 

Click on OK to insert the answer. 

For adding more answers, you repeat these steps, until you have all the answers you need for an-

swering the question. You can insert up to 999 answers for answering a question. 

Repeat these steps to insert the following five answers: “Archery”, “Beach volleyball”, “Darts”, 

“Taekwondo” and “Tennis”. 

A question 
with six an-
swers is in-

serted on this 
slide 

 

Adding a result diagram 
A result diagram shows the results for the corresponding question. After having voted on a question, 

a bar chart is displayed in the result diagram, which shows the number of votes for each answer. 
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Choose the 
option Result  

from the In-
sert  menu to 

insert a result 
diagram 

 

To insert a result diagram you choose the option Result from the Insert menu. Alternatively, you 

can click the Result ( ) button in the toolbar or press the  on your keyboard. 

Choose the option Result from the Insert menu. 

The result diagram is inserted into the slide. Because there are no results yet, the result diagram is 

entirely empty. You only see the text “Question 1” at the top of the result diagram. This text indicates 

that this result diagram belongs to question 1 and will later display the results of question 1. 

The result di-
agram has 

been inserted 
into the slide 

 

It is recommended to save the script after having created a slide. 

Saving the script 
By saving the script, all the slides, including the images that are used on the slides, are saved. The 

script is saved in its own folder, where later on the voting results will also be saved. This way, eve-

rything that belongs to the script is conveniently stored on a fixed location. 
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To save the script, you choose the option Save from the File menu. Alternatively, you can click the 

Save ( ) button in the toolbar or press  +  on your keyboard. 

Choose the 
option Save  

from the File  
menu to save 

the script 

 

Choose the Save option from the File menu. 

The standard dialog box for saving files appears. Here you enter the name of the script. 

The standard 
dialog box 
for saving 

files 

 

After having entered a name, you click on the Save button to save the script. 

Enter the name of the script: “Starting with IVS-Professional” and click on Save to save the script. 

The name of the script is displayed in the title bar of IVS-Professional. 
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The name of 
the script is 
displayed in 
the title bar  

It is recommended to save the script regularly. 
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Using background slides 

A script consists of a number of slides on which you can place questions and answers, result dia-

grams, images and texts. Apart from the standard slides, a script consists of at least one background 

slide. On a background slide you can only place texts and images. 

A background slide is displayed behind a standard slide. The advantage is that objects, that you want 

to repeat on every slide, do not need to be inserted on each single slide again. You only have to 

insert them once on the background slide. Any object that is inserted on the first background slide, 

is automatically displayed on each normal slide.  

Go to the background slide 
To switch from standard slides to background slides, you choose the option Background slide from 

the View menu. Alternatively, you can click on the Background slide ( ) button in the lower 

toolbar. 

Choose the 
option Back-
ground slide 

from the 
View  menu to 
switch to the 
background 

slide. 

 

Choose the Background slide option from the View menu. 

The standard slide disappears and you see an empty slide. This is the first background slide. 
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The still 
empty back-
ground slide 

 

Inserting an image 
When you want to show an image on each slide in the script, you place it on the first background 

slide. This way, you can show for instance a company logo in the corner of each slide. 

To insert an image, you choose the option Image from the Insert menu. Alternatively, you can click 

on the Image ( ) button in the toolbar or press  on your keyboard. 

Choose the 
option Image  

from the In-
sert  menu to 
insert an im-

age 

 

Click Image from the Insert menu.  

A standard dialog box for opening files appears. Here you choose the location and select the name 

of the file you want to open. 
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The standard 
dialog box 

for opening 
files 

 

The most common file formats, like bitmap, JPG, PNG and GIF are supported. If you choose for a 

PNG format, transparency and semi-transparency are also supported. If you choose for a GIF format, 

transparency and animation are also supported. There are some limitations to the GIF format. You 

can only place one GIF image on a slide. If the GIF image is both transparent and animated, and you 

are moving the image to a new location, the background of the original location is also moved. The 

normal background can be restored if after moving the image you go to the previous slide and then 

go to the next slide. The background of an animated GIF image might also contain strangely colored 

pixels. 

After you have selected the file, you click on Open. The image is inserted into the background slide. 

Select an image and click Open to place on the background slide. 
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The image 
has been in-

serted in the 
background 

slide 

 

Selecting objects 
The image you just inserted is automatically selected. A selected object has four squares along the 

edges and four circles on each corner. When an object is selected you can move it, make it bigger or 

smaller or you can edit it. 

You can select an object by clicking on it with the left mouse button. You see the squares and circles 

appear immediately. To deselect an object you either select another object or you click on the slide 

with the left mouse button. 

Moving objects 
When an object is selected you can move it around on the slide. To move an object you click on it 

with the left mouse button and keep the button pressed. If you move the mouse the object will be 

dragged along. You can see this because the outline of the object moves with the mouse. The object 

itself will first stay on its original position. 
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The object is 
moved to the 
top right cor-

ner of the 
slide 

 

After you moved the object to its new position you release the mouse button. The object now moves 

to its new position. 

If you don’t want to move the object, you can press the  key while dragging the object. Moving 

the object will be canceled and the object stays at its original position. 

The object 
has moved to 
its new posi-

tion on the 
top right cor-

ner of the 
slide 
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To the normal slides 
After you have inserted an image on the background slide, you return to the normal slides. You do 

this by choosing the Standard option from the View menu. Alternatively, you can click on the Stand-

ard slide button ( ) in the lower toolbar. 

Choose the Standard option from the View menu. 

Choose the 
option Stand-
ard  from the 

View  menu to 
return to the 

standard 
slides 

 

You are now back at the standard slides where you see your first slide with the question and six 

answers. Behind this slide you see the image that you put on the first background slide. 

The back-
ground slide 
is displayed 
behind the 

standard slide 
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Working with results 

A result diagram is used to show the results of the voting. However, when you are making a script, 

no results are available yet. Therefore nothing is shown in the result diagrams. 

For a correct layout of your script, it would be handy when results would be displayed. This way, you 

can see for instance whether the bars are on the correct position and have the correct color or not. 

To display results when you are creating a script you can make use of example results. 

By using example results, it looks as if every question is voted. With every answer a random number 

of votes is displayed. With example results you can do almost everything you would when you had 

real results. However, you cannot export or print example results. And keep in mind: these are only 

random example results. 

Importing example results 
To display results in the script, whether they are real results or example results, you have to import 

them. To import results, you choose the option Import from the File menu. 

Choose the 
option Import  
from the File  
menu to im-

port example 
results 

 

Choose the Import option from the File menu. 

The dialog box for importing session appears. This dialog lists all the results that belong to this script. 

Because this script has not been used to vote with, there is only one session available, namely the 

one with example results. 
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Dialog box 
for importing 

sessions 

 

Select this session and click on OK to import the results from this session. 

Select the session “Example results” and click on OK. 

The example results are now displayed in the result diagrams. 

Example re-
sults are dis-
played in the 

result dia-
gram 

 

Formatting the result diagram 
The results are displayed in a bar chart. Each bar is shown below the corresponding answer. Behind 

each bar, the percentage of participants that have voted on this answer is shown. 

You can change how the results are displayed, according to your wishes. You could, for instance, 

choose to show absolute figures instead of percentages. Or you could show the results in a pie chart. 

To change the way results are displayed, you go to the properties of the result diagram. 

To go to the properties of the result diagram, you click on the result diagram with the right mouse 

button and choose the option Properties from the menu. 
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Click on the result diagram with the right mouse button and choose the Properties option from the 

menu. 

The dialog box Properties of result appears, in which you can change the properties of the result 

diagram. 

Dialog box 
with the 

properties of 
the result dia-

gram 

 

Results of question 

This shows the question of which the results are shown in this result diagram. When you insert a 

question, answers and a result diagram on a slide, the result diagram will automatically be linked to 

that question. Should you want to show more result diagrams for this question, this link would not 

be automatically made. You would have to manually link this result diagram to a question. 

Display 

The options under Display determine how the result diagram is displayed. 

Interactive When results are shown interactively, you can see the bars grow during voting. When 

results are not shown interactively, the diagram remains empty until the voting is closed. 

Show axes With this option axes are shown at the left and at the bottom of the chart. The text 

that is shown along these axes is determined by the options Values on axis, Legend text on 
axis and Use answer numbers as legend. 
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Values on axis Along the bottom axis values are shown that give an indication of the absolute 

value of each bar. The exact value is shown with each bar. Depending on the available space, the 

values are shown in steps of 5 or 10 or even greater. This option is only available when Show axes 

is also enabled. 

Normalize to 100% The largest bar in the chart will be displayed using all available space in the 

chart. When the largest bar represents 43.4% it will be displayed from the bottom to the top of the 

chart. With the option Normalize to 100% enabled only a bar that represents 100% is displayed 

using all available space. A bar representing 43.4% will use about half the available space. 

Cross/Compare to 100% When crossing or comparing two or more questions, the total number 

of votes for all questions are taken to the same level. When this option is not checked, the bars in 

the chart are based on the absolute number of votes. A bar with four votes is therefore smaller than 

a bar with six votes. When displaying the results in percentages, the bar with four votes is still smaller 

than the bar with six votes. However, the bar with four votes can have a result of 25%, while the 

bar with six votes can have a result of 20%. This will make 25% look less than 20%. When this 

option is checked, the bars in the chart are based on the percentage of votes. A bar with 25% of the 

votes is bigger than a bar with 20% of the votes. 

3D chart The chart is displayed three-dimensionally. Disable this option if you want a flat chart. 

Walls transparent The left wall and the bottom wall of the chart can be made transparent with 

this option. If they are not transparent, they will use the color set at Primary color. This option is only 

available if the 3D chart option is also enabled. 

Full frame in chart By default, only the left and bottom wall are visible. With this option you can 

also show the right and top wall. These two walls are only represented by a line. 

Always show correct answer With this option the correct answer is shown immediately upon 

closing the voting. This means that all bars belonging to a correct answer will be shown in green, 

and all bars belonging to a wrong answer will be shown in red. See also “Showing the correct an-

swer“ on page 99. 

From right to left This option allows you to display a mirrored result diagram. The bars are shown 

from the right to the left instead of from the left to the right and the legend is on the left side of the 

chart instead of on the right side. This option is only available if your computer is set up to use from-

right-to-left languages, like for example Arabic. 

From top to bottom  With this option the bars are displayed from top to bottom. Normally the 

bar belonging to answer 1 is displayed at the bottom of the chart – in the case of a bar chart – or on 

the left in the chart – in the case of a column chart. By enabling this option, the bar belonging to 

answer 1 appears at the top of the chart or at the right of the chart. 
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Legend 

Apart from the answer text, each answer also has a legend text. In most cases the legend text is the 

same as the answer text. Only when the answer text is too long, the legend text will be a shortened 

version of the answer text. 

In the result diagrams, the legend texts of the answers can be displayed in various ways. 

Legend text on axis This option shows the legend text of the answers along the bottom axis of 

the result diagram. When the text of one of the answers it too long, it could happen that the legend 

text of the adjacent answers is not shown. You can solve this either by selecting Use answer num-

bers as legend or by shortening the legend text. The option Legend text on axis is only avail-

able when the option Show axes is also enabled. 

Use answer numbers as legend Instead of the legend text, you can also show only the numbers 

of the answers. This option is only available when both the options Show axis and Legend text 

on axis are enabled or when Always display legend is enabled. 

Rotate legend text 45° When the legend text is displayed along the axis, you can use this option 

to rotate the text 45°. This option is especially useful when the legend texts are too long, which 

causes that not all of the texts are shown. When the legend text is rotated, it can always be displayed. 

This option is only available when the options Show axes and Legend text on axis are also 

enabled. 

Always display legend Besides showing the legend texts along the axis, it is also possible to 

show a separate legend. This can be done by enabling the option Always display legend. The 

legend will be displayed on the right side of the result diagram. 

Only with pie chart Because it is not possible to show a legend along the axis of a pie chart, this 

option offers the possibility to show a legend with a pie chart. The legend is not shown with a bar 

chart, a line chart or a 3D area chart because these charts have the legend along the axis. This option 

is not available when the option Always display legend is enabled. 

Only with crossing or comparison This option only shows a legend when the results are 

crossed or compared. In that case, the legend shows what the crossing or comparison represents. 

This option is not available when the option Always display legend is enabled. 

Background 

The background of the result diagram can be changed. You can choose from one single color, a 

gradient from one color to the other color, or an image as the background, or you can leave the 

background transparent. These different options are almost the same as those of the slide. For a 

more comprehensive description, see “Background“ on page 50. 
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Single color The background is displayed as one single color. The desired color can be chosen by 

clicking the Color button behind Primary color. The walls of the chart are also displayed in a darker 

and lighter tone of this primary color, unless the option Walls transparent is enabled. 

Gradient The background is displayed as a gradient from one color to another. The desired colors 

can be chosen by clicking the Color button behind Primary color and behind Secondary color. From 

the list under Gradient direction, you can choose the direction of the gradient. The direction is always 

given from the primary color to the secondary color. If you choose the option From bottom to top, 

the primary color is displayed at the bottom and the secondary color at the top. 

Image With this option you can display an image as the background. By clicking the Browse button 

( ) under File name, you can select a file that you want to use as an image on the background. The 

image will always be stretched, to fit in the available space of the result diagram. 

Transparent This option makes the background transparent, so that you can see the slide through 

the result diagram. The walls of the chart are not automatically made transparent. Use the option 

Walls transparent to do this. 

Select the options Show Axes and 3D chart from the Display options and Transparent from the Back-
ground options with white as the Primary color. 

Setting up the chart 
The dialog box Properties of result consists of four tabs. The first, Result, contains the options that 

relate to displaying the result diagram. The second, Chart, contains the options that relate to dis-

playing the chart in the result diagram. The third, Cross & Compare, contains options for displaying 

a crossing or comparison. And the last one, Font, contains options for setting up the font for all texts 

used in the diagram. 

Click on the Chart tab at the top of the dialog box. 
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Dialog box 
with the 

properties of 
the chart 

 

Chart type 

You can choose from a variety of charts to display the results. The most used chart types are the bar 

chart and column chart. But you can also choose a pie chart, a line chart or a 3D area chart. The 4-

quadrant chart is a special chart type. In this chart, the results of two consecutive questions are 

displayed. The results of the first question are displayed along the X-axis, while the results of the 

second question are displayed along the Y-axis. If you choose for this chart type, you will be notified 

of the fact that this is a special chart type, that cannot be used just like the other chart types to 

display the results of a voting. 

Bar chart 

If you display your results in a bar chart or column chart, you can also choose how the bars or columns 

should be displayed. You can choose from thirteen different types. Furthermore you can select the 

width of the bars or columns. This width can vary from 5% up to 100% of the available space. The 

width is adjustable in 5% steps. The default width is 50%. 

If you choose the type ‘Rectangle with gradient’ you can have the bar color gradually fade from a 

starting color at the beginning, if necessary through a second color in the middle, to a final color at 

the end. Under Start color you choose the color with which all bars should start. The bars all end 

in a color that you have set in the properties of each corresponding answer. If necessary, you can 
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choose a third color that is used in the middle of the bar. Besides, you can also indicate the direction 

of this gradient. The direction is given from the selected starting color to the final bar color. 

The option Frame around bar determines whether or not the thin black line is displayed around 

each bar. 

Results 

The results that are displayed with each bar, can both be displayed in percentages and absolute 

values. 

Absolute The results are displayed in absolute values. 

Percentages The results are displayed in percentages of the total number of votes. 

Absolute/Percentages The results are displayed both in absolute values and in percentages of 

the total number of votes. 

Percentage of total The results are displayed in percentages of the total number of votes. Besides 

that, the total number of votes is also displayed. 

Percentage relative to total voters This option is only applicable when this question can be 

voted more than once. The results are displayed in percentages relative to the total number of par-

ticipants that voted at least once. Because there can be more votes than there are participants – 

each participant can vote more than once –, this percentage can be more than 100%. 

Absolute/Percentages relative to total voters The results are displayed both in absolute 

numbers and in percentages relative to the total number of voters. 

Legend This option displays the legend texts instead of the number of votes. 

If you choose to display the results in percentages, you can enter the number of digits behind the 

decimal point under Number of digits. This can vary from 0 to a maximum of 5 digits behind the 

decimal point. 

With the option Maximum number of bars you determine how many bars you would like to 

display at most in this diagram. The default value is 0, which will display all bars. If you want to 

show less bars than the number of answers, for example to show the ten most important answers 

from a series of 25, you can indicate that here. 

The option First displayed bar determines which bar will be the first one to be displayed in the 

diagram. All bars preceding this bar will not be displayed. You can combine this option with the 

Maximum number of bars option to determine which range of bars you want to display. This 

allows you to divide a series of 20 answers across two diagrams. For both diagram, you set the 

Maximum number of bars to 10. For one diagram, you set First displayed bar to 1. For the 

other, you set this to 11. One diagram will now show the first ten bars and the other will show the 

second ten. 
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Values with bar 

Together with each bar, the total number of votes of the corresponding answer is displayed. You can 

indicate whether these values are to be displayed or not, and if so, where they should be displayed. 

You can also adjust the text color and the background color of these values. 

Display values The results of each answer are displayed along with the bar. Use Text color to 

choose the text color in which these results are displayed. 

Display background A colored area is displayed behind the results which improves the legibility. 

Use Background color to select the color of this area. 

Distance to bar With this option you indicate at what distance the result should be displayed from 

the bar. The higher this value, the further the result will be displayed from the bar. The value can be 

both positive and negative. A positive value indicates that the result will be displayed outside the 

bar, a negative value indicates that the value will be displayed inside the bar. 

Select Rectangle with gradient as type under Bar chart. Then click on the Cross & Compare tab. 

Settings for crossing and comparing 
In the third tab of the Properties of result dialog box you can set up how a crossing or comparison 

will be displayed. Normally, both a crossing and a comparison display the bars next to each other. 

Dialog box 
with the 

properties for 
crossing and 

comparing of 
questions 

 



36 

Cross 

Here you indicate how the bars are to be displayed when crossing a question. 

Side by side The bars of the various references are displayed side by side. 

Stacked The bars of the various references are stacked on top of each other. 

Stacked to 100% The bars of the various references are stacked on top of each other. Additionally 

all stacked bars have the same height. 

Front-to-back The bars of the various references are displayed behind each other. If you want to 

use this option, make sure that the option 3D chart is also enabled. 

With the option Immediately cross with question you can indicate that the results in this chart 

should immediately be crossed with another question. In that case, you don’t have to cross the results 

manually. Enter the number of the question with which you want to cross the results in this chart. If 

you want to cross the results manually, leave this value set to 0. For more information about crossing, 

see “Crossing results“ on page 82. 

With the option Immediately show multiple-choice distribution with question you can 

indicate that you immediately want to show a multiple-choice distribution of the results in this chart. 

In that case, you don’t have to display a multiple-choice distribution manually. Enter the number of 

the question with which you want to show the multiple-choice distribution. A multiple-choice distri-

bution can be useful for questions that can be voted more than once. The multiple-choice distribution 

shows how many participants chose a particular range of answers, for example, four participants 

chose answer 1, 2 and 3, two participants chose answer 1, 2 and 5, etc. 

Compare 

Here you indicate how the bars are to be displayed when comparing a question. The options are the 

same as for a crossing. 

With the option Immediately compare with question you can indicate that the results in this 

chart should immediately be compared with another question. In that case, you don’t have to com-

pare the results manually. Enter the number of the question with which you want to compare the 

results in this chart. If you want to compare the results manually, leave this value set to 0. For more 

information about comparing, see “Comparing results“ on page 93. 

Split 

With the option Immediately split to reference/choice you want indicate that the results in 

this chart should immediately be split. This option is only applicable to results that are crossed, or to 

results of a question that can be voted more than once. To split crossed results, you enter the number 

of the reference that you want to show in this chart. To display a certain choice from a question that 

could be voted more than once, you enter the number of the choice. For more information about 

splitting, see “Splitting a crossed question“ on page 87. For more information about displaying a 

certain choice, see “Showing the different choices“ on page 113. 
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Adjust 

When you cross or compare a question and display the bars next to each other, they will become a 

lot smaller. The font used to display the values along with the bars can then become too big com-

pared to the bars. These options allow you to automatically reduce or enlarge both the font size and 

the bar size when you cross or compare the question. 

Adjust font size to Here you choose a percentage of the original font size. For example, if you 

choose 70%, the font size used for a crossing or comparison will be reduced to 70% of the original 

font size. 

You can set up a percentage in steps of 1%, with a minimum of 5% and a maximum of 200%. 

Adjust bar width to Here you choose a percentage of the original bar width. For example, if you 

choose 50%, the bars will be displayed at half the original size during a crossing or a comparison. 

You can set up a percentage in steps of 1%, with a minimum of 5% and a maximum of 100%. 

Click on the Font tab. 

Setting up the font 
In the last tab of the Properties of result dialog box you can set up the font that is used by the result 

diagram. 
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Dialog box 
with the 

properties for 
the fonts 

used in the 
chart 

 

In this dialog you can set up the font used for all texts in the result diagram. You can also set up the 

font style, the size and the color of the font used. The font color will only be used by texts displayed 

along the axes. The text color for texts displayed with the bars can be set up separately on the Chart 
tab. 

Click on OK to apply the changes. 
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A horizontal 
three-dimen-

sional bar 
chart with a 
gradient in 

the bars 
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Changing the layout of the slide 

When inserting the question, answers and the result diagram, they were inserted into the slide at a 

default position. This default position is determined by the template that was used. The default tem-

plate that was used to design this script, was designed to display the bars in the chart just below the 

answers. This setting however, was based on five answers instead of six answers that are used in 

this script. 

After inserting all objects, they can be moved to the correct location. The example results that you 

just imported can help you in positioning the answer texts. 

Finally you can add a suitable background to your slide. 

Enlarging and reducing objects 
When an object is selected, four squares will appear along the edges and four circles appear on the 

corners. You can use these squares and circles to enlarge or reduce an object. By placing the mouse 

on one of the corners of the selected object and then clicking on it with the left mouse button, you 

can move this corner, which enlarges of reduces the size of the selected object. If you move the 

mouse, the outline of the object moves along with the mouse. The object itself will first stay at its 

original position. Only when you release the left mouse button, the object will get its new size. 

The bars in the chart are covering the answers. To prevent this, you can reduce the size of the chart a 

little, so that the left edge of the chart ends just behind the answers. To do this, place the mouse pointer 

on the middle square at the left side of the chart, click on it with the left mouse button and keep it 

pressed. Move the mouse to the right to reduce the size of the chart. 
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The object is 
reduced in 

size so that 
the bars no 

longer cover 
the answers 

 

Release the mouse button when the object reaches the correct size. The object changes to its new 

size. 

Release the left mouse button when the object has its desired size. 

The object 
has been re-

duced in size, 
so that the 

bars no 
longer cover 
the answers 

 

Similarly, you can move the right side of the question a little to the left, so that the text of the 

question is no longer displayed on top of the logo. 

Select the question, click on the center square on the right and drag it to the left, so that it is well in front 

of the logo. 
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The question 
is made a lit-
tle smaller so 

that it is no 
longer on top 

of the logo 

 

Positioning answers 
The answers are all perfectly aligned, but the in-between distance is fairly large. By moving the 

answers closer to each other, they can be aligned with the bars in the bar chart. 

First, select the lower answer and move it upwards until it is in a horizontal line with the lower bar 

of the chart. Make sure the answer is moved a little to the right compared to the other answers. 

Select answer 6 and drag it upwards until it is in line with the lower bar of the chart. 

The last an-
swer is 

moved until it 
is in line with 
the lower bar 
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Selecting more than one object 
The last answer is now aligned with the lower bar in the graph, but the alignment with all the other 

answers has disappeared. The answer is too far to the right. Therefore this answer has to be aligned 

again with the other answers. 

If you keep the  key pressed while selecting objects, you can select multiple objects at once. If 

you do not use the  key you can select only one object at a time. 

The last answer is still selected. Press the  key and then select the second last answer. 

Both the last 
and the sec-

ond to last 
answer are 

selected 

 

Aligning objects 
By aligning objects, they are neatly put under each other, or next to one another. To do this, you 

choose the option Align or distribute from the Edit menu and then select one of the ten available 

options to align or distribute your selection. Alternatively, you can click on one of the selected objects 

with the right mouse button and choose the option Align or distribute from the menu, or you can 

click on one of the button in the Align or distribute toolbar at the bottom of the screen. 
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The Align or 
d istr ibute  

menu offers 
ten different 

options to 
align or dis-
tribute your 

selection 

 

Aligning horizontally 

The first four options determine the horizontal alignment. 

Align Left The selected objects are aligned with their left side at the same position. The most left 

object is used as a reference. Therefore this object is not moved while all other objects are moved to 

the left. 

Align Center The selected objects will be centered. The point of reference is the center between 

the left edge of the most left object and the right edge of the most right object. All selected objects 

will use this point of reference as their center. 

Align Right The selected objects are aligned with their right side at the same position. The most 

right object is used as a reference. 
Align Left and Right The selected objects are both left and right aligned. The left edge of the 

most left object and the right edge of the most right object are used as a reference. 

Aligning vertically 

The next four options determine the vertical alignment. 

Align Top The selected objects are aligned with their top edge at the same position. The top most 

object is used as a reference. Therefore this object is not moved while all other objects are moved 

up. 
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Align Middle The selected objects will be centered. The point of reference is the center between 

the top edge of the top most object and the bottom edge of the bottom most object. All selected 

objects will use this point of reference as their center. 

Align Bottom The selected objects are aligned with their bottom edge at the same position. The 

bottom most object is used as a reference. 

Align Top and Bottom The selected objects are both top and bottom aligned. The top edge of 

the top most object and the bottom of the bottom most object will be used as a reference. 

The options for aligning objects are only active when two or more objects are selected at the same 

time. If you use the option Relative to Slide, the options for aligning objects are active when one 

or more objects are selected at the same time. 

Distribute 

The last two options determine how the selected objects are distributed. 

Distribute Horizontally The selected objects are equally distributed between the most left and 

the least left object. These two remain at the same place while all other objects are equally distrib-

uted between those two objects. 
Distribute Vertically The selected objects are equally distributed between the top most and the 

bottom most object. These two remain at the same place while all other objects are equally distrib-

uted between those two objects. 

The options for distributing objects are only active when three of more objects are selected at the 

same time. 

Relative to Slide 

When aligning objects, one of the objects is always used as a reference. If you select the option 

Relative to Slide it is not one of the objects that is used as a reference but the slide itself. For 

instance, if you choose the option Align Left, all selected objects will be aligned to the left edge of 

the slide. 

Choose the Align or distr ibute option from the Edit menu and then the Align Left option. 
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Both selected 
objects are 

aligned with 
their left 

edge 

 

Now that the last answer is at the correct position, all the other answers can be correctly positioned 

the same way. 

Deselecting objects 
Both answers are still selected. You have to deselect them first. To deselect any object, you click 

somewhere on the slide where there are no objects. You can then select a new object to be moved. 

Alternatively you can choose the option Deselect all from the Edit menu, or press  +  on the 

keyboard. 

First click anywhere on the slide where there are no objects to deselect both selected answers. Then click 

on the first answer, this will be selected. Drag the answer down so that it ends up at approximately the 

same position as the first bar in the graph. Hold down the  key while moving, so that the answer is 

only moved vertically. Its left side remains at the same position. 
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Answers 1 
and 6 have 

been moved 
so that they 

are at the 
same height 

as the bars in 
the chart 

 

Distributing objects 
The first and last answer are now at the same height as the bars in the chart, but the other answers 

are still too high or too low. By selecting all the answers again and then aligning and distributing 

them, they can easily be aligned to one another and put at the same height as the bars in the chart. 

The first answer is still selected. The others can be selected by keeping the  key pressed and 

subsequently clicking on each answer. 

Press the  key and subsequently click on the answers 2, 3, 4, 5 and 6. 

To distribute the answers so that they are put neatly in front of the bars, you choose the Distribute 

vertically option from the Align or distribute menu. The selected objects are distributed equally 

between the top most and the bottom most object. 

In the Align or distribute toolbar at the bottom of the screen, click on the Distribute vertically button 

( ). 
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All answers 
are neatly 

aligned and 
they are on 

the same 
height as the 

bars in the 
chart 

 

Customizing the slide 
You can not only customize the properties of objects, but you can also customize the properties of 

the slide. You can provide each slide with a description, change the background color and select 

which background slide you want to display with this slide. 

You go to the properties of the slide by choosing the option Properties from the Edit menu. Alter-

natively, you can click the Properties ( ) button in the toolbar, click on the slide with the right 

mouse button and choose the option Properties from the menu or you can press  +  on 

your keyboard, provided that no objects are selected. 

Click on the slide with the right mouse button. Choose the option Properties from the menu. 

The dialog box Properties of slide appears in which you can customize the properties of the slide. 
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Dialog box 
with the 

properties of 
the slide 

 

Description 

You can provide each slide with a description. This makes it easier to find a certain slide later. 

As a description for this slide you enter: “Slide with question about Olympic sport”. 

Background slide 

A background slide can be displayed behind each normal slide. Using this background slide, you can 

easily repeat objects, that are automatically displayed on every slide. 

Use background slide Select this option if you want to display a background slide behind the 

current slide. From the dropdown list below this option, you then choose the background slide that 

you want to display behind this slide. 

Jump 

Use this option to indicate that you don’t necessarily want to go to the next slide when you press  

or . Enter the number of the slide you want to jump to. If you simply want to go to the next slide, 

enter a 0. 
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IVS-Online 

If you let your participants vote via IVS-Online, you can show this slide to the online participants. If 

the option Show this slide in IVS-Online is selected, this slide will be shown to the online par-

ticipants as an image. This option is only available if you have an IVS-Online license. For more infor-

mation about voting via IVS-Online, see “Voting with the smartphone via IVS-Online“ on page 231. 

Setting up the background 
The second tab in the Properties of slide dialog contains options that can be used to set up the 

background of the slide. You can select the color of the slide, choose to display a gradient or even 

select an image to be used as the background. 

Click on the Background tab, at the top of the dialog. 

Dialog box 
with the 

properties of 
the back-

ground of the 
slide 

 

Background 

The background of a slide can be customized. You can choose from one single color for the entire 

slide, a gradient from one color to another color, or you can use an image as the background. 

Single color 

If you want your background to be one single color, you select the Solid Fill option. Next, you click 

the Color ( ) button behind Primary color to select the desired background color. 
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If you click on the color area of the Color button, the standard Windows color dialog box appears. 

You can choose a color from this dialog box or define a custom color. 

Standard 
color dialog 

box with cus-
tom colors 

 

If you want to use a specific color from your script, but you don’t know exactly which color this is, 

you can pick up the color using the color picker ( ). When you click on the color picker, the mouse 

cursor changes in a color picker. You then click on the color you want to use. The selected color can 

be found in the Custom colors section of the standard color dialog box. 

If you click on the small arrow of the Color button, a menu appears from which you can select various 

colors. 

Color menu 
with a num-

ber of colors 

 

Here too you can define a custom color by clicking on the More colors button. 

Color menu 
with a num-

ber of colors 
and the op-

tion to define 
a custom 

color 

 

Gradient 

If you want to make a more dynamic slide, you can use a gradient. Select the option Gradient Fill. 

Next, you click on the Color button behind Primary color to select the primary color. This color is 

used at the top of the slide. Then you click on the Color button behind Secondary color to select the 
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secondary color. This color is used at the bottom of the slide. The background of the slide will show 

a gradient from the primary color at the top of the slide to the secondary color at the bottom of the 

slide. From the dropdown list Gradient direction you can choose another direction for the gradient. 

Directions are indicated from the primary color to the secondary color. 

Image 

To completely customize the slide, you can use an image as background. Select the Picture Fill 
option. You can now select a file that is going to be used as a background image, by clicking on the 

Browse ( ) button. A standard dialog box to open files appears. Select a location and the name of 

the file you want to open. 

From the dropdown list Image position you can choose how the image is displayed on the slide. 

Fill The image is scaled so that the smallest edge fits along the smallest edge of the slide. A part of 

the image might be cut off the make the image fit. 

Fit The image is scaled so that the largest edge fits along the largest edge of the slide. Part of the 

background color of the slide might stay visible. 

Stretch The image is scaled so that it fills the entire slide. The original image ratio is not taken into 

account, which might lead to the image being stretched. 

Tile The image is placed in the top left corner of the slide and is repeated both horizontally and 

vertically until it fills the entire slide. 

Center The image is displayed in the center of the slide. Part of the image might be cut off if the 

image is larger than the slide, or part of the background color of the slide might stay visible when 

the image is smaller than the slide. 

If you want the image to fill the entire slide, use an image of 1280 x 800 pixels for a widescreen 

slide, or of 1024 x 768 pixels for a normal slide. 

Select the Image Fill option. Then, click on the Browse button and select an image. Click on Open to 

use it as a background. Select Center for the Image position. 
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An image is 
used as the 

background 
for the slide 

 

Changing texts 
Once the question and the answers are inserted, it is possible to change the text, but also the font, 

the size and the color afterwards. 

By double-clicking the question or the answer, the same text window appears as when inserting the 

question or the answers. 

Double-click the question to change the font. 

To edit the 
question, the 
text window 
for entering 
the question 
text appears 

 

The text of the question is displayed in the text window. The text is selected, so that you change or 

replace the text immediately. 
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In the toolbar at the top of the text window you can choose a different font and size for the text. 

You can make the text bold, italicized or underlined. You can use superscript or subscript. You can 

convert small letters to capitals. You can left align a paragraph, center it, right align it or justify it, 

change the line spacing, display the text from-left-to-right or from-right-to-left, display bullets in 

front of each paragraph, use paragraph numbering, indent the paragraph less or more, align the text 

vertically, and change the text color. 

Change the font to Myriad Pro, 28 points, bold and the color to dark gray. If you don’t have Myriad Pro, 

you can also use Tahoma, 24 points, bold. Click on OK to apply the changes. Do the same to change the 

font of the answers to Myriad Pro, 20 points, bold and the color to dark red. 

The font and 
color of the 

question text 
and answer 
texts have 

been changed 

 

Making a new slide 
Your first slide is now entirely ready. You have inserted a question with some answers and a result 

diagram to show the results. You put a logo on the background slide and changed the background 

of the slide, so that it shows an image. You aligned the answers to the bars in the chart and finally 

you changed the font and color of the question text. Now you are ready to create the next slide. 

To create a new slide, you simply go to the next slide. Press the  key on your keyboard. Alterna-

tively, you can press  or click on the Next slide ( ) button in the lower toolbar. 

Because you have only made one slide and there is no next slide, you will be asked if you want to 

add a new slide. Click OK to add a new slide. The new, empty, slide is shown. In the top right corner 

you will see the logo that you inserted on the background slide. 

Press  to go to the next slide. Click on OK to insert a new slide. 
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A new, empty 
slide has been 

inserted 

 

The new slide looks exactly like the first slide you started with. To prevent you from customizing the 

background, adjusting the text and positioning the question and answers over and over again, each 

time you create a new slide, you can adjust these default properties once so that every next slide 

you create will look the same. These default properties can be adjusted in the template. 
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The template 

Besides standard slides and background slides, there is a third type of slide in a script. This slide, of 

which each script has only one, is the template. On the template slide you will find a question, two 

answers, a result diagram, a text and a timebar. You can only change the properties of these objects. 

Adding or removing objects is not possible. 

All the object properties you change in the template are automatically applied to all objects on the 

standard slides and on the background slides of the script. For example, you can change the font 

and the text color of the question in the template. These changes will be applied to all questions in 

your script, with the exception of those questions that you manually change the font or text color of. 

You could change the properties in the template before you start making a script. This way, all the 

slides in your script will look the same. But you could also make changes in the template afterwards. 

And you can save the template separately, so that you can later use it in another script. 

Go to the template 
To switch from the standard slide to the template, you select the option Template from the View 

menu. Alternatively, you can click on the Template ( ) button in the lower toolbar. 

Choose the 
option Tem-

plate  from 
the View  
menu to 

switch to the 
template 

 

Choose the option Template from the View menu. 

The standard slide disappears and the slide of the template is shown. 
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The template 
slide with the 
standard ob-

jects that you 
can adjust 

 

Customizing the slide 
In the template you can change several properties of the slide. All new slides that you create later 

will automatically get these properties. 

You go to the properties of the slide by choosing the option Properties from the Edit menu. Just 

like when customizing the properties of the standard slide, you will see the Properties of slide dialog 

box. Here you can change the properties of the slide. 

Click somewhere on the slide with the right mouse button and choose the option Properties from the 

menu. 
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Dialog box 
with the 

properties of 
the template 

slide 

 

You can only change the background of the slide in the template. This is done in the same way as 

changing the background of the standard slide. See “Customizing the slide“ on page 48 for a de-

scription. 

Because the settings of the template are also used for IVS-Online, you can set a few extra options 

here, which are used specifically for IVS-Online. These options are only available if you have an IVS-

Online license. 

If you enable the Always use a solid fill background for slides on IVS-Online option, the 

background slide used for IVS-Online will always have a solid color, regardless of the Fill setting. 

For example, you can use an image as background for your slides in IVS-Professional, while the 

background has a solid color for online users. 

The Logo filename option allows you to select an image that will be displayed as a logo at the top 

of the slide in IVS-Online. With Logo position you determine whether the image is displayed on 

the left, right or in the middle of the slide. The logo is always displayed half the size of the selected 

image, with a maximum height of 512 pixels. 

Change the background just like you changed the background of the first slide. That is, you choose the 

option Image, click on the Browse button and select the same file that you selected for the first slide. 
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An image is 
used as the 

background 
of the slide 

 

Customizing the result diagram 
To have the results look the same on each slide, you change the result diagram on the template. To 

do this, you go to the properties of the result diagram, by clicking on the result diagram with the 

right mouse button and choosing the option Properties. See “Formatting the result diagram“ on 

page 28 and “Setting up the chart“ on page 32 for a description. 

Changing the bar colors 
You can set up a bar color for each of the answers. This color is normally selected using the properties 

of each answer. But because there are only two answers available in the template, you can select 

the colors here using the properties of the result diagram. 

Go to the properties of the result diagram and select the Colors tab. 
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Setting up 
the bar colors 

for the an-
swers 

 

You will see an overview of the bar colors for the first twenty answers. You can set up a color per 

answer. If you use more than twenty answers, the answers 21 to 40 will get the same color as answer 

1 to 20. 

Same colors 

To set up the same color for each of the answers, you can make use of the Same colors button. You 

first setup the desired color for the first answer. Then click on the Same colors button. All answers 

will get the same bar color as the first answer. 

Gradient 

With the Gradient button you can have the bar colors gradually change from one color into the other 

color. First set up the desired starting color for the first answer. Then you set up the desired ending 

color for one of the other answers. When you now click on the Gradient button the colors will grad-

ually change from the starting color of the first answer to the ending color of the answer you set up 

last. 

Repeat 

After having set up the colors for the first view answers, you can have these colors repeated for the 

remaining answers by clicking on the Repeat button. For example, if the last color you set was the 

sixth answer, and you then click the Repeat button, answer 7 to 12 will get the same colors as 
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answer 1 to 6, as will answer 13 to 18. And finally answer 19 and 20 will get the same color as 

answer 1 and 2. 

Set the color of the first answer to white. Then click on the Same colors button to also set the color of 

all the other answers to white. Click on OK to close the properties window. 

Moving answers 
The position of the two answers on the template slide determines the position of new answers on 

the standard slides. The position of the first answer determines where the first new answer will be 

positioned. The position of the second answer determines where the second new answer will be 

positioned. The third new answer will automatically be positioned on the same distance from answer 

two, as answer two is positioned in relation to answer one. The distance between both answers on 

the template therefore determines the distance between all subsequent answers. 

Using the grid 
When moving answers, you can freely move them around the slide. To align the answers, so that 

each answer has its left side on the same position, you use the option Align or distribute from the 

Edit menu. See also “Aligning objects“ on page 43. 

Another method to left-align the answers is by using the grid. When you activate the grid, you will 

see a grid of dots displayed on the slide. You can have all objects automatically align to these dots. 

You can activate the grid, by selecting the option Display grid from the View menu. Alternatively 

you can press  +  +  on the keyboard. 

From the View menu, choose the Display  grid option. 

A grid of dots is now displayed on the slide. 
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The grid has 
been acti-

vated which 
allows for au-

tomatic ob-
ject align-

ment 

 

After activating the grid, you have to set up how you want the objects to automatically align to the 

grid. You can choose to have an object automatically align horizontally only, or vertically only, or 

both horizontally and vertically. 

To do this, you select the option Snap to grid from the View menu, and then you select the option 

Horizontal or Vertical. 

Select the option Snap to grid from the View menu and subsequently select the option Horizontal. 
Make sure the option Vertical is switched off. 

When moving an object around, you can place it very precisely vertically, but horizontally it will 

always be placed on a grid marker. This allows you to easily align the objects. 

Alternatively, you can move objects in a horizontal or vertical direction only by keeping the  key 

pressed while moving the object. As long as you keep the  key pressed, you can move the object 

only in a horizontal direction, or only in a vertical direction. If you release the  key, you can 

move the object in any direction again. 

Move the result diagram somewhat to the left, so that the left side is placed exactly on a grid marker. 

For the remainder of this manual, the grid is no longer used. You can deactivate the grid by selecting 

the option Display grid from the View menu again. You also have to deactivate the option Snap to 

grid from the View menu, to prevent objects from still being aligned to the grid. 

Select the option Display  grid from the View menu to deactivate it. Select the option Snap to grid 

and then Horizontal from the View menu to deactivate this. 
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When the grid markers are placed too close to each other, or even not close enough to each other, 

you can change the distance between the markers. You can do this in the preferences of IVS-Profes-

sional. See “Preferences“ on page 231 on how to do this. 

Customizing the texts 
The last customization that needs to be done to make the template look like the first slide is reducing 

the size of the question’s textbox and adjusting the font of the question and the answers. 

If you want to change the font of the answers, you only have to do this for the first answer. The other 

answer changes automatically. 

Reduce the size of the question’s textbox on the right side and at the bottom. Also place the textbox 

somewhat higher on the slide. Next, double-click the question to change the font to Myriad Pro, 24 

points, bold and change the color to dark gray. Click on OK to apply the changes. Finally, double-click 

on the first answer to change the font to Myriad Pro, 20 points, bold and the color to dark red. Click OK 

again to apply the changes. 

The textbox 
of the ques-

tion has been 
adjusted and 
the font and 
color of the 

question and 
answer texts 

have been 
changed 

 

To the standard slides 
After you have adjusted the background of the slide, the question text and the answers, you return 

to the standard slides. To do this, choose the option Standard from the View menu. Alternatively, 

you can click on the Standard slide ( ) button in the lower toolbar. 

Click on the Standard slide button in the lower toolbar. 
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The standard 
slide has 

changed to 
follow the 
settings in 

the template 

 

You can see that the slide has changed to follow the settings in the template. 

Reapplying the template 
The changes you made in the template do not entirely match the changes you made before on the 

first slide of your script. The first slide still differs from the template. 

If you go back to the previous slide you can see that some of the settings from the template are 

applied to this slide, and some are not. You can go back one slide by clicking on the Previous slide 

button ( ) in the lower toolbar. Alternatively you can press  or  on the keyboard. 

Go back to the previous slide by pressing  on the keyboard. 

Normally, all setting are taken from the template. If you make changes to the template and then 

return to the normal slides, all these changes are immediately followed by the normal slides. How-

ever, if you make changes to a normal slide so that it differs from the template, then this slide will 

always keep its own settings, regardless of whether you make any more changes to the template. 

On the first slide for example, you changed the position of the result diagram. Even though you also 

did this on the template, the result diagram still kept its own position. The same is true for the 

position of the question. 

If you want this slide to look exactly like the slide you set up in the template, you can reapply the 

template to this slide. To do this, you choose the option Reapply template from the Format menu. 

Choose the Reapply  template option from the Format menu. 
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Reapplying 
the template 

 

You can now indicate to which slides and to which objects you want to reapply the template. 

To current slide The template will only be reapplied to the current slide. 

To all slides The template will be reapplied to all slides in the script. 

From current slide The template will be reapplied to the current slide and all subsequent slides. 

All objects The template will be reapplied to all objects on the slide. 

These objects only The template will only be reapplied to the selected objects. 

Return objects to their original location When reapplying the template, all settings are taken 

from the template, except for the position of the objects. If you want to return the objects to the 

position you set up in the template, you have to enable this option. 

Choose the option To current slide and the option All objects. Also enable the option Return objects to 
their original location. Click on OK to reapply the template. 
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The template 
has been re-

applied to the 
first slide 

 

Aligning answers 
By reapplying the template, the answers are no longer aligned in front of the bars. Before, the an-

swers were placed neatly in front of the bars by moving the first and last answer manually. Then, 

the other answers were aligned by using the Align left and Distribute vertically options. This way 

of aligning always works and works for all types of objects. 

The option Align answers from the Edit menu also allows you to align the answers. This option 

only distributes the answers vertically, just like the Distribute vertically option, and places the 

answers exactly in front of, exactly on top of, or exactly below the bars in the chart. This option only 

works for answers, and not for other types of objects. And this option only works when there is a 

result diagram with results in it on the slide. 

To align the answers in front of or on top of the bars, this option takes into account the height of 

the textbox of the answer. When aligning in front of the bars, the center of the textbox is aligned 

with the center of the bar. When aligning on top of the bars, the textbox is placed with the bottom 

edge exactly on top of the bar. When aligning below the bars, the textbox is placed with the top 

edge exactly on the bottom of the bar. 

Choose the option Align answers from the Edit menu and then the option On top of the bars. 



67 

The template 
has been re-

applied to the 
first slide 

 

Go back to the next slide by pressing . 

Saving the template 
After you have adjusted the template to your wishes, you can save it for later use. You can save the 

template by choosing Save template from the Format menu. 

Choose the option Save template from the Format menu. 

The standard dialog box for saving files appears, in which you enter the name of the template. Al-

ways save your template in the Templates folder, that is automatically selected. This will make it 

appear in the start-up screen when you start IVS-Professional. 
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The standard 
dialog box 
for saving 

files 

 

Enter the name of this template: “IVS” and click on the Save button to save the template. 

Saving the script 
After having saved the template, it is recommended to also save the script. Click on the Save ( ) 

button in the toolbar to save your script. 

While making your script, do not forget to save it regularly. 
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Asking a reference question 

The first question in a script is often a practice question. With this question, the audience can become 

acquainted with the voting system. The audience can practice with giving an answer, and, when 

necessary, correcting an already given answer. The results are immediately and interactively dis-

played on screen, so that the audience can see that something really happens when they push a 

button on their keypad. A practice question is often a question based on current affairs. Most of the 

times, one of the answers given is the correct answer, while one of the other answers is obviously 

the wrong one. 

The second question in a script is often a reference question. Using a reference question, you can 

divide the audience into certain groups. With all the other questions, you can then show how these 

are answered by the different groups. 

A simple reference question could be: “Are you:”, with possible answers being: “Man” and 

“Woman”. With all the other questions, you can show what both the men and the women answered 

to this question. Viewing the results, divided into the groups of a reference question, is called cross-
ing. 

You can make multiple reference questions in one script. 

Inserting a reference question 
Insert a new question into the still empty second slide. Add two answers and insert a result diagram. 

See also “Making a question“ on page 14, “Adding answers“ on page 16 and “Adding a result 

diagram“ on page 17. 

Create a question with the following text: “Are you:”, two answers with the text: “Man” and “Woman” 

and add a result diagram. 

You see the question immediately appear in the font and the color that you set up in the template. 

The two answers appear at the same position as where you placed them in the template and the 

result diagram shows horizontal bars. But, the result diagram now shows two bars for the two an-

swers, and not five bars like in the template. That is why the answers are not at the same height as 

the bars. You will have to realign the answers on top of the bars. 

Choose the option Align answers from the Edit menu and then the option On top of the bars. 
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A simple ref-
erence ques-

tion has been 
inserted as 
the second 
question in 

the script 

 

The properties of a question 
After inserting a question, it still is a normal question. In the properties of the question, you have to 

indicate that this is a reference question. 

You go to the properties of the question by clicking on it with the right mouse button and choosing 

the option Properties from the menu. 

Click on the question with the right mouse button and choose Properties from the menu. 

The dialog box Properties of question appears, in which you can change the properties of the ques-

tion. 
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Dialog box 
with the 

properties of 
the question 

 

Numbering 

Each question is automatically numbered. Therefore you cannot change the number of a question. 

You can select the style of the number though. If you want display your question without a number, 

you select “None” as a style. 

Question options 

In the question options you determine the type of question you want to ask. This primarily relates to 

the way results are displayed. 

Display mean If you enable this option, the mean value (x) of the results will be displayed just 

below the result diagram. Although you can enable this option for every kind of question, it is only 

useful for rating questions. These are questions where you ask your audience to give a rating from, 

for instance, 1 to 5. 

Display deviation If you enable this option, the standard deviation (d) of the results will be dis-

played just below the result diagram. Like with the mean value, this option can be enabled for every 

kind of question, but it is only useful for rating questions. 

Display answers next in rank If you choose to display your answers next in rank, the answer 

that received most of the votes will be displayed at the top or on the left of the chart and the answer 

that received the least number of votes will be displayed at the bottom or on the right of the chart. 
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Please note that when using this option, you also need to use the option Legend text on axis or 

the option Display legend (see also “Legend“ on page 31), otherwise you don’t know which bar 

belongs to which answer. 

Calculate answers next in rank If a question can be voted more than once, the given answers 

can be calculated next in rank. For example, if you allow a question to be voted three times, the first 

answer given will get three votes, the second answer two votes, and the last answer one vote. If the 

answers are not calculated next in rank, each answer given will only get one vote. 

Last answer does not belong to total With this option the results of the last answer are not 

counted when determining the total number of votes. This last answer will always show an absolute 

number of votes, while all the other answers together represent 100% of the votes. This option is 

especially useful when the answers are yes / no / abstain, and the abstentions will not be counted 

when determining the total. 

Answers from high to low This option can be used to show the answers the other way around 

in the chart. Normally, answer 1 is at the top or on the left side of the chart. By enabling this option, 

answer 1 will be at the bottom or at the right side of the chart. 

Reference question This option indicates that this question is a reference question. This allows 

the audience to be divided into groups. 

Group question With a group question you can have your audience divide themselves into differ-

ent groups. The answers of a group question determine the groups. When the audience votes on a 

group question, the choice they make is stored in the participants list. This will overwrite an existing 

grouping, that you had programmed before in a participants list. Someone who does not vote, will 

stay in the group he was originally assigned to. This option is only available when the option Iden-
tified voting is also enabled. For more information about programming groups in a participants 

list, see “A list of participants based on names“ on page 127. 

Use voting time When this option is enabled, the program can keep track of the amount of time 

that goes by before a participant makes a choice. If this option is not enabled, the voting time for 

this question is not recorded and each participant will get a time of 0.00 seconds. For more infor-

mation, see “An overview of the score per participant“ on page 218. 

Identified voting This option indicates whether this question should be voted with or without 

identification. If the question has to be voted with identification, each participant has to put his chip 

card into the keypad to be able to vote. This option is only available in IVS-Professional. If you use 

IVS-Basic, you can only vote anonymously. 

Use vote weight By enabling this option, the voting weight of the individual participant is taken 

into account. This option is only available if you also enabled the Identified voting option. 
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Knock-out race This option indicates that the current question is part of a knock-out race. Only 

participants that are still in the race can vote on this question. This option is only available if you 

have also enabled the Identified voting option. For more information, see “The knock-out race“ 

on page 229. 

Number of answers If you had already added answers to this question, the number of answers 

you added will be displayed here. If you don’t add any answers, then you determine here how many 

answer options you want for this question. See also “A rating question without answers“ on page 

79. 

Legend & Colors 

You can set up the legend text of this question and the colors for the correct and wrong answers. 

Legend text Here you can enter the legend text for this question. The legend text will be displayed 

in the legend when you are comparing questions. By default, the legend text is equal to the question 

text, with a maximum of 32 characters. When the question text is too long, you can enter a shorter 

version here. Also see “Comparing questions“ on page 95. 

Correct answer Here you can set up a color that the bars, belonging to the correct answer, will 

get when you show the correct answer. See also “Showing the correct answer“ on page 99. 

Wrong answer Here you can set up a color that the bars, belonging to the wrong answer, will get 

when you show the correct answer. 

Voting options 

Using the voting options, you can set up extra options of the keypad while you are voting this ques-

tion. 

Use confirmation key This option determines that your audience not only has press the key of 

their choice, but also has to confirm the choice by pressing the confirmation key on the keypad. If 

you ask a question with more than ten answers, your audience always has to confirm their choice 

using the confirmation key, regardless of this option. This option only applies when you use RF-I or 

RF-II keypads. 

Use correction key This option determines whether an already cast vote can be corrected by 

pressing the correction key on the keypad. After casting a vote, the correction key can be used to 

withdraw the vote and a new choice can be made. When you use RF-I keypads, this option cannot 

be combined with the option Use enter key. 

Use scroll keys This option determines whether or not the scroll keys on the keypad can be used. 

These keys allow your audience to scroll through the earlier given answers, when more than one 

answer can be given. This option can only be used when the option Times to vote is set to more 

than one and when you use RF-II keypads. 
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Allow double votes When this option is enabled, a question that allows more than one answer 

to be given, accepts the same answer more than once. This option can only be used when the option 

Times to vote is set to more than one. If you use RF-I or Lite keypads, it will still be possible to 

vote for the same answer more than once, but these double votes will be ignored by the software. If 

you use RF-II keypads, the keypad will not accept a double vote. In that case, the choice made will 

blink in the LCD screen. 

Maximum times to vote This option determines how many answers can be given. This can be 

used when you need your audience to choose three answers from a list of ten possibilities. See also 

“Voting a question more than once“ on page 104. 

Minimum times to vote This option is only available when a question can be voted more than 

once. The minimum times to vote determines how many times a participant has to vote before his 

votes are counted. 

Automatically close after receiving this many votes With this option you can have the 

voting automatically close after a fixed number of votes are received. This option can be used when 

you have a small audience in which everyone is forced to vote. The voting will be automatically 

closed after the last person has cast his vote. If you enter 0, the voting will not be closed automati-

cally. 

Select the option Reference question and switch to the Background tab. 

Background 

On the Background tab you can set the background of the question’s text box. You can choose No 

Fill, which keeps the text box transparent, but you can also choose a solid fill, a gradient fill or a 

picture fill. The options are almost the same as for the background of a slide. See “Setting up the 

background“ on page 50. 

If you choose a solid fill or a gradient fill, you can select not only a color, but also the transparency 

of that color. It ranges from 0%, with the color fully visible, to 100%, with the selected color com-

pletely transparent. 

Finally, you can also set the corners of the text box to be rounded. For this you can set a radius that 

determines the roundness of the corners. 

Go to the Advanced tab. 

Advanced settings 

On the Advanced tab you will find options that only need to be set for advanced applications. 
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Identification group If you use identified voting, you can indicate here which identification group 

is used for this question. With an identification group you determine which group the participants 

are in and what their voting weight is. 

Score for non-voters If you want to use a total score to be achieved, you can assign a certain 

score to each answer. In addition, you can assign a score for non-voters to the question. All partici-

pants who answer this question, receive the score assigned to the given answer added to their total 

score. Participants who do not vote, get the score of the question added to their total score. 

Default answer With this option you can have participants who do not vote be counted to a 

certain answer. This can be useful for reference questions, where not everyone answers the reference 

question. To assign these participants to a certain group, you can set a standard answer for a refer-

ence question. 

Set maximum vote time for non-voters If you use voting time, only participants who vote 

will receive a voting time. Participants who do not vote will receive a voting time of 0 seconds. In 

some cases this can result in an unfair score count, for example when you use the Score for non-
voters option. Participants who do not vote will receive a score, but no voting time. With the option 

Set maximum vote time for non-voters you can overcome this by assigning the maximum 

voting time to participants who do not vote. The maximum voting time is the time that the voting 

was open. 

Estimation question With this option you indicate that this question is an estimation question. 

For an estimation question, the participant has to estimate a certain value. When the participant 

estimates the correct value, he gets the full score for it. Under Correct value you can set the correct 

value for this estimation question. With Score for correct value you set how many points the 

participant gets when he estimates the correct value. The farther away the participant is from the 

correct value, the fewer points he will receive. For example, if the correct value is 50 and the corre-

sponding score is set to 10 points, a participant who chooses 50 will receive the full 10 points. If he 

chooses 49 or 51, he will receive 9 points. If he chooses 45 or 55, he gets 5 points. And if he chooses 

40 or less, or 60 or higher, he will receive no points, unless the Allow negative score option is 

enabled. In that case, a participant can also receive points deduction if he is too far from the correct 

value. 

Click OK to apply the changes. 

A second reference question 
Following on the first reference question, you can ask another reference question, with which you 

divide your audience into other groups, for instance, the sector in which one is employed. 

First create a new slide, insert a question with five answers and a result diagram. Because this question 

has five answers, the answers are perfectly aligned on top of the bars of the chart, just as you had set up 
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the answers in the template. In the properties of the question you indicate that this is a reference ques-

tion. 

The second 
reference 

question di-
vides the au-

dience into 
sectors in 

which one is 
employed 

 



77 

Asking a rating question 

With a rating question, your audience does not make a choice from a number of answers, but instead 

gives a rating on a certain subject. For example, people can rate a subject on a 5-point scale or a 10-

point scale. If you use a rating question like this, you do not have to add any answers. 

You can also use a rating question with more descriptive answers, like from “very bad” to “very 

good” or from “fully agree” up “fully disagree”. Of course, if you use a rating question like this, you 

have to add the answers. 

Using a rating question, you can also show the mean (x) and standard deviation (d) of the results. 

This allows you to see what your audience on average thinks about the subject, and how the results 

are scattered around this average. 

A rating question with answers 
To ask a rating question with a descriptive rating, you have to insert a question with a couple of 

answers. 

Create a new slide. Insert a question with the following text: “To take greater pleasure in working, better 

coffee is needed. Do you agree with this proposition?”. Also add a result diagram. 

A rating ques-
tion allows 

your audience 
to express 

their opinion 
about a cer-

tain proposi-
tion 
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Inserting a fixed set of answers 
When asking a rating question with a descriptive rating, you mostly insert a number of fixed answers. 

For each rating question you insert for example two answers, ‘I agree’ and ‘I disagree’. Or you have 

a rating question with five answers, varying from ‘I fully disagree’ to ‘I fully agree’. 

For these types of questions you can very easily insert the same set of answers. From the Insert 

menu, you choose the option Answers from template and then you choose one of the predefined 

sets of answers. 

The Answers 
f rom tem-

plate  option 
allows you to 
easily insert a 

fixed set of 
answers 

 

Choose the Answers from template option from the Insert menu and then the option I completely  
disagree..I completely  agree. The five answers are automatically inserted. 

The five an-
swers from 

the fixed set 
are automati-
cally inserted 
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The mean and deviation 
To show both the mean and deviation for this rating question, you go to the properties of the ques-

tion and check the options Display mean and Display deviation. The mean and the standard 

deviation are shown at the bottom of the result diagram. 

Click on the question with the right mouse button and choose the option Properties. In Properties of 
question the dialog box you check the options Display mean and Display deviation. Click on OK to apply 

the settings and close the dialog box. Because the result diagram now displays the mean and standard 

deviation, the bars are moved up a little. Realign the answers so that they are on top of the bars again. 

Both mean 
and deviation 
are displayed 
with this rat-
ing question 

 

A rating question without answers 
If you ask a rating question where your audience has to give a mark, you do not have to insert 

answers. Instead, in the properties of the question, you set the number of answer options you want 

to allow for this question. 

Create a new slide. Insert a question with the following text: “A number of people have complained 

about the poor quality of the coffee. On a scale of 1 to 10, how would you rate the quality of the coffee?” 

and insert a result diagram. Enlarge the text box of the question a little, so that the entire text fits into 

the box. 
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A rating ques-
tion where 

the audience 
has to give a 

mark to a cer-
tain subject 

 

In the properties of the question you have to set that you want to use ten answers. 

Go to the properties of the question and set the Number of answers to 10. Also check the options Display 
mean and Display deviation. Click on OK to apply the settings. 

A rating ques-
tion with 10 
possible an-

swers 

 

This horizontal chart barely leaves room for the bars. You can better turn this horizontal chart into a 

vertical chart. And because the lack of answer options, there is no direct relation between the an-

swers and the bars. To re-establish this relation, you can display the legend text along the axis. Both 

options are set in the properties of the result diagram. 
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Go to the properties of the result diagram. Check the option Legend text on axis. Next, go to the Chart 
page and select Column chart from the Chart type options. 

The chart is 
displayed ver-

tically and 
the legend 
text is dis-

played along 
the axis 
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Crossing results 

By asking one or more reference questions in your script, you can divide your audience into different 

groups. Throughout the rest of your script, you ask questions that at first show the total results. By 

crossing this question with one of the reference questions, you can view the total results for each 

group.  

Crossing with a simple reference question 
In the chapter “Asking a reference question“ on page 69 you made two reference questions. A simple 

reference question with one two answers and a more comprehensive reference question with five 

answers. These answers are the references or groups, into which you divide your audience. 

The next two questions are rating questions. First the total results of these questions are displayed, 

which are the total results of the entire audience. By crossing this question with the reference ques-

tion “Are you man or woman”, you can see how the group of men has rated this question and how 

the group of women has rated this question. 

To do this, you go back to slide 4 with the question “Do you agree with this proposition?”. 

Go back to slide 4 by pressing . 

You can cross a question by choosing the option Cross from the Results Menu, or by pressing 

 +  on the keyboard. You will see a list containing all the questions with which you can cross 

the current question. This list contains all the questions from your script, and not just the reference 

questions. A question can be crossed with all other questions from the script, not just the reference 

questions. 

Press  +  to cross this question with another question. 

Dialog box to 
choose a 

question to 
cross with 

 

Select the question that you want to cross with and click OK to perform the crossing. 

Under Question you choose “2. Are you:”. Next, click OK. 
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After crossing 
you will see 

the results for 
each group 

 

After the crossing, two bars are displayed for each answer. The first bar indicates the total number 

of votes of the men, the second indicates the total number of votes of the women. 

Both bars take over the color of the answers of the question you crossed with. Because we chose to 

set the bar colors of all answers to white in the template, both answers of the reference question 

“Are you:” have the same color. And therefore they also have the same color in this crossing. To 

make the crossing more understandable, it is better to give the bars of the reference question differ-

ent colors. 

To change the bar colors of the reference question, you go back to the second slide. In the properties 

of both answers you set up the bar color. 

Go back to slide 2. Click with the right mouse button on the first answer and choose the option Prop-
erties. The dialog box with the properties of the answer is shown. 
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Setting up 
the correct 

answer 

 

Numbering 

Each answer is automatically numbered. You can change this number afterwards, so that you can 

change the order of the answers. You can also change the style of the number that is displayed. If 

you want the answer to be displayed without a number, set the style to “None”. You can then 

provide a number for each answer, for example by using a different font, or by using an image that 

displays the answer number. Please take extra care that the number you use matches the number of 

the answer, so that when the participants vote 1, they have indeed voted for answer 1. 

When you enable the Custom color option, you can select a different color to be used for the 

answer number. If you do not set a separate color, the answer number will have the same color as 

the last character of the answer text. 

Legend & Colors 

Here you can enter the legend text and the bar color of this answer. The legend text can be displayed 

along the axes of the result diagram or in a separate legend on the right side of the result diagram. 

If the answer texts are too long, you can enter a shorter version here. 

By clicking on the Bar color button, you can select the color of the bar belonging to this answer. 

Answer options 

The answer options allow you to make several changes to the options of the answer. 
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Next slide With this option you can indicate to which slide you want to jump when this answer 

gets the most votes. You enter the number of the slide you want to jump to. If you only want to go 

to the next slide, enter a 0. After closing the voting, you can press  or  to go to the slide you 

indicated. 

Score If you want to make use of a total score for your participants, you can assign a certain score 

to each answer. All participants that choose this answer, will get the score assigned to this answer 

added to their total score. 

Display as correct answer With this option you indicate that you want this answer to be dis-

played as a correct answer. When displaying the correct answer, all answers that you indicated to 

be displayed as correct, will have their bar displayed in green, while all other answers will have their 

bar displayed in red. 

Background 

On the Background tab you can set the background of the answer’s text box. You can choose No 
Fill, which keeps the text box transparent, but you can also choose a solid fill, a gradient fill or a 

picture fill. The options are almost the same as for the background of a slide. See “Setting up the 

background“ on page 50. 

If you choose a solid fill or a gradient fill, you can select not only a color, but also the transparency 

of that color. It ranges from 0%, with the color fully visible, to 100%, with the selected color com-

pletely transparent. 

Finally, you can also set the corners of the text box to be rounded. For this you can set a radius that 

determines the roundness of the corners. 

Advanced settings 

On the Advanced tab you will find options that only need to be set for advanced applications. 

Answer group You can group several answers together in a certain group. If you allow a question 

to be voted on more than once, it will only be possible to choose answers that are in the same answer 

group. When an answer from a different answer group is chosen, all other given answers will be 

discarded. For example, if you can vote three times on a certain question, and someone first votes 

for an answer from answer group 1, next for another answers from answer group 1 and finally for 

an answer from answer group 2. In this case, only the last answer from answer group 2 will be 

counted. The first two given answers are not canceled, so it’s not possible to still choose three an-

swers from answer group 2. 

Add this answer’s results to answer With this option you can have the votes, that were orig-

inally meant for this answer, added to a different answer. For this answer, no results will be dis-

played. For instance, if you want to group the results of answers 2, 3 and 4 together, you go to the 

properties of answer 3 and 4, and indicate that the results have to be added to answer 2. All the 
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votes that came in for answer 2, 3 and 4 are now all added together and displayed with answer 2. 

Answer 3 and 4 will not display any results. 

This answer repeats the given answers of question This option turns this answer into a 

special case. If this option is enabled, it is no longer possible to vote for this answer itself. Instead, 

votes given to a previous question will automatically be repeated for this question. Behind this option 

you enter the question number from which you want to repeat the votes. This option can be com-

bined with the option to allow a question to be voted more than once. In that case, all the votes 

given for the previous question will be repeated for this question by only selecting this single answer. 

This answer selects all the answers above This option also makes this answer a special op-

tion, so that no vote can be cast on this answer itself. All the above answers are selected instead. 

You can only select this option for answer 3 and higher and when you can vote on this question 

multiple times. For example, if this question is allowed to vote three times, and you enable this 

option for answer 4, a participant only needs to select answer 4, which has the same effect as suc-

cessively selecting answers 1, 2 and 3. 

Set the bar color to blue and click on OK to apply it. Next, click with the right mouse button on the 

second answer and choose the option Properties. Set the bar color to pink and click on OK to apply it. 

Go back to slide 4 and cross this question again by pressing  + , selecting question 2 and clicking 

OK. 

The crossing 
is now dis-

played with 
different col-

ors for the 
two groups 

 

Both groups now have a different bar color. You can now better see how both groups have responded 

to this question. The blue bars represent the group of men, while the pink bars represent the group 

of women. You can see for instance, that more than 50% of the men completely agree with the 

subject, while more than 60% of the women completely agree. 
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After crossing, the mean and standard deviation are still displayed. They are however based on the 

entire group, that is both men and women. 

Crossing with a more comprehensive reference question 
The first reference question only had two references, that divided your audience into two groups. 

The next reference question has five references, that divide your audience into five groups. 

Crossing the current question with the second reference question shows a chart with five bars next 

to each other. Again, the bars of this question also take over the colors of the answers belonging to 

the reference question. So it is better to set up different bar colors for this question too. 

Go to slide 3, click with the right mouse button on the first answer, choose the option Properties and 

set the bar color. Repeat this for all other answers. Set the colors to red, yellow, green, purple and blue. 

The go back to slide 4 and cross the current question with the second reference question by pressing 

 +  and then choosing question three as reference question. 

Crossing with 
a reference 

question with 
five refer-

ences 

 

The bars are now so small that the results overlap each other and are not or hardly legible. Besides 

that, it is difficult for the audience to understand what exactly is displayed here. 

Splitting a crossed question 
If you cross a question with a reference question that has more than three references it is advised to 

split the question after crossing. By splitting the question you display the results per reference. 

To split a crossed question, choose the option Split from the Results menu, or press  +  on 

your keyboard. A dialog box appears in which you can enter which reference you want to see. 
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The dialog 
box where 
you enter 

which split or 
reference you 
want to show 

 

It is also possible to split a crossed question without using this dialog box. To do this, you press 

 +  to display the first reference,  +  for the second reference, etc. This key combination 

allows you to split a maximum of nine references. If you have more than nine references, you still 

have to use the dialog box. 

Press  +  to split the crossing. Enter 1 as the split number. Click OK to perform the split. 

The crossed 
question is 

split, showing 
only the first 

reference 

 

Now, only the results of the first reference are shown. In the legend the description of this reference 

is displayed. 

Because this is a rating question, both the mean and standard deviation are displayed at the bottom 

of the chart. After crossing a rating question, the mean and deviation of the total results are still 

displayed. Only when splitting this crossing, the mean and standard deviation for this particular ref-

erence. In the example above you see the mean and deviation of the group “Government”. 

To show the results of another reference, you can split the question again. Choose the option Split 

from the Result menu and enter the number of the reference that you want to show. 
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Undoing a split 
After showing each reference separately, you can undo the split to go back to the original crossed 

question. You undo a split by choosing the option Split from the Results menu. In the dialog box 

that appears, you enter a 0 as the split. After clicking on OK the original crossing will be displayed 

again. 

You can also undo the split without using the dialog box. To do this, press  +  on the keyboard. 

Press  +  to undo this split. 

Displaying a crossing differently 
When a normal crossing becomes too complicated, because the reference question has more than 

three references, you can display the crossing in a different way. Instead of placing the bars side by 

side in the bar chart, it is also possible to stack them on top of each other. 

To do this, you go to the properties of the result diagram. Open the tab Cross & Compare and choose 

the option Stacked under Cross. The bars of the various references are now stacked on top of each 

other instead of side by side. This makes it easier to see the relationship between the various groups 

and also the relationship between the various answers. The percentages that are displayed while 

stacking the bars on top of each other are hardly visible. It is better to leave them out. 

Go to the properties of the result diagram. Open the tab Chart and disable the option Display values. 
Next, open the tab Cross & Compare and choose the option Stacked under Cross. Finally, click on OK. 

A crossing 
which dis-

plays the bars 
stacked on 

top of each 
other instead 

of side by 
side 
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Back to the normal results 
To return to the normal, uncrossed results of this question, you choose the option Normal from the 

Results menu. You can also press  +  on your keyboard. 

Press  +  to show the normal results again. 

The normal, 
total results 

are displayed 
again 

 

The results are still displayed without percentages. In the following examples these percentages are 

used again, so you can now enable them again in the properties of the results diagram. 

Click with the right mouse button on the result diagram and choose the option Properties. Open the 

Chart tab and enable the option Display values. 

Crossing with multiple reference questions 
In IVS-Professional you can cross a question with up to five reference questions. By first crossing a 

question with the reference question “Are you man or woman” and then with the reference question 

“In which sector are you employed”, you can see what the men that are employed in the sector 

“Government” have answered, or what the women that are employed in the sector “Communication 

and Media” have answered. 

To cross a question with two reference questions, you first cross the question with the first reference 

question. Then you split this question to the reference you are interested in. Finally, you cross this 

question again with the second reference question. This crossing can also be split into the separate 

references. 
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Press  +  to cross this question with another question. Under Question you choose question 2 

“Are you:”. Next, click on OK. Press  +  to split this crossing. You now only see the results of the 

men. 

The first 
crossing is 

split into the 
reference 

“Man” 

 

Press  +  again to cross this question with another question. Under Question choose question 3 

“In which sector are you employed?”. Next, click on OK. You now see an overview of all men, in which 

sector they are employed and what they have answered to this question. 

The reference 
“Man” has 

been crossed 
again with a 

second refer-
ence question 
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Here you can see what all the men, divided into different sectors, have answered. At the top of the 

result diagram, you see the first reference. 

This crossing can also be split again, to display the results per reference. 

Press on  +  to split this crossing. You now only see the results of the men that are employed in 

the sector “Education and Science”. 

The second 
crossing is 

split into the 
reference 

“Education 
and Science”, 

so that only 
the results of 

the refer-
ences “Man” 
and “Educa-
tion and Sci-

ence” are dis-
played 

 

When necessary, you can cross this split again. In that case, you can see both previous references 

“Man, Education and Science” displayed at the top of the result diagram. 
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Comparing results 

When you ask a question twice, you can compare the results of these two questions. For instance, if 

you can ask a question at the start of a meeting and then repeat the same question at the end of the 

meeting. By comparing both questions you can see whether your audience has changed their minds 

or not. 

Another method where comparing two exactly the same question is applied, is the so-called Peer 
Instruction. This originally American method is often applied in educational environments. With this 

method, two the same questions are asked. The students have to answer the first question by intui-

tion, and then they get a few minutes to discuss about the answers with their peers. After the dis-

cussion, they are invited to vote again and the results are compared with each other. In practice, it 

happens that the number of correct answers remarkably increases for the second question. 

Inserting a question to compare 
Before you can compare results, you need two similar questions to compare. The condition is that 

both questions have the same number of answers. Of course the answers on both questions have to 

be the same and have to be in the same order. 

Go to the last slide and create a new slide. Insert a question with the following text: “A temperature of 

272 Kelvin equals how many degrees Celsius?” Add four answers with the following text: “-3 degrees”, 

“-1 degree”, “1 degree” and “3 degrees”. Finally, insert a result diagram and align the answers on top 

of the bars. 
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First question 
for comparing 
two questions 

 

Setting the correct answer 
The question that is asked is a knowledge question. After asking this question and showing the 

results, you can see how many people in the audience knew the correct answer. If desired you can 

also show the correct answer. The bar that belongs to the correct answer will turn green while all 

the others will turn red. 

To show the correct answer you have to set up one or more of the answers to be the correct one. 

Setting the correct answer is done in the properties of the corresponding answer. It is possible to set 

up more than one correct answer. 

Click on the second answer with the right mouse button and choose the option Properties. Enable the 

option Display as correct answer. Click on OK to apply the settings. 

Copying a slide 
To compare two questions with each other, both questions need to be identical. The easiest way to 

achieve this is to copy the entire slide with the first question. 

You can copy an entire slide by choosing the option Copy from the Edit menu, provided that no 

objects are selected. Alternatively, you can click on the Copy ( ) button or press the  +  keys 

on the keyboard. To insert the copied slide as a new slide, you choose the option Paste from the 

Edit menu. Alternatively, you can click on the Paste ( ) button or press the  +  keys on the 

keyboard. 
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Click anywhere on the slide to be sure that no objects are selected. Next, click on the Copy button in the 

toolbar and then on the Paste button. 

A new slide has been inserted that is identical to the copied slide. The only exception is the question 

that automatically got a new number. All objects on the newly inserted slide are automatically se-

lected. 

The slide with 
question 6 on 

it has been 
copied 

 

Comparing questions 
You can compare a question with another question, by choosing the option Compare from the Re-

sults menu, or by pressing the  +  keys on the keyboard. A list appears, containing all ques-

tions with which the current question can be compared. This list only contains questions with the 

same number of answers as the current question. 

Press  +  to compare this question with another question. 

Dialog box to 
choose a 

question to 
compare with 

 

Select the question you want to compare with and click on “OK” to perform the comparison. 
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Under Question you choose question 6 “A temperature of 272 Kelvin equals how many degrees Celsius?” 

Next, click on OK. 

Questions are 
compared to 
one another 

 

In the chart you see the results of both questions next to each other. The lower bars represent the 

results of the current question, while the upper bars represent the results of the question that you 

compared with. 

The color of the bars can be changed in the properties of the result diagram on the template slide. 

On the Cross & Compare tab, you can set up the colors for a maximum of ten bars. 

The legend shows the legend text of both questions. By default, this legend text is equal to the 

question text, with a maximum of 32 characters. 

To modify the legend text, you go to the properties of the question. Under Legend & Colors you enter 

the text that you want to be displayed in the legend as Legend text. 

Go to the previous slide. Click on the question with the right mouse button and choose the option Prop-
erties. Enter “Result current knowledge” as the Legend text. Click on OK and go to the next slide. Here 

you also go to the properties of the question. Enter “Result after explanation” as the Legend text. Click 

on OK and compare the question again by pressing  + , selecting question 6 and clicking on OK. 
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Both ques-
tions now 

have a more 
sensible leg-

end text 

 

Comparing in percentages 
When you compare two questions and display the results in percentages, it sometimes seems as 

though the results do not match the bars that are displayed. This mainly happens when more people 

voted on one question than on the other question. 

To prevent this from happening, the results are normalized to 100% when you compare two or more 

questions. This means that all questions are treated as if the same number of people had voted on 

them. The length of the bars is then based on the percentage of votes. Normalizing only happens 

when the results are displayed in percentages. When you change to one of the other display modes, 

the results are no longer normalized and the length of the bars is based on the actual number of 

votes. 

Click on the result diagram with the right mouse button and choose the option Properties. Deselect the 

option Cross/compare to 100% and click on OK to apply the settings. 
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The lengths of 
the bars do 

not match 
with the per-
centages any 

more 

 

In the comparison above, you can see that when this question was voted for the first time, 4.6% of 

the participants voted for answer 1, while the second time 5.4% voted for answer 1. Still, the bar 

belonging to 4.6% is longer than the one belonging to 5.4%. This is because the length of the bars 

is now based on the absolute number of votes. The 4.6% of the first question corresponds to 22 

participants, while the 5.6% of the second question corresponds to 19 participants. The difference 

in percentages is caused by the fact that a different number of participants have voted on both 

questions. On the first question, a total of 481 participants have voted, while on the second question, 

only 351 participants have voted. 

When you use example results, it will not happen very often that one question receives more votes 

than the other question. The results in the example above are manipulated to explain the difference. 

In practice, however, it might occur, for instance, when you are comparing a question from a morning 

session with one from an afternoon session, where less people attended the afternoon session. 

Go back to the properties of the result diagram and enable the option Cross/Compare to 100% again. 

Click on OK to apply the settings. 

Switching between absolute numbers and percentages 
Results are mostly presented in percentages in the diagrams. Every once in a while a presenter or 

the audience asks for the number of people that chose one of the answers. In this case you can 

switch to absolute numbers, even during the presentation. 

You do this by choosing Absolute/Percentages from the Results menu or by pressing 

 +  +  on the keyboard. 

Press the  +  +  keys on the keyboard to show the result in absolute numbers. 
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Results of a 
comparison 

are presented 
in absolute 

figures 

 

Because the percentages are being normalized, you see the length of the bars change when you 

switch from percentages to absolute numbers. 

By choosing the option Absolute/Percentages from the Results menu again, or by pressing 

 +  +  on the keyboard again, you switch back to the original display mode. 

Showing the correct answer 
This knowledge question has four answers. One of them is the correct one, the other three are wrong. 

In the properties of the second answer you indicated that this answer should be displayed as the 

correct answer. The correct answer can be displayed by choosing the option Correct Answer from 

the Results menu or by pressing the  +  keys on the keyboard. The bar of the correct answer 

will turn green, while those of the wrong answers turn red. The colors used can be set up in the 

properties of the current question. 

Press  +  to show the correct answer. 
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The correct 
answer is in-
dicated by a 

green bar, the 
wrong an-

swers are in-
dicated by 

the red bars 

 

By showing the correct answer, the results are displayed in percentages again, even though you just 

changed to absolute values. This is because the change to absolute values was only temporary. By 

showing the correct answer, the results are displayed the way they were set up in the properties of 

the result diagram. 

By choosing the option Correct answer from the Results menu again, the bars will turn back to 

their original colors. 

Press  +  to show the normal bar colors again. 

Back to the standard results 
To show the original results again after a comparison, you choose the option Normal from the Re-

sults menu. You can also press  +  on the keyboard. 

Press  +  to undo the comparison. 

Two result diagrams on one slide 
Another way of comparing questions is by inserting two result diagrams on one slide. One result 

diagram displays the results of the first question, the other result diagram displays the results of the 

second question. 

Reduce the size of the result diagram by moving the left side to about halfway through the slide. Insert 

an extra result diagram in this slide, by copying the original result diagram and then pasting it. 

When you insert an extra result diagram in a slide, a warning is displayed. 
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Warning 
when insert-
ing an extra 

result dia-
gram on the 

same slide 

 

Click on Yes to insert an extra result diagram. 

After pasting the second result diagram on the slide, it will be placed at exactly the same position as the 

original result diagram. Move the second diagram to the left, so that it is alongside the original result 

diagram. Keep the  key pressed while moving to make sure the diagram is only moved in horizontal 

direction. 

Two result di-
agrams on 

the same 
slide 

 

An extra result diagram is not automatically linked to a question. In the properties of the result 

diagram, you have to select the question of which this result diagram will display the results. 
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Linking a re-
sult diagram 

to a question 

 

Go to the properties of the left result diagram. Under Question you select “6. A temperature of 272 

Kelvin equals how many degrees Celsius?”. Click on OK to link this result diagram to the selected ques-

tion. 

Because this result diagram is linked to a question that has already been linked to another result 

diagram, a warning is displayed. 

Warning 
when linking 
a result dia-

gram 

 

Click on Yes to link this result diagram also to that question. This question now has two result 

diagrams that display its results. 

Click on Yes to also link this result diagram to question 6. 

After linking a result diagram to a question, the results of this question are immediately displayed. 
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Both dia-
grams now 
display the 

results of two 
different 

questions 

 

A disadvantage of this method is that when you are going to vote this script, the results of question 

6 are already visible in the first result diagram, while question 7 still has to be voted. The voting 

behavior of your participants could be influenced be these results. Those participants that still don’t 

know what to vote, can go for the results as they are already visible for question 6. 

To prevent this from happening, it is better to show the results of question 6 only with question 6, 

the results of question 7 only with question 7, and make another slide following question 7 that 

shows both result diagrams side by side. To leave no doubt, you could repeat the question and 

answer texts by inserting them as normal texts. 
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Voting a question more than 

once 

A standard multiple choice question offers the audience the possibility to choose one of the available 

answers. With some multiple choice questions is desirable to have the audience choose more than 

one answer. 

An example is a question with ten answers out of which the three most appealing have to be chosen. 

The most appealing should be selected first followed by the answer that is appeals second, etc. 

Another example is choosing a certain amount of people from a list. Someone could for example 

choose the ten best equipped candidates for a certain position out of a list of 30 people. 

Quickly inserting answers 
To ask a question that can be voted on more than once, you first have to add a question with a 

number of answers. 

Create a new slide. Insert a question with the following text: “What are the most important benefits of 

the Interactive Voting System?”. 

This question has six answer options. You can insert the answers one by one and each time type in 

the answer text for one answer option. However, it is also possible to insert answers quickly, entering 

the answer texts for all answer options in one go. This can be especially useful if you already have 

the answer texts underneath each other in a Word document, for example. 

To quickly insert answers, choose Quick Insert Answers from the Insert menu. Alternatively you 

can press the  on the keyboard. A window will appear in which you can enter the answer texts for 

the answer options. 
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Input window 
for quickly in-

serting an-
swers 

 

In the answer list, enter the texts of the various answer options. Each answer text is placed on a 

separate line. If an answer text is longer than the width of the input window, it will automatically 

wrap to the next line. However, this is still seen as one line. Only when you press  do you start 

a new answer option. 

Press  to quickly insert answers. Enter the following answer texts, each on its own line: “Anonymity 

of the participants / honesty”, “Continuous attention”, “Statistical data immediately available”, “Con-

trolling and directing the communication process”, “Creating togetherness” and “Improving the quality 

of the presentation”.  

A question with multiple votes 
To be able to vote this question more than once, you go to the properties of the question and choose 

how many times you want to vote for this question with the option Maximum times to vote. 

Click on the question with the right mouse button and choose the option Properties. In the Properties 
of question dialog box, set the option Times to vote to 3. Click OK to apply the settings and close the 

dialog box. 

Answers that fall outside the slide 
The distance between the two answers in the template was set up in such a way, that when using 

five answers, they would be exactly in line with the bars in the result diagram. This results in the 

sixth answer barely fitting on the slide, and the seventh answer falling outside the slide. 

With every next answer you are inserting, a dialog box will pop up stating that the answer would 

fall outside the slide. You will have to manually move the answer to the correct position. 



106 

The new an-
swer is about 
to be placed 
outside the 

slide 

 

Insert another two answers with the following text: “Brainstorming and prioritizing themes” and “Im-

mediate evaluation and documentation possible”. When the dialog box pops up, you click OK. Use the 

scroll bar on the right side of the screen to scroll both answers into view. Manually move all answers 

closer together so that they all fit on the slide. Use the option Align or distr ibute to neatly align all 

answers. See also “Positioning answers“ on page 40. 

The answers 
are manually 

moved to 
make them all 

fit on the 
slide 

 

Result diagram on the next slide 
If the answers to your question are short, you will have plenty of space left to put a result diagram 

on the slide. However, when you have a larger amount of answers, and the answer texts are also 

getting a bit longer, the available space to put your result diagram in will become more and more 

limited. In those cases you could place the result diagram on the next slide. In that case you can use 

all available space of the entire slide for your result diagram. 

Create a new slide. Insert a result diagram and resize it until it almost fits on the entire slide. Leave a free 

space at the top of the slide. 
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The result di-
agram is 

placed on the 
next page 

 

Because there are no answers in front of the bars you cannot see the relation between the bars and 

the answers. This can easily been solved by showing the legend texts on the axis. 

Go to the properties of the result diagram and select the option Legend text on axis. Deselect the option 

Use answer numbers as legend to have the entire legend text displayed. 

The legend 
text is dis-

played on the 
axis but texts 

that are too 
long are trun-

cated 
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Changing the legend text 
When you insert an answer and enter the text for it, the legend text of the answer is automatically 

entered. In most cases, the legend text equals the answer text. Only when the answer text is too 

long, the legend text will be truncated. The maximum number of characters for the legend text is 32. 

You can manually change the legend text to prevent half sentences. You can change the legend texts 

in the properties of the accompanying answer. 

Go back to the previous slide. Click on the first answer with the right mouse button and choose the 

option Properties. Change the legend text to “Anonymity” and click OK. Repeat this for all the other 

answers entering the following texts: “Continuous attention”, “Statistical data”, “Controlling process”, 

“Creating togetherness”, “Improving the quality”, “Brainstorming” and “Immediate evaluation”. Go to 

the next slide. The legend texts have been adjusted. 

The legend 
texts are ad-

justed to a 
shortened 

version of the 
answer texts 

 

Adding a text 
By showing the legend text on the axis, the relation between the answers and the bars in the result 

diagram is restored. However, because there is no question on this slide there is no relation anymore 

between the answers and the question. This can be solved by repeating the question text on this 

slide, not as a new question, but as a plain text. 

To insert a text, you choose the option Text from the Insert menu. Alternatively, you can click the 

Text ( ) button in the toolbar or press the  on your keyboard. 
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To save you from re-typing the entire question text, you could copy the text. To do this, you go back 

to the slide with the question, double-click the question and copy the question text. When inserting 

the text, you can simply paste the question text. 

To get the text to the exact same position on the slide as the question text, you can first insert the 

text on the slide with the question. Then position the text so that it falls exactly over the question 

text. Then cut the text from this slide and paste it back on the next slide. 

Go back to the previous slide. Double-click the question. The question dialog box appears with the ques-

tion text already selected. Copy this text by pressing  + . Click Cancel to close the dialog box 

without making any changes. Press  to insert a text. The dialog box for entering text appears. Press 

 +  to paste the copied text. Click on OK to close the text dialog box and insert the text. 

The question 
text is re-

peated by in-
serting it as a 

text 

 

Automatically align objects 
To position the text exactly in the same position as the question text, you can use the automatic 

alignment of objects. When this option is enabled, when moving an object, or enlarging or reducing 

it, an object will be automatically aligned with another object as soon as it comes close to this object. 

To enable automatic alignment, select the option Snap to objects in the View menu. Alternatively 

you can press  +  +  on the keyboard. 

When you now move an object, its left edge will be placed exactly on the left edge of another object, 

when it comes close to that left edge. Its left edge will also be placed exactly on the center or on the 

right edge of another object. The same applies to the center and the right edge of the object being 

moved. Those, too, will be placed exactly on the left edge, the middle or the right edge of another 
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object. Moreover, it does not only apply to the edges of other objects, but also to the edges of the 

slide. 

As the text 
box is moved, 
it is automati-

cally aligned 
with the 
edges of 

other objects 

 

If you want to temporarily disable automatic alignment while moving an object, then keep the  

key pressed while moving. As long as you keep the  key pressed, you can move an object freely. 

When you release the key, the object will automatically align to the edges of other objects again. 

Enable the auto-align option by enabling the Snap to objects option in the View menu. Move the text 

box so that its right edge and bottom edge snap to the right edge and the bottom edge of the question 

text. Then enlarge the text box so that its left edge and top edge also snap to the left edge and the top 

edge of the question text. 



111 

The text box 
is aligned ex-
actly with the 
question text 

 

Aligning text vertically 
By default, the text in an answer object and text object is aligned with the lower edge of the text 

box, while the text of a question object is, by default, aligned with the upper edge of the text box. 

Although the text boxes of the text object and the question object are now exactly on top of each 

other, one text is at the top while the other is at the bottom. In addition, a question text is automat-

ically numbered, so that its text is somewhat indented. 

By aligning the text in the text object with the top of the text box, it will be in the same position as 

the text in the question object. To do this, double-click the text object, so that the text entry window 

appears. Next, set the Vertical Alignment option to Align Top. 

Setting the 
vertical align-

ment of the 
text to Align 

Top 
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Double-click the text object’s text box. Set the Vertical Alignment option to Top Align. 

The text of 
the text ob-

ject is top 
aligned, just 
like the text 
of the ques-
tion object 

 

Moving objects with the arrow keys 
Due to the numbering of the question text, the text box of the text object has to be moved slightly 

to the right in order to get the texts exactly aligned. You can try to do this very carefully with the 

mouse, but you can better use the arrow keys to position objects precisely. 

After you select one or more objects, you can move these objects across the slide by using the arrow 

keys. If you hold down the  key while moving, you can move the objects in larger steps. If you 

hold down the  key while moving, you can move the objects in very small steps. 

Hold down the  key and press the right arrow three times. Release the  key and press the right 

arrow twice. Hold down the  key and press the right arrow three more times. The text is now exactly 

above the text of the question. Finally, move the right edge of the text box so that it is at the exact same 

position as the right edge of the question text. 

Cutting objects 
The text box is now positioned in such a way that the text falls exactly over the text of the question. 

Now the text box only needs to be moved to the next slide, so that it ends up in exactly the same 

position again. You can do this by cutting the object from this slide and pasting it back onto the next 

slide. 

To cut an object, select it and choose Cut from the Edit menu. Alternatively, you can click the Cut (

) button in the toolbar or press  +  on the keyboard. 
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Press  +  to cut the text box. 

To re-insert the cut object on another slide, go to the slide in which you want to insert it and choose 

the option Paste from the Edit menu. Alternatively, you can click the Paste ( ) button in the 

toolbar or press  +  on the keyboard. 

Go to the next slide and press  +  to insert the cut text box on this slide. 

The text box 
has been 

pasted on the 
next slide 

 

Showing the different choices 
The results of a question where more than one answer can be given, show a total overview of all 

votes. You could also show the results of the first choice, the second choice, etc. You do this by 

splitting the results the same way you did with crossing questions. 

To split the question, you choose the option Split from the Results menu or press  +  on the 

keyboard. A dialog box appears in which you can enter which of the available choices should be 

displayed. You can also press  +  up until  +  to immediately display the first choice 

till the ninth choice. 

Press  +  to split this question so that the first choice is shown. 
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Only the re-
sults of the 
first choice 

are displayed 

 

At the top of the result diagram you can see which choice is currently displayed. 

You can show the results of the second and third choice by following the same procedure. 

Undoing a split 
After displaying each choice separately, you can undo the split to show the total results again. You 

undo a split by choosing the option Split from the Results menu. In the dialog box that appears, 

you enter a 0 as the split number. After clicking on OK, the total results are displayed again. Alter-

natively, you could choose the option Normal from the Results menu to undo the split, or press 

 +  on the keyboard. 

Calculating results next in rank 
The total overview of the results of a question that can be voted more than once, does not take into 

account the preference of the votes. When someone first chooses answer 1, then answer 3 and finally 

answer 2, he indicates that he thinks answer 1 is the most important answer, answer 3 is less im-

portant, and answer 2 is the least important. Another participant first chooses answer 3, then answer 

2, and finally answer 1. In the total overview, both answer 1 and answer 2 and 3 all have 2 voted. 

With the option Calculate results next in rank you can include the preference of the votes when 

calculating the total overview. If it is allowed to vote three times, the first answer given will get three 

votes, the second answer two votes and the last answer given gets one vote. In the example above, 

the first participant gives three votes to answer 1, two votes to answer 3 and one vote to answer 2. 

The second participant gives three votes to answer 3, two votes to answer 2 and one vote to answer 

1. It follows that answer 3 was considered the most important, with a total of five votes. In second 

place follows answer 1 with four votes, and in third place answer 2 with three votes. 
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The option Calculate results next in rank can be switched on in the properties of the question. 

Go back to the previous slide. Click on the question with the right mouse button and choose the option 

Properties. In the Properties of question dialog box you select the option Calculate results next in rank. 

Click on OK to apply these settings and close the dialog box. Go to the next slide. 

Displaying results next in rank 
When you display the separate choices it can be useful to show the results next in rank. When show-

ing results next in rank, the answer that received most votes is displayed at the top of the result 

diagram. The answer that received the least votes is displayed at the bottom. You can see at a single 

glance which answer received the most votes. 

To display the results next in rank, you go to the properties of the question and enable the Display 
results next in rank option. 

Go back to the previous slide. Click on the question with the right mouse button and choose the options 

Properties. In the Properties of question dialog box, you enable the Display results next in rank option. 

Click on OK to apply the changes and close the dialog box. Then go to the next slide. 

The total results are now displayed next in rank. When you split these results into the first choice, 

you immediately see which answer most people voted for first. When you split them into the second 

choice, you see which answer most people voted for second, etc. 

Split these results into the first choice by pressing  + . 

You see at a 
single glance 

which answer 
most people 
voted for as 

their first 
choice 
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Answers that received the same number of votes are displayed underneath each other. The exact 

order in which this happens however is undetermined. 
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Printing the script 

When you are going to use your script during a session, it could be helpful to have a printed overview 

of your script. With this overview, you can see which question is going to be the next and which slide 

contains this question. Besides, you can make notes about which question needs to be crossed or 

compared with which other question. 

There are several ways in which you can print the script. You can make a print-out that only contains 

the questions and answers. But you could also make a print-out of the entire slide, so that you can 

see which question has its result on the next slide, or where the slides without questions are. 

When printing a script, any result, if available, will also be printed. This can be done in a text-only 

format, together with the question and results, or in a slide overview, in which the entire charts are 

printed. 

The results that are printed are the results that are displayed in the script when you are printing it. 

Until now you have been working on your script using example results. These are the only type of 

results that cannot be printed to prevent you from accidentally printing example results instead of 

real results after a session. As long as there are example results in your script, you cannot print it. 

Removing example results 
There are two ways to remove the results from the charts, showing empty charts again. Choose the 

option Clear charts from the Results menu. All results are now removed from the charts. 

When you imported the example results (see “Importing example results“ on page 27) you actually 

opened an existing session (see also “Using a session again“ on page 163). By closing the session, 

the results will be removed from the charts, too. You can close the session by choosing the option 

Stop session from the Voting menu. 

Choose the option Clear charts from the Results menu. 
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The example 
results have 

been re-
moved from 

the charts 

 

Printer settings 
The default printer as defined in Windows is used to print a script. Should you want to select another 

printer, check whether the correct printer is selected or change the settings of the printer, you can 

choose the option Printer settings from the File menu. 

Choose Printer settings from the File menu. 

The standard Print dialog box appears. In this box you can select a printer or change the printer 

settings. 

The standard 
Print dialog 

box 

 

When necessary, select the correct printer and click Print to apply the settings. 
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Printing a script overview 
To print a script, you choose the option Print from the File menu. Alternatively, you can click the 

Print ( ) button in the toolbar or press  +  on the keyboard. 

Click the Print button in the toolbar. 

A dialog box appears where you can indicate what you want to print and how you want it to be 

printed. 

Dialog box 
for printing a 

script 

 

 

Slides 

Instead of printing the entire script, you could also choose to print a certain number of slides. 

From slide This box shows the slide number and a description of the slide, if available. This is the 

first slide to be printed. 

To slide This box shows the slide number and a description of the slide, if available. This is the last 

slide to be printed. 

Cross 

While printing the script, you can have the results automatically crossed with a certain question. 

Cross all slides with question Select this option if you want to cross all questions in your script 

with one of the other questions, before they are printed. From the list under this option, you choose 

the question with which you want the other questions to be crossed. This option is only available 

when a session has been started or when results have been imported. This option does not apply to 

all print types. 
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Print 

Questions, answers and results can be printed in various ways. You could for example, choose to 

only print a text overview, but it is also possible to print a complete slide overview. 

Print as type Here you choose how you want to print the selected slides. 

Settings 

By clicking on the Settings button, the standard Print dialog box appears, in which you could select 

a different printer or change the settings of the printer. 

Select, as far as it hasn’t been done yet, slide number 1 in the box From slide and slide number 9 in the 

box To slide. Select “Script layout” in the Print as type box. Click on OK to print the script overview. 

Printing a handout 
When printing a handout not only the questions and answers are printed, but instead an image of 

the entire slide is printed. This results in an overview of the slides as they will be presented on the 

screen. 

To print a handout, you choose the option Print from the File menu. In the dialog box, you select 

the option “Handout” from the Print as type box. 

Choose the option Print from the File menu. From the Print as type box, you choose the option 

“Handout”. Next, click on OK. 

A dialog box appears where you select how many slides you want to be printed on one page. 

The dialog 
box where 

you can 
choose how 
many slides 

should be 
printed on 

one page 

 

If you choose one slide per page, each slide will be printed full page. If you choose two slides per 

page, two slides will be printed under each other, et cetera. 

Additionally you can set a number of options that control whether the slide number or question 

number should also be printed, or whether slide should be printed within a frame. 

Include slide number When this option is checked, the slide number will be printed at the top-

left, next to the slide. 
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Include question number When this option is checked, and a question is available on the slide, 

the question number will be printed at the bottom-right, below the slide. 

Print slides in frame When this option is checked, the slide is printed within a frame. A black 

rectangle will be printed surrounding the slide. This is especially useful when you have a lot of slides 

with a white or other light colored background. 

Choose the option 4 slides and check the option Include slide number. Next, click on OK to print the 

handout. 

Printing to file 
In the dialog box for printing a script you can choose several options from the Print as type box, 

that don’t send the results to a printer, but to a file instead. This allows you to also save the script 

overview to a file. This file contains the same information that would normally be printed on paper. 

Other options are printing a complete slide to an image. This allows you to make images of all your 

slides, for example for inserting them in a Word document. 

For printing to a file you choose the Print option from the File menu. In the dialog box that is shown 

you choose the option “Script overview (to file)” from the Print as type box. When you click on OK, 

the standard dialog box for saving files appears. You enter the name of the file and choose the 

location where you want to save this file. Click on the Save button to actually save the file. 

Choose the Print option from the File menu. From the Print as type box, choose the “Script overview 

(to file)” option. Click on OK. In the dialog box you enter the name of the file and choose a location. 

Click on Save to save the file. 

To save the slides as images, you also choose the Print option from the File menu. If you don’t want 

to save all slides as images, you can choose from which slide and to which slide you want to save to 

an image from the From slide and To slide boxes. From the Print as type box you select the 

“Print to file (Bitmap)”, “Print to file (JPEG)” or “Print to file (PNG)” option, depending on which 

image format you want to save. After you click on OK, the dialog box for selecting a folder appears. 

Choose the Print option from the File menu. From the Print as type box, choose the “Print to file (PNG)” 

option. Next, click on OK. 
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The dialog 
box where 

you select a 
folder to save 
the images in 

 

In this dialog box you select the folder where you want to save the images. After you have selected 

a folder you click on Select Folder to save the images in the selected folder. Saving the images can 

take some time, depending on how many slides you want to save. 
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Creating a list of participants 

In IVS-Professional you can indicate per question whether it should be identified or voted anony-

mously. 

When you use RF-I or RF-II keypads, each participant gets a chip card to participate in an identified 

voting. This chip card has to be inserted into the keypad during the voting. Without a chip card it is 

not possible to vote. 

If you use Lite keypads, the keypad itself is the identification. There is no need to insert a chip card. 

Before you can use your script to vote, you first have to make a list of participants. This is a list that 

contains all the chip cards or keypads that may take part in the voting. Although it is possible to vote 

with chip cards that do not appear in this list, the votes are discarded by the software. It is not 

possible to vote with keypads that are not in this list. 

It is also possible to link the name of a participant to a chip card or keypad. Later, when you are 

going to print or export the results, you can see what each individual participant has voted. The 

participant can also be categorized into a group, which makes it possible to review the results per 

group. 

Finally, it is possible to link a vote weight to a chip card or keypad. This allows a participant with a 

higher vote weight to exercise more influence on the voting than a participant with a lower vote 

weight. 

A simple list of participants with chip cards 
The IVS-Participant Registration utility allows you to make a list of participants with names, groups 

and voting weights. By then inserting the chip cards into the chip card reader one at the time, or by 

entering the identification number of the keypad, you can link the chip card or keypad to a partici-

pant. 

Close IVS-Professional and then start IVS-Participant Registration. You can find IVS-Participant Registra-

tion in the Start Menu under IVS. 
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IVS-Partici-
pant Registra-
tion for creat-

ing a par-
ticipants list 

 

The chip cards that are going to be used can be read with the chip card reader that comes with the 

system. The chip card reader is connected to one of the computer’s USB ports. When you connect 

the chip card reader for the first time, you have to install the driver only once. This driver is installed 

automatically by Windows. After having connected the chip card reader, it is initialized automati-

cally. When necessary, you can select the appropriate chip card reader from the Reader menu. If 

your card reader is not listed, check whether the driver has been installed correctly. 

Select a chip 
card reader 

for register-
ing chip cards 

or choose 
manual regis-

tration for 
registering 

Lite keypads 

 

To register keypads, there is no need to connect a chip card reader. Should this still be the case, 

select the Manual registration option from the Reader menu. 

Connect the chip card reader to a USB port. Install the drivers when necessary. Then choose the OMNI-
KEY CardMan 3x21 0 option from the Readers menu. The chip card reader will now be initialized. 

By creating a simple list of participants, you just place the chip cards or keypads that are going to be 

used in a list. During a voting, only those participants, that own a chip card or keypad that was 

placed in this list, can vote. Although it is possible to vote with a chip card or keypad that is not 

listed in the list of participants, the votes are discarded by the software. 
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To create a simple list of participants, choose the Create default list option from the Participant 

menu. After Number of new participants, you fill in the number of chip cards or keypads that you 

want to place in the list of participants. 

Creating a de-
fault list of 

participants 

 

Click on OK to create the list of participants. The participants in this list will not receive a name, do 

not belong to any group and all have a voting weight of 1 vote. 

Choose the Create default list option from the Participant menu. For Number of new participants 
you enter 25. Then, click on OK. 

If it turns out that you have added insufficient participants to your list of participants, you can select 

the Create default list option once again, to add some extra participants to the list. 

Adding names and groups 

The Create default list option also allows you to create a default list where each participant does 

get a name and, when necessary, a group. To do this, enter the name of the participant in the input 

field after Name and enter the name of the group you want to add this participant to, in the input 

field after Group. Please note that all participants get the same name, group and voting weight. 

When necessary, you can add an index number to each participant name. Enter the staring value for 

the index, placed between square bracket, into the input field after Name. 

Suppose you want to create a default list with 100 participants divided into two groups, with Partic-

ipant 1 to Participant 40 in the group MALE and Participant 1 to Participant 60 in the group FEMALE. 

Choose the Create default list option, enter 40 for Number of new participants, enter Participant 

[1] for Name and MALE for Group. Click on OK. Again, choose the Create default list option, enter 

60 for Number of new participants, enter Participant [1] for Name and FEMALE for Group. Click on 

OK. 

Registering chip cards 

After creating a default list, the first participant from this list is automatically selected, so that you 

can link a chip card to this participant. To do this, you insert a chip card into the chip card reader. 

After reading the chip card, the identification number of the chip card is displayed. On the right hand 
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side of the window, you can see how many participants have already been registered, that is, are 

linked to a chip card, and how much voting weight has already been registered. 

Linking a chip 
card to a par-

ticipant 

 

When you remove the chip card from the chip card reader, the next participant is automatically 

selected, so that you can immediately register this participant. When all participants have been reg-

istered, the automatic registration process ends. 

Insert a few chip cards into the chip card reader to link these to the participants. 

Registering keypads 

After creating a default list, the first participant from this list is automatically selected, so that you 

can link a keypad to this participant. To do this, enter the keypad’s unique identification number and 

click on the Register button to register this participant. On the right hand side of the window, you 

can see how many participants have already been registered, that is linked to a keypad, and how 

much voting weight has already been registered. 

If you own a barcode scanner, you can also scan the keypad’s identification number with the barcode 

scanner. Depending on the scanner you use, you don’t even have to click the Register button. 

Linking a key-
pad to a par-

ticipant 
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After clicking the Register button, or after this was done automatically by the barcode scanner, the 

next participant is automatically selected, so that you can immediately register this participant. When 

all participants have been registered, the automatic registration process ends. 

Enter some keypad IDs and click on the Register button each time to link these to the participants. 

Saving the list of participants 

You can now save the list of participants you created by choosing the option Save from the File 

menu. 

Choose the option Save from the File menu. 

The standard dialog box for saving files appears. Here you enter the name of the file and choose a 

location to save the file. Preferably save the file in the Participant Lists folder as indicated by IVS-

Participant Registration. IVS-Professional will automatically display this folder when you have to 

select a participants list. 

Enter the name of the participants list: “Participants test script” and click on the Save button to save 

the participants list. 

A list of participants based on names 
Instead of making a simple list of participants, you can also make a list of participants based on the 

participants’ names. By doing so, you link a chip card or keypad to an individual participant. Addi-

tionally, you can arrange the participants in certain groups and link a certain voting weight to this 

participant. 

To create a list of participants based on names, you choose the Manage option from the Participant 

menu. The participant management window appears, where you can add, edit and delete individual 

participants. 
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Add or edit 
individual 

participants 

 

Choose the Manage option from the Participant menu. 

To add a participant, click in the window with the right mouse button and choose the Add option, 

or press  + . 

Adding a par-
ticipant 

 

Click in the window with the right mouse button and choose Add. 

After Name, you fill in the name of the participant. After Weight, you fill in the voting weight that 

you want to link to this participant. If you don’t want to use a voting weight, you enter the default 

voting weight of 1 for each participant. 

It is also possible to arrange the participants in different groups. When playing a quiz you can show 

the group scores as well as the individual scores. To place a participant in a certain group, you just 

enter the name of the group after Group. If you don’t want to use any group, leave this field empty. 

With the Qualified to vote option, you determine whether this participant can vote or not. This 

option is especially useful when using multiple identification groups. For more information, see “A 

list of participants with multiple identification groups“ on page 130. 

After filling in all the information, click on OK to add this participant to the list of participants. 
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Enter John Smith as the name, RED as the group and 5 as the voting weight. Next, click on OK. 

A participant 
with name, 
group and 

voting weight 
was added 

 

Repeat these steps for the other participants. 

Importing a list with names 

If you already have a list with the names of all participants, you can import this list, so that you don’t 

have to enter all the names one by one. 

You can import a list with names by choosing the option Import from the File menu. If there are 

already participants in the list, you are first asked whether you want to clear this list before importing 

the list with names, or want to keep the current list. If the latter is the case, the imported names are 

added to the current list. 

You can either import a text file or an IVS card list. A text file contains the information for one single 

participant on each line, starting at the second line. First thing on the line is the participant’s name, 

then a tab as a delimiter followed by this participant’s group name, and finally another tab as de-

limiter followed by the voting weight for this participant. The first line in the text file is reserved for 

group definitions. 

Registering participants 

After adding all participants, or after importing an existing list with names, you can start registering 

the participants. You can register a specific participant by clicking on the Search button and finding 

the relevant participant in the list. After selecting the participant, you can register this participant by 

placing a chip card in the chip card reader or by entering the keypad’s identification number. 

When you want to register all participants one by one, without having to search for a specific par-

ticipant, you can choose the Automatic participant selection option from the Participant menu. 
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The first non-registered participant is now selected. After registering this participant, the next non-

registered participant is automatically selected. 

Unregistering participant 

When you register a participant with the wrong chip card or keypad, you can unregister this partici-

pant. To do this, select the Unregister option from the Participant menu. Insert the wrongly regis-

tered chip card or enter the identification number of the wrongly registered keypad to detach this 

chip card or keypad from a participant. Next, select the Register option from the Participant menu 

to link the correct chip card or keypad to this participant. 

Checking participants 

When you have a chip card or keypad and don’t know to which participant it belongs, you can check 

the chip card or keypad. Select the Check option from the Participant menu. Insert the chip card or 

enter the keypad’s identification number and click on the Check button. When this chip card or 

keypad was linked to a participant, the participant’s information is shown. 

A list of participants with multiple identification groups 
You can create multiple so-called identification groups from all the participants in your list of partic-

ipants. Each identification group contains all the participants from your list, but you can change a 

participant’s voting rights, put him in a different group or give him a different voting weight, per 

identification group. You can define as many identification groups as you need. In IVS-Professional, 

you can choose per question which identification group you want to use for this question. 

To be able to use identification groups, the advanced mode should be enabled. You can enable the 

advanced mode by selecting the User Interface option from the File menu, and then selecting the 

option Advanced Mode. 

To create another identification group, you open the participant manager by selecting the Manage 

option from the Participant menu. 

Next, select the Show participant information for this identification group option and, 

when necessary, choose a different identification group. All participants are initially shown with their 

default information. You can then edit each participant’s information. You can modify the group 

name and voting weight and whether participants are entitled to vote or not. The participant’s name 

cannot be modified. 

You can modify the information for multiple participants all at once, by first selecting multiple par-

ticipants, then clicking on one of the selected participants with the right mouse button and selecting 

the Edit option. When the participants are arranged in different groups, the group name edit box 

will be empty. Leave this edit box empty, to leave the current group name of each selected participant 

unchanged, or enter a new group name for each selected participant. Likewise, the edit box for the 
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voting weight is empty, when the selected participants have a different voting weight, and the voting 

right checkbox contains a square when the selected participants don’t share the same voting rights. 

When necessary, you can change to voting weight, and check or uncheck the voting right checkbox, 

to change the voting weight and voting right for all selected participants. 

After selecting a different identification group, it is not possible to add new participants. This is only 

possible when showing the default participant information. It is also not possible to delete partici-

pants from a different identification group. When choosing the Delete option, you only delete the 

changes made to the default information, so that this participants gets the same settings as he has 

in the default participants list. 

In the advanced mode, it is also possible to connect three user-defined values to a participant. You 

can fill in any text you like. In IVS-Professional, you can show any of these three values by using a 

field. 

Close IVS-Participant Registration and start the IVS-Professional. In the startup dialog you choose the 

last used script “Starting with IVS-Professional” and click on OK to reopen the script. 
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Connecting the network 

Now that you created a script with a number of slides and questions you can let your audience vote 

on these questions. To do so, you use the Base Station, that has to be connected to your computer, 

and a number of keypads, that have to be initialized by the Base Station. Keypads and Base Station 

together make up the voting network. 

The keypad is used to have the audience cast their votes. Each participant receives one keypad to do 

so. There are 10 or 11 keys on the keypad that allow the audience to make a choice. The LCD screen 

displays the choice that is made. To correct the choice made, the keypad has a correction key. On 

RF-I and Lite keypads this is the red key. On RF-II keypads it is the red C-key. On both RF-I and RF-II 

keypads you find this key on the left side of the keypad. On Lite keypads you find this key to the left 

of the LCD screen. 

On the RF-II keypad, there are two scroll keys and an enter key just below the LCD screen. Whether 

these keys are used or not depends on the settings of each question in the script. 

All keypads have a built-in wireless transmitter and receiver that are used to communicate with the 

Base Station. The Base Station controls the keypads to open and close a voting and to activate only 

those keys that are relevant for the voting. Furthermore, the Base Station receives the information 

from the keypads during a voting. These are processed and transferred to IVS-Professional, so that 

it can show the results in a chart. A RF-I or RF-II Base Station can control up to 1,000 keypads and a 

Lite Base Station can control up to 250 keypads. 

The keylock 
You need a license for IVS-Professional to be able to use the voting network. This license determines 

how many keypads you can use. One license you get free of charge with the software. This license 

allows you to use a maximum of 30 keypads. For all other licenses, you need to connect a so-called 

keylock to the computer. Depending on the keylock you use, you get a license for a maximum of 250 

keypads or 4,000 keypads. 

Keylock for 
connecting to 
the USB port 

 

The keylock should be connected to a USB port of the computer. 
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Charging the keypads 
To be able to operate completely wireless, the keypads are equipped with a battery. Depending on 

the type of keypad, this is either a rechargeable NiMH-battery, or two normal AA-type batteries. 

The RF-I and RF-II keypads are equipped with a rechargeable battery. These keypads come in a 

charging case, that cannot only be used to transport the keypads, but also to charge the battery. To 

charge the keypads, you place them in the charging case with the charging contacts facing down 

and then switch on the case by connecting it to the AC power. 

RF-I keypads 

When the case is switched on, the battery status of the keypad is indicated by a LED. When charging 

the battery the LED blinks red. When the battery is fully charged the LED lights continuously red. 

It takes about two hours to fully charge the battery. After that, the keypad can be used for about 

eight hours. 

The moment the keypad is taken from the case, it switches itself on. A keypad stays switched on 

until it is put back into the case to be charged, or until the battery runs empty. 

RF-II keypads 

When the case is switched on, the battery capacity of the keypad is indicated by the LED. 

When the battery is charged for less than 40% the LED lights continuously red. When it is charged 

between 40% and 70% the LED will blink red. When charged over 70% the LED will blink green. 

When fully charged, the LED lights continuously green. 

It takes about five hours to fully charge the battery. After that, the RF-II keypad can be used for 

approximately 20 hours. 

The moment the keypad is taken from the case, it switches itself on. A keypad stays switched on 

until it is put back into the case to be charged, or until the battery runs empty. 

Lite keypads 

When the keypad is equipped with a set of fully charged batteries, it can be used for approximately 

one year. If the batteries are empty, they must be replaced with a new set of batteries. 

A Lite keypad is normally switched off and is only switched on when a key is pressed. 

Connecting the Base Station 
The Base Station has to be connected to a USB port of your computer. Always use the USB cable that 

comes with the system. An RF-I or RF-II Base Station also has to be connected to the AC power using 

the supplied adapter. When connected to the power, a red LED lights at the front side of the Base 
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Station. A Lite Base Station is powered by the USB bus, so there is no need for a separate power 

adapter. When the computer is switched on, a red LED lights at the front side of the Lite Base Station. 

When the Base Station is connected to the computer for the first time, you have to install the device 

drivers. Please refer to the separately supplied “Supplement connecting USB Base Station” booklet. 

To achieve the best communication with the keypads, do not place the Base Station too close to 

computers or other devices, or in the neighborhood of cables. If you need the Base Station in a large 

room we advise you to place it on a tripod in the front or in the back of the room with the front of 

the Base Station facing the audience. 

Communication with the Base Station 
When the Base Station is connected to the computer and, when necessary, to the AC power and the 

device drivers are installed, IVS-Professional can communicate with it. To establish this communica-

tion, you choose the option Settings from the Communication menu. A dialog box for setting up 

the communication appears. 

Connect your Base Station to a USB port and connect it with the supplied adapter to the AC power. 

Install the device drivers for the Base Station when you are asked to do so. Then, choose the option 

Settings from the Communication menu. 

The dialog 
box to set the 

communica-
tion helps you 

through the 
settings in 
only a few 

steps 

 

Searching for clusters 

By installing the device drivers for the Base Station, your computer gets an extra serial port. This port 

is used to communicate with the Base Station. In the Communication Settings dialog box you will 

see an overview of all serial ports available on your computer, up to a maximum of sixteen ports. 

For each of these ports you can indicate if a Base Station is connected to it or not. 
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You can manually indicate on which ports a Base Station has been connected, but you can also have 

the wizard automatically detect which ports have a Base Station connected and what type of Base 

Station this is. 

If you choose Detect connected USB clusters automatically (recommended), the wizard 

retrieves the information about the connected clusters from the Windows device manager. This is 

the fastest method to detect the clusters, but it only works to detect the most common USB-con-

nected clusters. 

If you choose the Search for all clusters option, the next step is that the wizard will check each 

port to see which cluster is connected to it. This method is a lot slower, but it also detects the less 

common clusters connected to the serial port. 

If you choose for the Setup the clusters manually (advanced) option, automatic searching is 

skipped. 

Click Next to start the automatic searching of the clusters, or to manually select the clusters. 

Choose the Detect connected USB clusters automatically (recommended) option and click on Next to 

continue. The wizard retrieves the information about the connected clusters from the device manager. 

Selecting the clusters 

For each of the available serial ports, you have to indicate whether a cluster is connected to this port, 

and if yes, which type of cluster. If you had the clusters detect automatically, the correct clusters are 

already filled in for the appropriate serial ports. 

The automati-
cally detected 

clusters are 
already se-

lected 
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For each of the available serial ports you select which type of cluster is connected to it. If no cluster 

is connected to a serial port, select ‘None’. After having selected the correct clusters, you click Next 
to continue. 

Click on Next to continue. 

Selecting channels 

To be able to communicate over a wireless connection, the Base Station uses one of the available 

channels. Because multiple channels are available, multiple Base Stations can be used together, 

without them interfering with each other. If two Base Stations are in each other’s vicinity and they 

both use the same channel, they will interfere with each other, which causes a very bad wireless 

connection with the keypads. 

Select a chan-
nel for the 
keypads to 

communicate 
with the Base 

Station 

 

In the Communication Settings dialog box you see an overview of all serial ports to which a Base 

Station is connected. For each of these ports you can indicate which channel the Base Station should 

use to communicate with the keypads. 

If you use only one Base Station it does not matter which channel you choose for communication. 

However, if you use multiple Base Stations, or if there is an active Base Station in a room nearby, 

you have to select a unique channel for each Base Station. 

If you use an RF-I or RF-II Base Station, you can choose from four different channels. You can there-

fore also use a maximum of four Base Station at the same time. If you use a Lite Base Station, you 

can choose from 51 different channels. Although it is theoretically possible to use a maximum of 51 

Base Stations, in practice you cannot use more than sixteen Base Stations, because the software 

cannot select more than sixteen ports. 

After you have set the channel, click the Next button to continue. 
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Select “RF-II Channel 2” and click Next to continue. 

Initializing the clusters 

After selecting the correct serial port and setting the channel, the Base Station can be initialized. 

During initialization, IVS-Professional checks whether it can communicate with the Base Station on 

the selected serial port. If communication succeeds, the Base Station is set to the selected channel. 

The con-
nected Base 
Station can 

be initialized 

 

In the Communication Settings dialog box you see an overview of all serial ports to which a Base 

Station is connected. The status of the Base Station is indicated by means of a LED. A red LED indi-

cates that the Base Station hasn’t been initialized yet. A dark red LED indicates communication with 

the Base Station. A green LED indicates that the Base Station has been successfully initialized. A 

yellow LED indicates that the selected serial port could not be used for communication. If that is the 

case, check to see whether other software that is running on your computer, might keep the serial 

port busy. If that is the case, close this software, or select a different serial port to connect the Base 

Station to. Please refer to the separately supplied booklet “Supplement connecting USB Base Sta-

tion”. 

To initialize the Base Station click the Initialize button. When the Base Station has been initialized, 

this is indicated by a bright green LED. If the LED stays red, click the Previous button to check the 

settings. Also check whether the Base Station is connected to the AC power, whether it is correctly 

connected to a USB port of the computer and whether the device drivers have been installed. 

After the Base Station has been successfully initialized, you could if necessary check the version of 

the Base Station. To do this, move the mouse over the text behind the green LED. A little window 

appears showing the version number of the Base Station. This version number consists of two parts. 

The first part indicates the version of that part of the Base Station that communicates with the com-

puter. The second part indicates the version of that part that communicates with the keypads. 
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Click on Initialize to initialize the Base Station. 

The con-
nected Base 
Station has 

been initial-
ized and the 

version num-
ber is show-

ing 

 

After initializing the Base Station, click the “Next” button to continue. 

Click Next to continue. 

Keypad functionality 

There are three types of Base Station: the RF-I Base Station, the RF-II Base Station and the Lite Base 

Station. There are also three types of keypad: the RF-I keypad, the RF-II keypad and the Lite keypad. 

The RF-I keypad and the RF-II keypad can be used by both the RF-I Base Station and the RF-II Base 

Station. The Lite keypad can only be used by the Lite Base Station. 

If you use an RF-I Base Station, there is no need to choose the keypad functionality. RF-I functionality 

is automatically selected. You can use both RF-I and RF-II keypads, but you cannot use the extra 

features of the RF-II keypad. 

If you use an RF-II Base Station, you have to choose which keypad functionality you are going to use. 

This keypad functionality determines whether you can both use RF-I and RF-II keypad, or whether 

you can only use RF-II keypads. 

If you use a Lite Base Station, there is no need to choose the keypad functionality. You can only use 

the Lite keypads. 
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If you use an 
RF-II Base 

Station, you 
can choose 

the function-
ality of the 

keypads 

 

If you are only going to use RF-I keypads, you choose RF-I functionality. If you are going to use 

both RF-I and RF-II keypads, you also choose RF-I functionality. If you are only going to use RF-II 

keypads, you choose RF-II functionality. 

After having chosen the functionality, you click the Next button to continue. 

Choose the option RF-II functionality and click Next to continue. 

Initializing keypads  

Keypads have to be initialized before the Base Station can communicate with them. During initiali-

zation the keypad will be set to the same channel as to which the Base Station was set. 

Only when you use an RF-II Base Station and you chose to use RF-II functionality you can choose 

which keypads should be initialized. 
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An RF-II Base 
Station can 

initialize both 
keypads that 

are outside 
the case and 
keypads that 

are still inside 
the case 

 

Initialize keypads outside charging case (recommended) If you start initializing the key-

pads, only keypads that were taken from the charging case will be initialized. This option is recom-

mended, because with this option the keypads can always be initialized. 

Initialize keypads inside charging case With this option, only the keypads that are still inside 

the charging case will be initialized. The only condition is that the charging case cannot be connected 

to the mains anymore. After disconnecting the case from the mains, the keypads can be initialized 

for a period of ten minutes. After that, the keypads can no longer be initialized. 

Initialize both inside and outside charging case This option initializes all keypads, whether 

they are still inside the case, or were taken from the case. Keypads that are still in the charging case 

can only be initialized when the case is no longer connected to the mains. After disconnecting the 

case from the mains, the keypads can be initialized for a period of ten minutes. After that, the key-

pads can no longer be initialized. 

After having indicated which keypads you want to initialize, click the Next button to continue. 

Select the Initialize keypads outside charging case (recommended) option and click the Next button to 

continue. 

Vote time 

If you have an RF-II Base Station with software version 5.12 or higher, and you chose to use RF-II 
functionality, you can make use of the voting time of the keypad. 



141 

If your Base 
Station sup-
ports it, you 

can make use 
of the voting 

time of the 
keypad 

 

Keypad vote time (recommended) Select this option to use the vote time of the keypad. During 

the voting, the keypad keeps track of the time from the moment the voting is opened, until the 

moment a key is pressed. This vote time is very accurate. However, the keypads have to support the 

vote time. If you choose this option while your keypads do not support the vote time, they will not 

open when you open the voting. Keypads with a software version 3.25 or higher support the vote 

time. You can check the version number by testing the network (see also “Testing the network“ on 

page 144). Keypads with software version 3.25 or higher will show their version in the display. Key-

pads that do not show a version in the display have a software version that is at least lower than 

3.25. 

Base Station vote time Select this option if you don’t want to use the vote time of the keypads, 

but instead want to use the vote time of the Base Station. This vote time is less accurate than that 

of the keypad. Only choose this option if you are using keypads that do not support the vote time. 

If your Base Station has a software version lower than 5.12, this step is automatically skipped. You 

can still make use of the vote time. In that case the vote time of the Base Station will be used. 

After you have indicated which voting time you want to use, click the Next button to continue. 

Select the option Keypad vote time (recommended) and click on Next to continue. 

Storing the configuration 

Now that the Base Station has been set up and initialized, you can store this configuration. Every 

time you start IVS-Professional, it will try to initialize the Base Station with these same settings. 



142 

You can have 
IVS-Profes-

sional auto-
matically ini-

tialize the 
Base Station 

when starting 
the program 

 

Yes, store this configuration If you start IVS-Professional, it tries to initialize the Base Station 

on the same serial port and with the same channel you just configured. 

No, I want to select a different configuration next time When you select this option, IVS-

Professional does not try to initialize the cluster during startup. Select this option if you often use 

IVS-Professional without any Base Stations connected, for example, when you are only preparing 

scripts. 

After having selected the desired option, click the Finish button to finish the setup of the Base Sta-

tion. 

Choose the option Yes, store this configuration and click Finish to finish the set up. 

Initializing the keypads 
After the Base Station has been set up and initialized, you have to initialize the keypads. During 

initialization, all available keypads will report themselves to the Base Station. The Base Station num-

bers the keypads and sets them to the same channel the Base Station was set. 

If you are using RF-II keypads, you can see when a keypad is initialized. In that case, you can see the 

IVS® logo in the LCD screen. When using RF-I keypads or Lite keypads you cannot see whether a 

keypad is initialized or not. 

To initialize the keypads select Initialize all keypads from the Communication menu. 

Choose the option Init ialize all keypads from the Communication menu. 
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The operating 
mode and the 
number of ini-

tialized key-
pads is dis-

played in the 
initialization 

dialog 

 

During initialization of the keypads the Initialization dialog is shown. It shows in which mode the 

Base Station is currently operating and the number of keypads already initialized by the Base Station. 

When the number of keypads changes, it will be displayed in red. If it stays the same for more than 

a second, it is displayed in blue. When the number of keypads has reached the maximum license, it 

is displayed in purple. 

If you use RF-I keypads, you have to take them out of the charging case before they can be initialized. 

As soon as a keypad has been initialized, you will see that the counter in the initialization window 

is increased by one. 

If you use RF-II keypads, you have to take them out of the charging case before they can be initialized. 

As soon as a keypad has been initialized, you will see that the IVS®-logo appears in the LCD screen. 

In the initialization window you will see that the counter is increased by one. 

When using Lite keypads, you first have to switch them on before they can be initialized. You can 

switch on a Lite keypad by pressing a random key. The key you pressed appears in the LCD screen. 

The keypad will then try to find a Base Station. If it finds a Base Station, the red LED lights. The 

keypad then waits until the Base Station confirms that it has found a keypad. When the keypad 

receives this confirmation, the green LED lights shortly and the number disappears from the LCD 

screen. The keypad has now been successfully initialized and the counter in the initialization window 

is increased by one. 

If you are initializing keypads and the number stops at 30, even though you took more keypads from 

of the case, check whether you connected your keylock. Also see “The keylock“ on page 132. 

Take all keypads that you want to initialize out of the charging case. Wait until all keypads show the 

IVS®-logo on the LCD screen. Also check the initialization dialog to see if the number of initialized key-

pads matches the number of keypads that you took out of the charging cases. 

When all keypads are initialized, you can click on the Stop button in the initialization dialog to stop 

the initialization of the keypads. 

Click on Stop to stop initializing the keypads. 
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Saving a list with initialized keypads 
When all keypads have been initialized, the Base Station maintains a list of the keypads it initialized. 

This list is also stored on your computer by default. In the unlikely event that the Base Station would 

get disconnected from the mains, this list can be restored in the Base Station. This prevents you from 

having to put all keypads back in the charging cases and having to initialize them again. 

You can also save the list of keypads yourself, allowing you to choose a file name and a location 

where you want to save the list. This can be useful if you want to take the list to another computer. 

To save the list, select Save initialized keypads in the Communication menu. 

The standard dialog box for saving files appears. You can enter the name of the list in here. 

The standard 
dialog box 
for saving 

files 

 

After you have entered a name, you click on Save to save the list. 

Enter the name of the list: “Test session IVS-Professional” and click on the Save button to save the list. 

Testing the network 
After initializing the keypads and saving the list of initialized keypads, you can test the RF-I and RF-

II keypads. During this test the Base Station continuously sends messages to the keypads. The key-

pads show that they receive the messages by alternately lighting their red and green LED respec-

tively. Because Lite keypads are switched off by default, and are only switched on when a key is 

pressed, they cannot be tested. 

After saving the list with initialized keypads, you are asked whether you want to test the network. If 

you only use Lite keypads, this question is skipped, because Lite keypads cannot be tested. 
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After saving 
the list, you 
can test the 

keypads 

 

Always respond Yes to this question to see if the keypads function correctly. 

Click on Yes to test the network of keypad. 

In the Test 
network dia-

log you can 
see how 

many key-
pads are ac-

tive 

 

While testing the keypads, the Test network dialog is displayed. It shows the mode the Base Station 

is currently operating in, how many keypads have been initialized by the Base Station and how many 

keypads do not respond to messages from the Base Station. 

Click on the Stop button in the Test network dialog to stop testing the network. 

Click on the Stop button to end testing the network. 

The keypads are now ready to vote. 
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Voting 

The script together with the initialized voting network offers the possibility to vote. The script you 

already made can be used to start a presentation. During the presentation, the script will be displayed 

full screen. You can project this presentation in the hall, so that your audience can read the question 

and answers on screen and can see the results immediately after voting. 

A script can be used several times for a presentation. This is why a session is started for each presen-

tation. All results of the keypads are stored during a session. If you have the same presentation 

again, you simply start a new session. By doing so, the new results will be stored without losing the 

previous results.  

After having given all presentations, you can easily review the results. By opening a session, the 

results of this session are displayed again. You can also cross and compare results just like during a 

real-time session. 

Starting a presentation 
You start a presentation by choosing the Start presentation option from the Voting menu. Alter-

natively, you can press  on keyboard. 

Press  to start the presentation. 

When you start a presentation, you must also immediately start a session. Only when a session has 

been started, or when no Base Station is connected, is the presentation screen immediately dis-

played. 

Starting a session 
You can give a name to each session you start. If you want to reopen a session, for example to have 

a look at the results again, or print the results, this helps you to find the session you want to open. 

When you start a session, a dialog box appears where you can enter the description for this session. 

If you have set at least one question to be identified, you must also select a list of participants. The 

session can only be started if you select a valid participant list. 
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Dialog box 
for entering 
the descrip-

tion 

 

If you have to select a list of participants, the last one you used is automatically indicated. It is very 

easy to use this one again. But if you want to use another list of participants, then you can choose 

one from the list, that displays the ten last used lists of participants. If you want to use a list of 

participants that is not displayed in the list, you can click on the Browse button ( ). The standard 

dialog box for opening files appears, in which you select the list of participants you want to use. 

After having entered a description and, when necessary, after having selected a list of participants, 

you click on OK to start the session. 

Enter the description for this session: “Test Session 10.30 am” and click on OK to start the session. 

The presentation screen 
After starting the session, the script will be displayed in the presentation screen. 

The first slide 
of the script 

is displayed in 
the presenta-

tion screen 

 

The slide is displayed full screen. Because there is a toolbar at the bottom of the screen, there is a 

black bar on each side of the slide. If you don’t want these bars to be displayed, you can enlarge the 

slide. However, part of the slide will be hidden behind the toolbar. 

To enlarge the slide, you press  +  on the keyboard. Press  +  again to display the 

slide full screen again. 
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Press  +  to enlarge the slide. 

By enlarging 
the slide, the 

black bars 
disappear, 

but the bot-
tom part of 
the slide is 
hidden be-

hind the 
toolbar 

 

To show the part of the slide that disappears behind the toolbar, you can hide the toolbar. But then 

you won’t be able to see any status information of the voting network. 

To hide the toolbar, press . By pressing  again, the toolbar will be displayed again. 

Press  +  to display the slide full screen again. 

Showing the presentation screen on a different monitor 
The presentation screen is normally shown on the same monitor as the edit screen. During a presen-

tation, it is not possible to edit the script anymore. When your computer supports the use of multiple 

monitors, you can show the presentation screen on a different monitor. When using a laptop, you 

can for example send the presentation screen to the beamer, while keeping the edit screen on your 

laptop monitor. 

When the presentation screen is shown on a different monitor, there is no need to display the status 

bar in the presentation screen. You can keep an eye on the progress of the voting by looking at the 

status bar in the edit screen. In this status bar you can also see that there is an active presentation. 

This is indicated by the ‘PRES’ indicator. 

You can set up on which monitor you want to show the presentation screen in the preferences of 

IVS-Professional. You open the preferences by selecting the Preferences option from the File menu. 

For more information, see “Preferences“ on page 231. 
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Locking the presentation screen 
When the presentation screen is shown on a different monitor, you can still use the edit screen for 

some last minute changes that become immediately visible in the presentation screen. If you don’t 

want these changes to be immediately visible, for example if you want to momentarily go to another 

slide, you can temporarily lock the presentation screen. As long as the presentation screen is locked, 

it will display the same image even if you use the edit screen to go to a different slide. 

You can lock the presentation screen by choosing the Lock presentation screen option from the 

Voting menu, or by pressing  on the keyboard. You can see whether the presentation screen has 

been locked or not by means of the ‘LOCK’ indicator in the status bar of the edit screen. By pressing 

 again, the presentation screen is unlocked. The slide that is currently displayed in the edit screen 

will also be displayed in the presentation screen. 

Opening the voting 
You can now vote on this question. To do this, you need to open the voting. By opening the voting, 

the proper keys on the keypad are activated. 

When you are using RF-I or RF-II keypads, after opening the voting the green LED lights. By pressing 

one of the keys, a vote is given. The red LED lights shortly, after which both LEDs are switched off. 

When both LEDs are off, the vote has been sent to the Base Station. 

The Lite keypads do not indicate that the voting has been opened. You can always press any key on 

the keypad, after which the keypad displays this key in the LCD screen. However, if no voting has 

been opened, the key pressed will almost immediately disappear from the LCD screen. 

If the voting has been opened, you can press any key on the keypad. If you press an invalid key – 

you press the 6 while there are only five answers, for example – the key pressed is displayed in the 

LCD screen and almost immediately disappears again. If you press a valid key, the keypad will try to 

find a Lite Base Station and the red LED lights when a Base Station was found. The keypad then 

waits until the vote is accepted by the software. If the vote is accepted, the green LED will light 

shortly and the vote disappears from the LCD screen. If the vote is not accepted – for example, when 

this keypad votes for the second time, while only one vote was allowed – the red LED will be switched 

off without the green LED lighting shortly. 

To open the voting, press  or click the Open voting ( ) button in the toolbar. You can see that 

the voting has been opened, because the status in the toolbar now says “Opened” instead of “Stand-

by”. Besides, the green LED in the toolbar is turned on. 

The keypad status is also shown in the toolbar. The “I:” indicates the number of initialized keypads. 

The “A:” indicates the number of keypads, that were active at the moment the voting was opened. 

The “K:” indicates the number of keypads that have voted, while the “V:” indicates the number of 

votes that were received so far. 
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If the question uses identified voting and you provided your participants with a voting weight, the 

“W:” indicates the total weight of the votes received so far. 

You determine which information is displayed in the status bar. If you right click on the information 

in the status bar, you can select which information you want to see and which information you don’t 

want to see. By default, all information is displayed except for the number of voted keypads. 

Press on  to open the voting. On all initialized keypads, the green LED is turned on. Press a key on 

each keypad. Only use the keys 1 to 6. 

Closing the voting 
When all votes have been received, you can close the voting. On all RF-I and RF-II keypads that 

haven’t voted yet, the green LED is turned off and the keypads do not respond to a key press any-

more. After closing the voting, the results are displayed in the result diagram. 

Press  or click the Close voting ( ) button on the toolbar to close the voting. The toolbar now 

shows “Closing” while the voting is being closed, after which “Stand-by” appears again. The results 

of the voting are displayed in the result diagram. 

Press on  to close the voting. 

You can vote all the other questions in the same way. Press on  or  to go to the next slide or 

click on the Next slide button ( ) in the toolbar. Open the voting by pressing  and close it again 

by pressing . 

Press on  to go to the next slide. Press on  to open the voting. Vote a few times for this question 

and press  to close the voting. Repeat this for each slide until you reach question 8. 

Voting on a question more than once 
With most of the questions it will only be possible to make one choice out of the available answer 

options. If the voting has been opened, the green LED on the RF-I and RF-II keypads lights. After 

giving a vote, the red LED lights shortly, after which both LEDs are switched off. It is not possible to 

vote anymore. 

On the Lite keypads, the red LED lights after giving a vote. After the vote has been confirmed by the 

Base Station, the green LED lights shortly, after which both LEDs are switched off. You can still press 

any key, and the red LED still lights, but the green LED will not light anymore. 

On a question that can be voted on more than once, you see that on the RF-I and RF-II keypads the 

green LED lights again, after the red LED was lit shortly. A second vote can now be given. Again, the 

red LED lights shortly. Only after the last vote has been given for this question, will both LEDs be 

switched off. 
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On the Lite keypads, both LEDs are switched off after the green LED was lit shortly. A second vote 

can now be given. Again, the red LED lights and after the vote has been confirmed by the Base 

Station, the green LED lights shortly. After the last vote has been given for this question, it is still 

possible to press any key, and the red LED still lights, but the green LED will not light anymore. 

Press on  to open the voting. Vote three times on each keypad. Then, press  to close the voting. 

Press  to go to the next slide, where the results are displayed. 
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Crossing and comparing in the 

presentation screen 

You can also cross and compare results in the presentation screen. The control, however, is a bit 

different from the control in the edit screen. Because the presentation screen is also shown on the 

big screen, no dialog boxes will appear on the screen. All information that needs to be entered to 

cross or compare is entered in the toolbar at the bottom of the screen. If this toolbar was hidden, it 

will automatically appear when something needs to be entered. 

However, if you show the presentation screen on a different monitor than the edit screen, all input 

will be entered the normal way in the edit screen. 

Crossing with a reference question 
Crossing a question with a reference question is very easy in the presentation screen. Press  +  

to cross the current question with the first reference question. Press  +  to cross the current 

question with the second reference question, etc. 

Go to slide 4. Press  +  to cross this question with the first reference question. 

A crossing 
performed in 
the presenta-

tion screen 

 

For more information about crossing with a reference question see “Crossing with a simple reference 

question“ on page 82. 
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Crossing with a normal question 
Even when a question is not set to be a reference question, you can still cross with it. Click on the 

Cross ( ) button in the toolbar or press  +  to perform a crossing. An edit box is activated in 

the toolbar. In the edit box you have to enter the question number with which you want to cross. 

Enter the question number and press , after which the crossing will be shown. 

If you would like to select a question from a list of available questions, press  +  to perform a 

crossing. Enter a 0 in the edit box and press . A dialog box appears from which you can choose 

a question to cross with. 

For more information about reference question, see “Asking a reference question“ on page 69. For 

more information about crossing with a reference question, see “Crossing with a simple reference 

question“ on page 82. 

Splitting a crossing 
You can split a crossed question in the presentation screen using the keys  +  to  +  . 

Use  +  to only show the results of the first reference. Use  +  to only show the results 

of the second reference, etc. 

When you have more than nine references, use  +  to split. Next, you enter the number of the 

reference and press . 

You can undo a split, by pressing  + . The original crossing will be shown again. 

For more information about splitting a crossing, see “Splitting a crossed question“ on page 87. 

Comparing questions 
To compare the current question with another question, you click on the Compare ( ) button in 

the toolbar, or press on  + . The edit box in the toolbar is activated. Enter the question number 

of the question you want to compare with. Next, press  to compare the current question with 

the other question. 

By entering a 0 instead of a question number, a list with available question is shown. From this list, 

you can choose a question to compare with. 

For more information about comparing questions, see “Comparing questions“ on page 95. 

Showing different choices 
A question that was voted more than once can also be split, so that you can show the results of the 

first choice, the second choice, etc. 
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To show the results of the first choice, you press  + . To show the results of the second choice, 

you press  + , etc. If you have a question that could be voted more than nine times, then you 

use  +  to split that question. In the edit box in the toolbar, you enter the number of the split. 

Next, you press  to show the split. 

You can undo the split, by pressing  + . The total results of this question are displayed again. 

For more information about questions that can be voted more than once, see “Voting a question 

more than once“ on page 104. 
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Ending the presentation 

When all questions are voted, you can end the presentation. Immediately after the presentation you 

can print the results. You can also export the results to use them in other software applications. 

Back to the edit screen 
After ending the presentation, you return from the presentation screen to the edit screen. In the 

editing screen, you can print the script or export the results. Press  to return from the presentation 

screen to the edit screen. 

Press  to return to the edit screen. 

Back in the 
edit screen 

where the re-
sults of the 
voting are 
still visible 

 

In the edit screen the results of the voting are visible too. When you return from the presentation 

screen to the edit screen, the session in which the results are stored, is still open. 

Printing a script layout with results 
In the edit screen, you can print a script overview, including the results that were just voted. To do 

this, you choose the option Print from the File menu. A dialog box appears in which you select what 

you want to print and how you want it to be printed. 

Choose the option Print from the File menu. 
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Dialog box 
for printing a 

script 

 

Select the slides you want to print and choose Script layout as print type. Click on OK to print the 

script. 

Click on OK to print all questions including the answers and the results. 

For more information about printing a script layout, see “Printing a script overview“ on page 119. 

Printing a handout with results 
Printing a handout with results is done in the same way. You choose the option Print from the File 

menu. In the Print dialog box you can select which slides have to be printed. Choose Handout as 

print type. 

Select the option Cross all slides with question to make a hand-out in which all questions are 

crossed. Choose a question from the list below with which you want all other question to be crossed, 

for example the question “Are you man or woman”. 

Select the option Print from the File menu. Select Handout as print type. Select the option Cross all 
slides with question. In the list of questions, select question “2. Are you…”. Click on OK to print the 

handout. 
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In the dialog 
box for print-

ing a script, 
you select 

that you want 
to print a 

hand-out and 
want to have 

all question 
crossed 

 

A dialog box appears where you can choose how many slides you want to print on one page. 

Choose the option 4 slides and click on OK to print the handout. 

For more information about printing a handout, see “Printing a handout“ on page 120. 

Exporting individual results 
To edit results in other application like Microsoft® Excel™, you can export the results. Choose the 

option Export from the File menu to export the results. 

Choose the option Export from the File menu. 

A dialog box for exporting results appears. 

The dialog 
box for ex-
porting re-

sults 

 

In this dialog box, you can enter a description for the results that you are about to export. You can 

also select in which format you want to export the results. The Individual results type only exports 

the results of each individual keypad. 

After having entered a description and selected an export type, you click on OK to export the results. 

Enter the description “Export individual results”, choose Individual results as export type and click on 

OK. 

A new dialog box appears in which you can change the export options. 
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Options for 
exporting in-

dividual re-
sults 

 

Score options 

Not only the individual results per keypad, but also a score per participant can be exported. This 

allows you to see which of the participants got the most points. 

Minimal and maximal score 

To only export the participants that have a certain score, or that stayed below a certain maximum 

score, you can indicate a minimal and/or maximal score. Only the participants below a certain mini-

mum or above a certain maximum or in between a minimum and maximum score are exported. 

Export only participants with a total score that is less than x points Choose this option 

if you want to export only those participants that stayed below a certain maximum score. You fill in 

a maximum score and only those participants that stay below this score will be exported. 

Lies between x and y points Choose this option if you want to export only those participants 

that stayed between a certain minimum and maximum score. You fill in a minimum and maximum 

score. Only participants that have more points than the minimal score and less points than the max-

imum score will be exported. For example, if you fill in a minimal score of 20 points and a maximum 

score of 25 points, then only participants with 21, 22, 23 or 24 points will be exported. 

Is more than x points Choose this option if you want to export only those participants that have 

at least a certain score. You fill in a minimum score and only those participants that got more points 

than this minimum score will be exported. 

Click on OK to continue. 

The standard dialog box for saving files appears. Enter the name of the file and choose a location to 

save the file. The description you have entered when exporting the results is automatically suggested 

as filename. 

After you entered the name and chose a location to export the results to, you click the “Save” button 

to export the results. 

Click Save to export the results. 
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Opening individual results in Microsoft® Excel™ 
You can now open the exported file in Microsoft® Excel™. 

Start Microsoft® Excel™. Click on File and choose the Open option. Next, click on Browse. Choose 

“Text files” as file type. Choose the location where you saved the exported file. Click Open to open the 

file. 

The exported 
individual re-

sults in Mi-
crosoft® Ex-

cel™ 

 

In each row, you see the answers per keypad. The first row shows the question number. Keypad 1 

has voted 5, keypad 2 has voted 6, etc. 

For questions that can be voted for more than once, the first row shows Question 8-1 for question 

8, first time voting, Question 8-2 for question 8, second time voting, etc. 

If you indicated this, you will see a score in the last column. This column keeps track of how many 

points each keypad got. 

Closing the network 
You can close the network at the end of a session. This requires no special operations. You can close 

IVS-Professional by choosing Exit from the File menu or click the small cross at the right upper corner 

in the window. You unplug the Base Station and put the keypads back in the charging cases. Make 

sure that the charging cases are connected to the mains, so that the keypads are reset as soon as 

they are put back. 

However, if you are going to use the system for another session, you can leave the network intact. 

You only have to close this script and open the next one. Now you can continue voting immediately. 



160 

Close IVS-Professional by choosing Exit from the File menu. 
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Using a script again 

After you made a script and used it for a voting session, you can use the same script again. This 

allows you to use the same presentation for another audience. 

You can use the same script, start the same presentation, but create a new session to save the 

results. By doing so the results of both sessions are saved separately, so that you can also print or 

export them separately. 

It is also possible to compare the results of a question from the first session, with the results of the 

second session. You could, for example, use the same script for a morning and an afternoon session. 

During the afternoon session, you can compare the results with those of the morning session. 

Opening a script 
After starting IVS-Professional the start-up dialog is shown. In this dialog you select whether you 

want to open a recent script or create a new one. 

If you have already created a script with Professional, a list of the ten most recently used scripts is 

displayed in the start-up dialog. 

Start IVS-Professional again. 

Start-up dia-
log box with 
the last used 

scripts 

 

Select the script you want to open and click on OK. 
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When the script that you want to use, is not in the list, you can click More scripts…. The standard 

dialog box for opening files appears, in which you can select a script to open. 

Select the script that is displayed in the list and click on OK to open it. 

The script is 
opened again 

and the first 
slide is dis-

played 

 

Initializing the Base Station 
When the Base Station is still connected to the computer and to the mains, it will be initialized 

automatically when you start IVS-Professional. In the status bar you will see “Stand-by”, indicating 

that the Base Station is ready for use. 

You can check the network by choosing the option Test network from the Communication menu. 

When all keypads respond to the network test you can close the test by clicking Stop in the Test 
network dialog box. The network is now ready for voting. 

When the Base Station is no longer connected to the mains, you have to reconnect it and initialize 

the Base Station again. Choose the option Initialize cluster from the Communication menu to 

initialize your Base Station again. 

If this is not the case, connect the Base Station to the mains. Choose Init ialize cluster from the Com-
munication menu. 

The dialog box for setting up the communication appears, in which you can initialize the Base Sta-

tion. 



163 

Dialog box 
for initializing 
the Base Sta-

tion 

 

Click the Initialize button to initialize the Base Station. After initializing the Base Station correctly, 

the green LED in the dialog box is turned on. Click on Finish to finish initializing the Base Station. 

Click Initialize to initialize the Base Station. Click Finish to finish the initialization of the Base Station. 

For more information about initializing the Base Station, see “Communication with the Base Station“ 

on page 134. 

Initializing keypads 
If you did not put the keypads back in the charging cases, you can use the keypads immediately 

again for a second session. If you did put them back in the charging cases, you have to initialize the 

keypads again. 

To initialize the keypads, you choose the option Initialize all keypads from the Communication 
menu. For more information, see “Initializing keypads“ on page 139. 

Starting the presentation 
After you checked the Base Station and the keypads you can start a presentation again. Choose the 

option Start presentation from the Voting menu. You are asked again if you want to start a new 

session. Respond with Yes to this question and enter a description for the second session. The script 

is now ready and you can vote with it again. 

For more information, see “Voting“ on page 146. 

Using a session again 
If you use a script again for another audience, you start a new session. 
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If your voting session consists of a morning session and an afternoon session, it is possible that you 

have to close the computer during the break. A part of the questions is answered during the morning 

session. To keep the results from the morning session and the afternoon session together, you have 

to put the morning session results back into the script to be able to add the results of the afternoon 

session. 

To add results to an existing session, this session must first be imported. You do this by choosing the 

Import option from the File menu. A dialog box appears in which you select the session you want 

to import. 

Choose the Import option from the File menu. 

Dialog box 
for importing 

sessions 

 

Select the session that you want to continue and click on OK to import the session. The results that 

were already saved in this session will be displayed in the result diagrams. You can press  multiple 

times to go to the slide where you left off. If you happen to know the slide number where you left 

off, you can also press  +  +  and enter the slide number of the slide where you left off. 

Finally, you start the presentation by choosing the Start presentation option from the Voting menu, 

of by pressing . 

For the remainder of this manual we will not make use of a previously voted session. Therefore, click on 

Cancel to close this dialog without importing a session. 
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Modifying an existing script 

If you use the same presentation for different audiences on a regular basis, you can use the same 

script. Every now and then you might want to change a question, add a question or remove one. 

By using an existing script, you can easily make a new script by changing existing questions or adding 

new slides with additional questions. 

The slide sorter helps you to copy or move slides very easily. When you move a slide, you can, for 

example, pose a question at an earlier point than in the original script. 

Inserting a new slide 
When you use the script, as it is made so far, for a presentation, you immediately start with the first 

question. You can consider starting with a welcome slide. You could, for example, display this slide 

when the audience enters the room. 

To create a welcome slide at the beginning of the script, you have to make a new slide before the 

current first slide. Go the current first slide and add a new slide by choosing the option New slide 

from the Insert menu. Alternatively, you can press  +  +  on the keyboard.  

You could also insert a slide by clicking on the Insert slide button ( ) in the lower taskbar. How-

ever, this inserts an empty new slide after the current slide without any questions. 

Choose the option New slide from the Insert menu. 

The dialog box for inserting new slides appears. 

The dialog 
box for in-

serting new 
slides 
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Slides 

At Number of new slides you select how many slides you want to insert. This offers the possibility 

to insert a number of new slides at once. 

Insert 

Here you select whether you want the new slides to be inserted before or after the current slide. 

Before current slide All new slides are inserted before the current slide. This option allows you 

to insert slides before the first slide. 

After current slide All new slides are inserted after the current slide. This option allows you to 

insert slides behind the last slide. 

Options 

When inserting new slides, you can insert standard empty slides. However, it is also possible to insert 

slides with a question, answers and a result diagram or copy an existing slide. 

Insert empty slides This option inserts standard empty slides. 

On each slide, insert default question with 2 answers All new slides that you insert contain 

a question, a number of answers and a result diagram. You select how many answers you want to 

insert with each question. The maximum number of answers is 20. After inserting the slides you have 

to enter the question texts and answer texts. 

Duplicate all objects on slide 1 This option allows you to duplicate an existing slide a number 

of times. All objects of the selected slide are automatically duplicated on each new slide. 

Enter 1 for the Number of slides, select the option Before current slide and the option Insert empty slides. 
Click on OK to insert the new slide. 
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A new, empty 
slide inserted 

before the 
first slide 

 

Adding a text 
The welcome text for this slide can be inserted as normal text. Choose the option Text from the 

Insert menu or press the  on the keyboard. 

The dialog box for entering text appears. Enter your welcome text and change the font when desired. 

Click on OK to insert the text. 

Press  to insert a text. Enter the text “Welcome to the IVS®” in the dialog box. Choose Arial Black as 

font with size 48. Center the text. Put the ®-sign in superscript. Click on OK to insert the text. 
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The welcome 
text is in-

serted at the 
position that 

is indicated in 
the template 

 

The text appears at the position that is indicated in the template. Because the text box is too small, 

the text is displayed outside the text box. 

Make the top of the text box slightly larger so that the entire text fits into the text box. Move the text 

box to the center of the slide. Because the automatic object alignment is still enabled, the center of the 

text box will automatically align with the center of the slide. 

The welcome 
text in the 

middle of the 
slide 
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Using another background 
A background slide is automatically displayed on each slide. You can put a logo on the background 

slide that will be repeated on each slide. 

You can consider not showing a logo on the title slide. In this case, you can disable the background 

slide of the title slide. 

Go to the properties of the slide to disable the background slide. In the Properties of slide dialog, 

you uncheck the option Use background slide. 

Click on the slide with the right mouse button and choose the option Properties. Uncheck the option 

Use background slide in the Properties of slide dialog box. Click on OK to apply the changes. 

This title slide 
no longer 

shows a back-
ground slide 

 

Inserting an image 
You can also insert an image to the title slide, for example an image that is related to the subject. 

To insert an image, choose the option Image from the Insert menu. In the standard dialog for open-

ing files, you select an image that you want to insert. 

Choose the option Image from the Insert menu. Select the image you want to insert and click on Open 

to insert the image. 

In the example below an image in PNG-format was used. This format supports the use of a transpar-

ent background. 
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The inserted 
image is 

placed over 
the welcome 

text 

 

Changing the order of objects 
Objects added to a slide are always inserted on top of the slide. This means that they are placed on 

top of other objects. The image you just added is therefore placed on top of the existing text. 

The order of the objects can be changed. You could move the image that was placed on top of the 

text and send it further to the back, so that the image is displayed behind the text. 

Select the object you want to send to the back and choose the option Order from the Edit menu and 

then the option Send further. Alternatively, you can click on the object with the right mouse button 

and select the option Order and then Send further or press  +  on the keyboard. The selected 

object will be placed one step further to the back. 

Select the image and press  + . The image is now behind the text. 
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The image is 
placed one 

step further 
to the back 

 

You can bring objects closer to the front in the same way. Choose the option Order from the Edit 

menu and then the option Bring closer. The option Bring to front moves an object immediately to 

the top of the slide. The option Send to back moves an object immediately to the back of the slide. 

Simulating a shadow effect 
Although the text is now on top of the image, part of the text is not quite readable. This is caused 

by the fact that the black text disappears against the dark background. You can prevent this by 

making the text lighter, but then the text might disappear against the mainly light background. 

You can solve the problem of the disappearing text by placing a shadow behind the text. Using a 

lighter shadow behind the text prevents it from disappearing against the dark background. 

IVS-Professional does not natively support the possibility to put a shadow behind texts. You can 

however simulate this shadow effect, by using two texts. You place a second, white text behind the 

dark text. By moving this text slightly compared to the text on top of it, you create the effect of a 

shadow behind the text. 

Duplicating objects 
To make sure that the texts are exactly the same, you’d better duplicate the text. By duplicating an 

object, you make an exact copy of it. This copy is immediately inserted in the same slide as the 

original. The same effect can be achieved by first copying the object by choosing the option Copy 

from the Edit menu, and then pasting the object by choosing the option Paste from the Edit menu. 
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Duplicating an object offers an extra option that normal copying and pasting does not. The duplicate 

can be inserted at a certain offset compared to the original. The offset can be set up using the pref-

erences. For more information see “Preferences“ on page 231. 

Go to the preferences by choosing the Preferences option from the File menu. On the Edit tab, set both 

the horizontal and vertical placement to 2 pixels. 

Select the object you want to duplicate and choose the option Duplicate from the Edit menu. Alter-

natively, you can press the  +  +  keys on the keyboard. A copy of the selected object is 

inserted. 

Select the text and choose the option Duplicate from the Edit menu. 

The text has 
been dupli-

cated and the 
duplicate has 
been moved 
slightly com-
pared to the 

original 

 

The selected text object was duplicated and the duplicate was moved slightly compared to the orig-

inal, like indicated in the preferences. For achieving the shadow effect, the text color of the second 

text has to be changed. 

Double-click on the text object on top. Set the text color to white. 
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The text color 
of the text 

object on top 
has been 
changed 

 

Because the white text is still on top of the black text, the effect of the shadow is just the other way 

around as the desired effect. We wanted to have a dark text with a lighter shadow. The white text 

has to be moved to the back so that it appears behind the black text. This can be done by changing 

the order of the objects, moving the white text one step to the back. 

Select the white text on top. Press  +  to move the text one step to the back. 

The white 
text was 

placed behind 
the black text 

 

The effect of the white text as a shadow behind the black text is still not very convincing. The effect 

can be enhanced by moving the white text slightly more compared to the black text. 
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Zooming in on the slide 
The white text has to be selected before it can be moved. But because the textbox is so close to the 

textbox of the black text, selecting it is a precision work. You will have to very precisely click on the 

lower protruding edge of the textbox to select it. 

As an aid in selecting, you can zoom in on the slide. This allows you to very accurately operate in a 

small working area. You can zoom in by adjusting the zoom percentage in the upper toolbar. If you 

have a wheel mouse, you can also zoom in on the slide by pressing the  key and rolling the wheel 

upwards. 

To set the zoom percentage, click on the zoom percentage in the toolbar. A window for zooming in 

and out appears. 

Adjusting the 
zoom per-

centage of 
the slide 

 

You can change the zoom percentage by selecting one of the standard percentages, or by entering 

a percentage yourself. If you select the Fit option, the zoom percentage will adjust automatically so 

that the slide always fits exactly in the available space. 

Click on the zoom percentage in the toolbar. Set the zoom percentage of the slide to 300%. 
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The slide is 
displayed 3 

times as big 
as normal 

 

Use the scroll bars on the right and at the bottom of the slide to adjust the position of the slide on 

the screen, when the wrong part of the slide is displayed. You can also use the wheel of your wheel 

mouse to scroll the slide up or down. Keep the  key depressed while turning the wheel to scroll 

the slide to the left or to the right. 

You display the entire slide by setting the zoom percentage to ‘Automatic’. The zoom percentage is 

then automatically adjusted so that the entire slide is visible. The real zoom percentage is displayed 

in the toolbar. 

You can set the zoom percentage to ‘Fit’ by clicking the Adjust button ( ) in the toolbar. Alterna-

tively, you can select the Fit to window option in the View menu or press  +  on the key-

board. 

Set the zoom percentage to ‘Automatic’ by pressing  +  on the keyboard. 

Selecting underlying objects 
Zooming in on the slide allows you to position objects more accurately and navigate more accurately 

to select closely spaced objects. 

If two objects are on top of each other, it can be difficult to select the lower object if both objects 

are fairly close together, or even impossible if the upper object completely covers the lower object. 

To still be able to select the lower object, you can use the click through objects method. By clicking 

on a selected object while holding down the  key, you can click through the object, so that you 

click on the object below it. This allows you to still select the underlying object, even if it is completely 

covered by the object above. 
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Select the text box with the black text. Hold down the  key and click again on the text box with the 

black text. By holding down the  key you click through the text box with the black text, thereby 

clicking on the underlying text box, so that the text box with the white text is selected. 

The textbox with the white text has to be moved slightly to make the text clearer. Use the arrow 

keys in combination with the  key to move the text box two pixels to the right and one pixel 

down. 

Keep the  key depressed and press the right cursor key twice and the down cursor key once to move 

the textbox two small steps to the right and one small step downwards. 

The white 
text was 

moved 
slightly so 

that it is bet-
ter visible 

 

Saving the script under another name 
To save the adjustments you just made to an existing script, you can save the original script again. 

This results in the original script being lost. To prevent this, you can save the adjusted script under 

another name. 

Choose the option Save as from the File menu to save the script under another name. Enter a new 

name for the script in the standard dialog box for saving files. Click the Save button to save the 

script with another name. 

Choose the option Save as from the File menu. Enter the new name for the script “Continuing with 

IVS-Professional”. Click Save to save the script under the new name. 
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The slide sorter 

The slide sorter shows an overview of all slides in the script. The slides are displayed as miniatures, 

so that a number of slides can be displayed on the screen at the same time. This allows you to find 

a slide very easily. You can also delete, copy or move slides in the slide sorter. 

Starting the slide sorter 
To start the slide sorter, you choose the option Slide sorter from the View menu. The large slide 

disappears and the miniatures are built. Building all miniatures may take several minutes, especially 

when you have a lot of slides in your script or when you use a lot of images. You can cancel building 

the miniatures by pressing the  key. 

Choose the option Slide sorter from the View menu. Wait until all miniatures are built. 

All slides that 
are made so 

far are dis-
played as 

miniatures in 
the slide 

sorter 

 

Copying slides 
In the slide sorter you can select and copy several slides at the same time, after which you can paste 

them to add copies of the originals to your script. 

You have to select slides before you can copy them. You select one single slide by clicking on it with 

the left mouse button. A selected slide is indicated with a blue border. By clicking on another slide 

with the left mouse button, you select that slide. If you want to select more slides at a time, press 

the  key while clicking the second slide. 
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Click on the first slide with the left mouse button. This one has now been selected. Press the  and 

click on the second slide. Both slides are now selected. 

The first two 
slides are se-

lected 

 

To copy the selected slides, you choose the option Copy from the Edit menu. Alternatively, you can 

click on one of the slides with the right mouse button and choose the option Copy or you press 

 +  on the keyboard. 

Press  +  to copy both selected slides. 

Pasting copied slides 
After you copied the selected slides you can paste them somewhere else. The new slides will either 

be pasted after the selected slide or, when more slides are selected, after the last selected slide. 

You first have to determine the position where you want to past the new slides by selecting the slide 

before that position. For example, if you want to paste the slides after the last slide, then you have 

to select the last slide. 

Click the last slide with the left mouse button to select it. 

To past copied slides, you choose the option Paste from the Edit menu. Alternatively, you can click 

the selected slide with the right mouse button and choose the option Paste or press  +  on 

the keyboard. 

Press  +  to paste the copied slides after the last slide. 
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Both copied 
slides are 

pasted after 
the last slide 

 

Moving slides 
You can easily move slides in the slide sorter. First select the slide you want to move. Next, drag the 

slide to its new position. During dragging, the new position of the slide is indicated with a red border. 

When you release the left mouse button, the slide is moved. If you move the slide further down the 

script, it will be placed after the selected slide. If you move the slide further up the script, it will be 

placed before the selected slide. 

You can move multiple slides at once, by selecting more than one slide. However, the selected slides 

must form a continuous block. You can, for example, select and move slide 2, 3, 4 and 5. 

Select the first slide. Keep the left mouse button pressed and drag the slide to the last slide. The last slide 

is indicated with a red border. 
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The first slide 
is selected 

and is 
dragged to 

the last slide 

 

Release the left mouse button. The selected slide is now moved to behind the last slide. 

The first slide 
has been 

moved, be-
hind the last 

slide 

 

Deleting one or more slides 
Deleting slides is also very easy in the slide sorter. Select the slide that you want to delete and choose 

the option Delete from the Edit menu. Alternatively, you can click the slide with the right mouse 

button and choose the option Delete or press the  key on the keyboard. 
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When a slide is empty, it will be deleted immediately. If there are any objects on the slide, you will 

be warned first. Click Yes to actually delete the selected slide. 

You can delete multiple slides at once by selecting more slides. 

Select the third but last slide and press  to delete this slide. Click Yes to actually delete the slide. 

Back to the normal slides 
There are two ways to return from the slide sorter to the normal slides. Choose the option Normal 

from the View menu to return to the normal slides. The slide that was selected in the slide sorter 

will now be displayed. 

You can also return to the normal slides by double-clicking one of the miniature slides in the slide 

sorter. You will now return to the normal slides and the slide you double-clicked will be displayed. 

Double-click the second to last slide to return to the regular slides and to display the second to last slide. 

Double-click-
ing the sec-
ond to last 
slide closes 

the slide 
sorter and 

displays the 
second to last 

slide 

 

Deleting slides 
You can delete slides not only in the slide sorter, but also in the normal edit screen. However, here 

you can only delete one slide at a time. To delete a slide in the edit screen, you go to the slide that 

you want to delete and you choose the option Delete slide from the Edit menu. Alternatively, you 

can press the  +  keys on the keyboard or click the Delete slide ( ) button in the lower task 

bar. 
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When a slide is empty, it will be deleted immediately. If there are any objects on the slide, you will 

be warned first. Click Yes to actually delete the selected slide. 

Press  +  to delete slide 10. Click Yes to actually delete the slide. 

Moving slides in the edit screen 
Moving slides is also possible in the edit screen. It is not as easy though as in the slide sorter, because 

there is no overview of all slides and you cannot drag a slide. 

To move a slide in the edit screen, you choose the option Move slide from the Edit menu. The dialog 

box for moving slides appears. 

Choose the option Move slide from the Edit menu. 

The dialog 
box for mov-

ing slides 

 

In this dialog box, you indicate which slides you want to move and where you want to move them 

to. 

Move from slide Here you enter the number of the first slide you want to move. 

Number of slides Here you enter the number of slides you want to move. 

Move to slide Here you enter the number of the slide where you want the slides to be moved to. 

To move the last slide to the first one, you enter slide 10 for Move from slide, 1 for Number of slides and 

1 for Move to slide. Click on OK to move slide 10 to slide 1. 
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Voting automatically with a 

timebar 

Usually a script is controlled manually. You control when you want the show the next slide. You also 

control when the voting is opened and when the voting is closed. 

You can also automate your entire script by using a timebar. By adding a timebar on each slide, you 

can have the voting opened after a few seconds. A few seconds later, you can have the voting closed. 

And a few seconds after that, you can go to the next slide. The timebar on the next slide will repeat 

this cycle, until the entire script is finished. 

Depending on the settings, a timebar begins automatically when the slide is shown. On three differ-

ent moments it can perform three different actions: open the voting, close the voting and go to the 

next slide. When, during the session, the timebar turns out to take too long, each of the actions can 

also be performed manually. When the timebar turns out to be too fast, it can be paused at any 

moment. 

Go to another slide 
By using the  and  keys, you can go to the previous and next slide respectively. It is also possible 

to go to a certain slide at once. To do this, choose the option Go to slide from the View menu. 

Alternatively, you can press  +  +  or  on your keyboard. The Go to slide dialog box 

appears. 

Press  to go to another slide. 

The dialog 
box to go to 

another slide 

 

In this dialog box, you enter the slide number of the slide you want to go to. Next, click on OK to go 

to that slide. 

Instead of immediately going to a certain slide, you can also move relative to the current slide. To 

move forward, you first enter a +, followed by the number of slides you want to move forward. To 

move backward, you first enter a –, followed by the number of slides you want to move backward. 
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Enter -3 and click on OK to go three slides backward. This takes you from slide 10 to slide 7. 

Inserting a timebar 
To insert a timebar in a slide, choose the option Timebar from the Insert menu. Alternatively, you 

can press the Timebar ( ) button in the toolbar or press  on your keyboard. 

Insert a timebar by choosing the option Timebar from the Insert menu. 

A timebar has 
been inserted 
into this slide, 
to control the 

voting time 

 

Setting up the timebar 
The default setting for a timebar is that it starts to run when the voting is opened and closes the 

voting after ten seconds. This default setting can be changed in the template. Of course it is also 

possible to set up each timebar individually. For some questions the audience simply needs more 

time than for others. 

To set up the timebar, you go to the properties of the timebar. 

Click on the timebar with the right mouse button. Next, choose the option Properties. 

The Properties of timebar dialog box appears. 
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Dialog box 
with the 

properties of 
the timebar 

 

Type 

The timebar can be displayed in seven different ways: 

Bar running down horizontally The timebar will be displayed as a bar, running down from the 

right to the left.  

Bar running down vertically The timebar will be displayed as a bar, running down from the top 

to the bottom. 

Circle The timebar will be displayed as a circle, running down counter clockwise. 

Time as text The timebar will be displayed as numbers, counting down. If the total time is less 

than 60 seconds, only the seconds will be displayed. If the time is more than 60 seconds, the time 

will be displayed in minutes and seconds. 

Bar running down horizontally with time as text The timebar will be displayed as a bar, 

running down from the right to the left, with the time in numbers in the center. 

Bar running down vertically with time as text  The timebar will be displayed as a bar, run-

ning down from the top to the bottom, with the time in numbers in the center. 

Circle with time as text  The timebar will be displayed as a circle, running down counter clock-

wise, with the time in numbers in the center. 

The choice for a different type of timebar does not mean that the shape of the timebar automatically 

changes too. If you inserted a standard vertical timebar, it will be displayed as a vertical bar. If you 
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change the type in a horizontal timebar, the bar will still be displayed vertically. However, the bar 

will count down from right to left. 

Transparent With this option you will make the timebar transparent. The timebar will first be 

displayed as a bar or circle. When the timebar is running, the original background of the slide will 

appear. 

Frame With this option a black frame will be displayed around the timebar. This option does not 

work for a timebar of the text type. 

Counting up Checking this option will cause the timebar to count up instead of counting down. 

This means that the timebar will start empty and fill up along the way. 

Timers 

The timebar consists of three different timers, that run automatically after each other. You can turn 

each of these timers on or off. The time, timebar color and background color can be set for each 

timer individually. 

Open voting after This timer starts as soon as the slide is shown. When the timer ends, the voting 

is opened. 

Close voting after This timers starts when the voting is opened. When the timer ends, the voting 

is closed. 

Next slide after This timer starts when the voting is closed. When the timer ends, the next slide 

is shown. 

Start timebar manually If this option is checked, the timebar will start in a suspended state. You 

can resume the timebar manually by pressing . 

Sounds 

When the timebar is running, you can have it play several sounds. The timebar supports every file 

format also supported by Windows. An audio clip will always be played completely, unless some 

other audio clip needs to be played. In that case, any still playing audio clip is cut off. 

Start timebar With this option you can play a sound when the first timer starts to run. 

Stop timebar With this option you can play a sound when the last timer ends. 

Every second With this option you can play a sound every second. If the audio clip itself is longer 

than one second, it will be restarted every second. 

Stop sound when timebar stops With this option you can indicate that any playing sound has 

to be stopped once the timebar stops. If you are playing a sound clip that lasts 15 seconds, but the 

timebar closes the voting after 10 seconds, the sound clip would continue to play for another 5 

seconds. By enabling this option, the sound clip will also be stopped after 10 seconds. 
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Choose a bar running down vertically as timebar type, not transparent and with frame. Select all three 

timers. Open the voting after 5 seconds, close the voting after 10 seconds and go to the next slide in 10 

seconds. 

Copying objects 
To make the entire script run automatically, you will have to place a timebar on each slide. To make 

all timebars exactly the same, you first set up the timebar in the template. Next, you add a timebar 

to each slide. 

If you do not want all the timebars to be the same, you will have to edit them manually. But even 

then, you can make two exactly the same timebars, by copying one timebar and then pasting it on 

the next slide. 

To copy an object, you first select it and then choose the option Copy from the Edit menu. You can 

also press the Copy button ( ) in the toolbar or press  +  on the keyboard. 

Select the timebar and press  +  to copy the timebar. 

To insert the copied object into another slide, go to the slide where you want to insert it and choose 

the option Paste from the Edit menu. Alternatively, you can use the Paste button ( ) in the toolbar 

or press  +  on the keyboard. 

Go to the next slide. Press  +  to insert the copied timebar. 

The copied 
timebar has 
been pasted 
on the next 

slide 
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Starting the timebar 
The first timebar is started when the slide is shown. This only works in the presentation screen. The 

other two timers work in both the presentation and editing screen. You can go to the presentation 

screen by pressing . 

Press  to go to the presentation screen. 

Because you go to the presentation screen without having started a session, that session will be 

started automatically. Starting a session is important if you want to store the voting results. See also 

“Starting a session“ on page 146. 

Enter the description “Testing timebar” and click OK to start the session. 

The presentation screen is now being displayed. The first timer of the timebar is started, which causes 

the timebar to start running down. 

The timebar is 
running in the 

presentation 
screen 

 

Controlling the timebar manually 
When the presentation is started, the first timer automatically starts to run. When this one finishes, 

the second timer starts. And when this one finishes, the third timer starts. You can also start the next 

timer manually, by performing the appropriate action. 

Starting the next timer 

As soon as the first timer has finished, the voting is opened. However, if you open the voting while 

the first timer is still running, the second timer will immediately be started. In the same, way the 

third timer will immediately be started when the voting is closed while the second timer is still run-

ning. 
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Pausing the timer 

When the timebar is running, and you discover that the time you set for the timebar is too short, you 

can pause the timebar. To pause the timebar press . Press  again to let the timebar continue 

running. 

Stopping the timebar 

If you want to stop the timebar completely, you press  while the timebar is this running. All timers 

will be stopped. A timer will only be restarted when the appropriate action when performed. For 

example, if the voting is opened, and you stop the then running timer, by pressing , the timebar 

will be stopped completely. When you manually close the voting, the third timebar will start running 

again. You can stop this one, by pressing  again. 

Wait until the three timers have run down. Next, press  to return to the edit screen. 
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Working with multimedia 

By using the multimedia object it is possible to add audio and/or video clips to your presentation. On 

each slide, you can place one or more multimedia objects, with which you can play an audio or video 

clip. 

The multimedia object can be linked to the voting, so that the audio or video clip starts playing as 

soon as the voting is opened and the voting is closed as soon as the audio or video clip has ended. 

By linking the multimedia object to the voting, you can have it read out the question, by playing an 

audio clip. Or you can ask a question based on a video clip you show. 

Inserting a multimedia object 
To insert a multimedia object, you choose the option Multimedia from the Insert menu. Alterna-

tively, you can press the Multimedia button ( ) in the toolbar or press  on the keyboard. 

The standard dialog box for opening files will be displayed. Here you can select the audio or video 

clip you want to play. IVS-Professional supports all file types which can be played by the Windows 

Media Player.  

Add a new slide at the end of your script. Choose the option Multimedia in the Insert menu to insert 

a multimedia object. Select a file and click Open to open the file. 

After having selected a file, the multimedia object is inserted. If you selected a sound clip, this will 

be displayed as a speaker icon. If you selected a video clip, then this will be displayed as an image 

of the first frame from the video clip. 
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A video clip 
has been in-

serted as a 
multimedia 

object 

 

Starting the multimedia object 
A newly added multimedia object is set to start manually by default. You determine when the audio 

or video clip is being played. To start the multimedia object, press . By pressing  again while 

the multimedia object is still playing, it can be stopped again. 

If you press  +  while the multimedia object is playing, the audio or video clip is paused. To 

resume the clip you press  +  again. 

While the multimedia object is playing, the voting can be opened and one can vote normally. 

If you place multiple multimedia objects on one slide, and you leave them all set to start manually, 

they will all start playing simultaneously at the moment you press . Although it is possible to play 

multiple video clips simultaneously, it is not recommended. The performance of your computer de-

crease greatly when it has to decode multiple video streams simultaneously, which can result in the 

video clips stalling or IVS-Professional becoming unresponsive until all video clips have ended. 

A video clip can only be played at one monitor at a time. If you show the presentation screen on a 

different monitor than the edit screen, the video clip will only be played in the presentation screen. 

Starting automatically when voting 
The multimedia object can also be started automatically as soon as the slide is displayed or when 

the voting is opened or closed. And, when the multimedia object has finished playing, it can auto-

matically show the next slide, open or close the voting. 

To set up the multimedia object, you go to the properties of the multimedia object. 
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Go to the properties of the multimedia object by clicking on it with the right mouse button and choose 

the option Properties. 

Dialog box 
with the 

properties of 
the multime-

dia object 

 

Start multimedia 

The multimedia object can be started in five different ways. 

Manually The multimedia object has to be started manually by pressing . 

When slide is shown The multimedia object is started as soon as the slide with the multimedia 

object on it, is shown. This will only function in the presentation screen. 

When voting is opened The multimedia object is started when the voting is opened. 

When voting is closed The multimedia object is started when the voting is closed. 

When the previous multimedia object end The multimedia object is started as soon as the 

previous multimedia object has ended. 

When multimedia stops 

When the multimedia object has finished playing, it can perform four different actions. 

Do nothing When the multimedia object ends, no action will be taken.  

Go to the next slide When the multimedia object ends, the next slide will be shown. 

Open the voting When the multimedia object ends, the voting will be opened. 

Close the voting When the multimedia object ends, the voting will be closed. 
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Window 

After inserting a video clip, its window can be displayed in several ways. 

Display the first frame from the video The window shows an image of the first frame from 

the video clip. 

Transparent The window is displayed transparently. 

Use this background color The window is displayed in the selected background color. 

Select the option When voting is opened from the Start multimedia options and Close voting from the 

When multimedia stops options. Click on OK to set up the multimedia object. 
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Advanced text objects 

IVS-Professional allows you to link an action to a text object. This action is executed when you click 

on the object in the presentation screen. 

It is also possible to hide the text object in the presentation screen, or to only display it when the 

voting network has a certain status. For example, you can display a text for as long as the voting is 

opened. When you close the voting, this text will disappear again. 

Displaying a text for a certain status 
When you want to display a text when, for example, the voting is opened, you first have to insert a 

text object. You then go to the properties of this text object and select the Advanced tab. 

Go to the properties of a text object by right-clicking on it and choosing the Properties option. Then, 

select the Advanced tab. 

Dialog box 
with the 

properties of 
the text ob-

ject 
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Display 

With these options you determine whether this text object isn’t displayed at all in the presentation 

screen, or is only displayed when the network has a certain status. If you check the option Do not 
display in the presentation screen, then the text object is only displayed in the edit screen. If 

you check the option Only display when network status is:, then the text object is only dis-

played when the network has a certain status. You can choose from the following statuses: 

Offline The text is displayed when the Base Station is no longer active. 

Stand-by The text is displayed when the Base Station is active but no performing any actions. 

Test network The text is displayed when the keypads are being tested. 

Opening The text is displayed when the voting is being opened. 

Opened The text is displayed when the voting is open. 

Closing The text is displayed when the voting is being closed. 

Initializing The text is displayed when the keypads are being initialized. 

Resetting The text is displayed when the keypads are being reset. 

Detecting The text is displayed when the Base Station is being detected. 

Internet 

When you use IVS-Online, you can also display this text on the slide in IVS-Online, provided that the 

slide contains a question. You can display the text as a title or as a subtitle. You can only display one 

title and one subtitle per online slide. The title and subtitle are displayed directly above the question 

text. 

Performing an action when clicked 
You can link a certain action to a text object that is executed when you click on the object. This 

action is only executed when clicking on the object in the presentation screen. If a text object has an 

action linked to it, you will see the mouse cursor change into a hand when you move the mouse over 

the object. 

You can set up an action in the properties of the text object. You can choose from the following 

actions: 

Don’t do anything No action is performed when clicking on the object 

Go to the first slide Clicking on the object will take you to the first slide. 

Go to the previous slide Clicking on the object will take you to the previous slide. 

Go to the next slide Clicking on the object will take you to the next slide. 

Go to the last slide Clicking on the object will take you to the last slide. 

Go to slide Clicking on the object will take you to a certain slide. From the list below Slide you can 

choose a slide to go to. 

Open the voting Clicking on the object will open the voting. 

Close the voting Clicking on the object will close the voting. 
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Go to PowerPoint Clicking on the object will switch to PowerPoint. This requires that PowerPoint 

has already been started and there is an active slide show in PowerPoint. 

Go to the next slide in PowerPoint Clicking on the object will switch to PowerPoint and take 

you to the next slide in PowerPoint. This requires that PowerPoint has already been started and there 

is an active slide show in PowerPoint. 

Go to Risk Analysis Clicking on the object will switch to IVS-Risk Analysis. This requires that IVS-

Risk Analysis has already been started. 

Go to Excel Clicking on the object will switch to Excel. This requires that Excel has already been 

started. 

After performing the action, go to the next slide By checking this option, you will immedi-

ately go to the next slide in IVS after performing the action. 

Switching from PowerPoint to IVS 
PowerPoint also supports linking actions to objects. This allows you to switch back from PowerPoint 

to IVS. 

To link an action to an object in PowerPoint, you first have to select the object. Then you select the 

Insert tab and click on the Action button in the Links group. 

Dialog box 
with the ac-

tion settings 
of an object 

 

Select the option Run program and then click on the Browse button. Use the dialog box to find 

IVSProfessional.exe. Finally, click on OK to set up the action. 

PowerPoint 2010, 2013, 2016 and 2019 

When you start a slide show and click on the object, you will get a security notice the first time you 

do this. 
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PowerPoint 
issues a secu-

rity notice 

 

Click on Enable to allow external applications to be started by an action. 

To prevent this notice from appearing each time you start a slideshow, you have to save your Pow-

erPoint presentation in a trusted location. You can add trusted locations to PowerPoint by clicking 

on the Options button in the File menu. Select Trust Center in the left-hand pane and then click on 

the Trust Center Settings button. Select Trusted Locations in the left-hand pane and add a new 

location by clicking the Add new location button. Select a folder to set this as a trusted location. 

Then save your presentation in this folder. 
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Automatically displaying text 

with fields 

Afield looks like a standard text object. In a standard text object, however, you have to enter the 

text that is displayed. In a field object you do not enter text. The field will show its own text, de-

pending on the type of field that you insert. 

There are eight different field types. 

Score offers numerous possibilities to play quizzes. You can show the scores of each individual 

participant but also of groups. You can also show a top-3, top-5 or top-10 of the participants that 

scored best. 

Results displays the results of specific answers, just like the result diagram. By using this field you 

can display the results as text-only instead of in a diagram. 

Participants this field shows the names of participants. Names are either displayed immediately, 

or only after a participant has voted, or even when a participant has given a certain answer. 

Cumulatives offers numerous possibilities for calculating totals, averages and other statistical 

data for a group of questions. 

Network status displays several values of the voting network, such as the number of initialized 

keypads, or the total number of received votes. 

Slide numbering displays the current slide number or the total number of slides. 

Date & Time displays the current date and/or time. 

Text displays the literal text as defined in an XML file. 

A field can be inserted on the standard slide as well as on the background slide. To distinguish the 

field from a standard text object, the field has a red boundary instead of a white boundary. 

A field itself is not interactive. This means that a field behaves like a non-interactive result diagram. 

When opening a vote the field is cleared and when voting is closed the results are displayed. If you 

want to show the results in a field interactively you have to add an interactive result diagram on the 

slide. This result diagram does not necessarily have to be placed on the slide, it can also be placed 

just off the slide. 

The only exceptions are a field of the Network status type or of the Participant type. These types of 

fields are automatically updated as soon as votes are being received. 

This chapter shows a number of examples of how to use fields. A simple script is used with a number 

of questions and fields. No attention is paid to the lay-out of the script. And unlike the other chapters 
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in this manual, this chapter does not mention the specific steps to create the script. The attention is 

focused on the settings of the fields. 

Every question in this script is set to identified voting and to using the voting time. A participant list 

with 200 participants is used. These participants are divided in four groups with the names ‘RED’, 

‘GREEN’, ‘BLUE’ and ‘YELLOW’. In each group there are 50 participants, that are named ‘Participant 

1’ to ‘Participant 50’. 

A text file as a basis 
To demonstrate the usage of fields, a script is made in this chapter, that can be used to play a quiz. 

The quiz contains seven questions with four answers each. Each question has one correct answer 

and three wrong answers, with the exception of the first question, that has two correct answers. 

To be able to quickly and simply enter the quiz questions into IVS-Professional, the questions and 

the accompanying answers are first entered into a text file. This text file will then be imported into 

IVS-Professional, so that is can serve as a basis for the script that’s going to be made. The main 

advantage is that you don’t have to retype the question and answer texts, or have to copy and paste 

them. And you can also indicate the correct answer in this text file. 

The text file that is going to be imported into IVS-Professional only contains the question and answer 

texts. It is not possible to format the text in any way. This is done later by using the template. It is 

also not possible to put any object other than a question, answers or a normal text into the text file 

To allow IVS-Professional to recognize the text file, it has to start with two fixed lines. These are 

followed by an empty line, after which the text of the first question follows. On every line directly 

following the question text are the texts of the accompanying answers. After the last answer follows 

an empty line, after which the text of the next question may start. 
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Example of a 
text file with 

questions and 
answers 

 

The first line of the text file contains the text ‘IVS-Professional Text Script’. This is the literal text, 

without any extra spaces before, between or after the text. The second line contains the version 

number of this file, which is currently always 4.5. Here, too, there may be no extra space before or 

after the text. 

When you import this text file into IVS-Professional, one slide will be created for each question. When 

necessary, you can have extra empty slides created by adding extra empty lines between an answer 

text and the following question text. 

A question text may be preceded by an asterisk (*) to indicate that this is a reference question, or by 

a number sign (#) to indicate that this is a rating question. A combination is also possible, by putting 

both signs in front of the question text. 

An answer text may be preceded by an asterisk (*) to indicate that this is the correct answer. 

Except question and answer texts, you can also enter normal texts in the text file, by preceding them 

with an ampersand (&). 

A text file can be imported by choosing the Open option from the File menu. The standard dialog 

box for opening files appears. Select the text file that you want to import and click on the Open 

button. 

Inserting a field 
To insert a field you choose the option Field from the Insert menu. Alternatively, you can click the 

Field ( ) button in the toolbar or press  on the keyboard. 
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Before a field is inserted, the Properties of field dialog box appears in which you have to indicate 

what type of field you want to insert. 

Dialog box 
with the 

properties of 
the field 

 

Under Field type in this dialog box you select the type of field that you want to insert. Under Field 
options you can set the properties for this field, depending on the type of field you choose. 

Displaying the date and time 
The field type Date & Time allows you to display the current date and/or time. Under Field options 

you can set how you want to display the date and how you want to display the time. You can choose 

from seventeen predefined date/time settings, but you can also set up your own settings. 
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The field op-
tions for the 

field type 
Date & Time  

 

In the Date/Time notation text box you can fill in your own notation for showing the date and/or the 

time. You can also choose one of the predefined options from the list below. If you choose one of 

the options from this list, the notation is automatically inserted in the Date/Time notation text box. 

You can use several combinations of characters for the notation. For example, ‘dd’ stands for the 

day of the month, ‘MM’ for the month as a number with a leading zero, and ‘yyyy’ stands for the 

current year as a four-digit number. The following combinations can be used: 

c Displays the date using the format given by the Short Date Format in Country/Regio of 

Windows, followed by the time set in hours, minutes and seconds. 

d Displays the day as a number without a leading zero (1-31). 

dd Displays the day as a number with a leading zero (01-31). 

ddd Displays the day as an abbreviation (Sun-Sat). 

dddd Displays the day as a full name (Sunday-Saturday). 

ddddd Displays the date using the format given by the Short Date Format as set by Coun-
try/Region. 

dddddd Displays the date using the format given by the Long Date Format as set by Country/Re-
gion. 

m Displays the month as a number without a leading zero (1-12). If the ‘m’ specifier im-

mediately follows an ‘h’ or ‘hh’ specifier, the minute rather than the month is displayed. 
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mm Displays the month as a number with a leading zero (01-12). If the ‘mm’ specifier im-

mediately follows an ‘h’ or ‘hh’ specifier, the minute rather than the month is displayed. 

mmm Displays the month as an abbreviation (Jan-Dec). 

mmmm Displays the month as a full name (January-December). 

yy Displays the year as a two-digit number (00-99). 

yyyy Displays the year as a four-digit number (0000-9999). 

h Displays the hour without a leading zero (0-23). 

hh Displays the hour with a leading zero (00-23). 

n Displays the minute without a leading zero (0-59). 

nn Displays the minute with a leading zero (00-59). 

s Displays the second without a leading zero (0-59). 

ss Displays the second with a leading zero (00-59). 

z Displays the millisecond without a leading zero (0-999). 

zzz Displays the millisecond with a leading zero (000-999). 

t Displays the time in hours and minutes. 

tt Displays the time in hours, minutes and seconds. 

am/pm Uses the 12-hour clock for the preceding ‘h’ or ‘hh’ specifier, and displays ‘am’ for any 

hour before noon, and ‘pm’ for any hour after noon. The ‘am/pm’ specifier can use 

lower, upper, or mixed case, and the result is displayed accordingly. 

a/p Uses the 12-hour clock for the preceding ‘h’ or ‘hh’ specifier, and displays ‘a’ for any 

hour before noon, and ‘p’ for any hour after noon. The ‘a/p’ specifier can use lower, 

upper, or mixed case, and the result is displayed accordingly. 

ampm Uses the 12-hour clock for the preceding ‘h’ or ‘hh’ specifier, and displays ‘am’ or ‘pm’ 

as set by Date and Time format in Country/Region. 

/ Displays the date separator character set by Country/Region. 

: Displays the time separator character set by Country/Region. 

‘xx’/”xx” Characters enclosed in single or double quotes are displayed as-is. “mm” is therefore 

displayed as mm and not as the month as a number with leading zero. 

Once you have chosen a notation or entered a notation yourself you click OK to accept the settings. 

The selected date and/or time are now displayed in the field. 
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A field of 
type Date & 

Time  has 
been inserted 

 

A field is not updated continuously. This means that, even though the time can be displayed accurate 

to the second, it does not “run”. The time will only change when the slide is updated, for example 

when it is displayed or when an object is added or removed. The slide is also updated during voting 

provided that you have inserted an interactive result diagram on the slide. 

Displaying slide numbers 
The field type Slide numbering allows you to display the current slide number or the total number of 

slides in the script. If you place this field on the first background slide it will be displayed on each 

slide, provided that you use the first background slide on each slide. 

Under Field options you can indicate if you want to show the current slide number or the total num-

ber of slides. If you want to show both you have to insert two fields. If desired, you can combine 

these fields with standard text objects. 
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A field of 
type Slide 

numbering  
has been in-

serted 

 

In the example above two standard text objects and two fields are inserted. The first field shows the 

current slide number, while the second field shows the total number of slides. 

Displaying the network status 
With the field type Network status it is possible to display different values of the voting network. 

You can display one of the following eleven statuses: 

Number of initialized keypads Displays the total number of keypads initialized on all connected 

Base Stations. 

Number of active keypads Displays the number of keypads that were active at the moment the 

last voting was opened. 

Number of voted keypads Displays the number of keypads that voted at least once. 

Total number of votes Displays the total number of votes. 

Total voting weight Displays the total voting weight given by all keypads that have voted. 

Total number of validly voted keypads Displays the total number of keypads that gave a valid 

vote. A vote is valid if this keypad voted at least the minimum number of times. 

Total number of invalidly voted keypads Displays the total number of keypads that gave an 

invalid vote. A vote is invalid if this keypad did not vote at least the minimum number of times. 

Simple majority of total number of validly voted keypads Displays the simple majority 

(50% + 1) of the total number of keypads that gave a valid vote.  

Total number of valid votes Displays the total number of valid votes. A vote is valid if this 

keypad voted at least the minimum number of times. 

Total number of invalid votes Displays the total number of invalid votes. A vote is invalid if 

this keypad did not vote at least the minimum number of times. 



206 

Simple majority of total number of valid votes Displays the simple majority (50% + 1) of 

the total number of valid votes. 

Displaying results without a result diagram 
By using the field type Results you can show the results of a question in numbers instead of in a 

result diagram. In the field options you can indicate from which question and from which answer 

you want to show the results. You can display the results as absolute figures or as percentages. 

Furthermore, you can cross results with participant groups so that you can see the results of each 

participating group. 

The field op-
tions for the 
field of type 

Results 

 

Field options 

In the field options you indicate which results should be displayed in this field. In Results of ques-
tion you indicate from which question the results should be displayed. You choose a question from 

the list containing all questions in your script. You can also choose Current question. This is the 

question that is on the same slide as this field. If there is no question on this slide, then the last 

question from the preceding slides is used. 

Answers 

In the answer options you indicate what type of result you want to see. You can choose from the 

following fifteen types: 
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Result of answer Displays the results of a certain answer. You can select from which answer you 

want to see the results. In the list below Answer all answers from the question you chose under 

Results of question are listed. 

Total result Displays the total result of all answers. 

Total result of non-voters Displays the total number of keypads that didn’t vote, or, in case of 

an identified question, the total voting weight of the participants that didn’t vote. It is not possible 

to distinguish between keypads that have been handed out but didn’t vote, or keypads that have 

been initialized but not been handed out. If you initialized more keypads than your final number of 

participants, these extra keypads will also be counted as non-voters. 

Half of the total result Displays the half of the total result. This option can be used to see if a 

certain answer received at least half of the total votes. This is the actual half, so in case of an odd 

number of votes, half a vote will be shown. 

Total result of negative answers Displays the total result of all answers that are considered 

negative. Negative answers are answers with the lowest answer number. For an even number of 

answers, the first half is considered negative, the last half is considered positive. For an odd number 

of answers, the middle answer is considered neutral. It will neither be counted to the negative an-

swers, nor to the positive answers. 

Total result of positive answers Displays the total result of all answers that are considered 

positive. Positive answers are answers with the highest answer number. 

Total result minus last answer Displays the total result of all answers with the exception of the 

last answer. 

Total result including last answer Shows the total result of all answers, including the last an-

swer, even if the question is set not to include the result of the last answer in the total. 

Total number of voters Shows the number of participants who cast at least one vote. 

Simple majority of the number of votes Displays the simple majority (sometimes called “Half 

plus 0ne”) of the total number of votes. For an even number of votes, this is the half of the number 

of votes plus one. For an odd number of votes, this is the half of the number of votes rounded 

upwards. 

Simple majority of the number of voters Displays the simple majority of the total number of 

voters. A voter is a keypad that voted at least once. 

Supermajority of the number of votes (2/3) Displays the supermajority (in this case ²⁄₃ ) of 
the total number of votes. For a number of votes that is a multiple of three, this is two thirds of the 

number of votes plus one. In both other cases, this is two thirds of the number of votes rounded 

upwards. 

Supermajority of the number of voters (2/3) Displays the supermajority of the number of 

voters. 

Supermajority of the number of votes (3/4) Displays the supermajority (in this case ¾) of the 

total number of votes. For a number of votes that is a multiple of four, this is three quarters of the 

number of votes plus one. In all other cases, this is three quarters of the number of votes rounded 

upwards. 
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Supermajority of the number of voters (3/4) Displays the supermajority of the number of 

voters. 

Simple majority of the number of votes (rounded) Displays the simple majority of the total 

number of votes, first rounding the result. For an even number of votes, this is the half of the number 

of votes plus one. For an odd number of votes, this is the half of the number of votes rounded 

upwards, plus one. 

Simple majority of the number of voters (rounded) Displays the simple majority of the total 

number of voters, first rounding the result. 

Supermajority of the number of votes (2/3, rounded) Displays the supermajority (in this 

case ²⁄₃ ) of the total number of votes, first rounding the result. For a number of votes that is a 
multiple of three, this is two thirds of the number of votes plus one. In both other cases, this is two 

thirds of the number of votes rounded upwards, plus one. 

Supermajority of the number of voters (2/3, rounded) Displays the supermajority of the 

total number of participants, first rounding the result. A participant is a keypad that voted at least 

once. 

Supermajority of the number of votes (3/4, rounded) Displays the supermajority (in this 

case ¾) of the total number of votes, first rounding the result. For a number of votes that is a multiple 

of four, this is three quarters of the number of votes plus one. In all other cases, this is three quarters 

of the number of votes rounded upwards, plus one. 

Supermajority of the number of voters (3/4, rounded) Displays the supermajority of the 

total number of voters, first rounding the result. 

Options 

Using the options you can indicate whether you want to show the results in absolute numbers or in 

percentages. You can have the percentage calculated based on the total number of votes as well as 

the total number of voters or participants. In this case a voter is a keypad that voted at least once. 

Absolute values The results are displayed in absolute numbers. 

Relative to number of votes The results are displayed in a percentage of the total number of 

votes. 

Relative to number of voters The results are displayed in a percentage of the total number of 

voters. A voter is a keypad that voted at least once. 

Relative to number of participants The results are displayed in a percentage of the total num-

ber of participants. A participant is a keypad, regardless of whether it voted or not. 

If you choose the Relative to number of votes, Relative to number of voters or the Rela-
tive to number of participants option, you can also indicate how many decimal digits you want 

to display using the Show decimal places option. 

If you choose Absolute values, you can use Precision in decimals to specify in how many dec-

imal places you want to display the absolute values. If you choose one decimal, the total number of 

votes divided by 10 is displayed. At two decimal places, the total is divided by 100, and so on. This 
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option is especially useful when using voting weights, where, for example, half weights must also 

be used. Because it is not possible to enter half weights, you can choose to multiply all weights by 

100. If you then set the accuracy to two decimal places, the total result is then divided by 100 again. 

With the option Show decimal places you determine how many decimal places are actually dis-

played. For proper operation, the number of decimal places can be set to a maximum of one less 

than the accuracy. 

With the Only count participants from this group option you can enter a group name of which 

you want to see the results. When counting the results, only the results from participants in this 

group are counted. This allows you to make a crossing with several groups. 

The name of the group is case-sensitive. This means that the groups ‘RED’ and ‘Red’ are two different 

groups. You can also enter multiple group names by separating the group name with a semicolon. 

The Ignore vote weight option allows you to view the results without using the voting weight, 

even though the current question is set to use voting weight. 

Various fields 
of type Re-
sults have 

been inserted 

 

In the example above the results of the four groups that answered this question are displayed. The 

first field after the answer “Italy” is set to show the results of the current question and the answer 

“Italy”. Additionally, the results should be displayed as percentages with one digit behind the deci-

mal point. Only the participants from the group ‘RED’ are counted. The following three fields have 

the same settings, except that they show the results of the groups ‘GREEN’, ‘BLUE’ and ‘YELLOW’ 

respectively. The last field is set to show the results of the current question and the answer “Italy”. 

The results are not displayed as percentages and no group is selected to count the results from. 

Therefore the absolute number of votes for the first answer is displayed. 
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The other fields are set up the same, with the only exception that they show the results of a different 

answer. The last row with totals is set to display the total result stead of the result of a specific 

answer. The first four are set up to only show the results of a specific group. The last field shows the 

total result without counting participants from a certain group. 

Displaying results from a series of questions 
It is not only possible to display the results of a certain question, you can also display all kinds of 

cumulatives. These are results calculated over a series of question. You can choose from a number 

of simple calculations, such as the total number of votes or the average number of votes, but there 

are also several statistical calculations available, such as the standard deviation and the variation 

coefficient. 

The field op-
tions for the 
field of type 
Cumulatives 

 

In the field options you select the questions over which you want to calculate the cumulatives. You 

can also calculate the cumulatives over just one question. You can also select whether you want to 

calculate the cumulatives over all answers or over just a single answer. The meaning of the calcula-

tion might differ depending on whether you choose all answers or just a single answer. The result 

calculated over all answers is also an answer, while the result calculated over a single answer is a 

number of participants. 
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For example, if you calculate the mean value of all answers, this will results in an average answer. 

If you calculate it for only a single answer, the average number of participants that voted for this 

answer is displayed. 

You have to take care that the calculations you make return useful information. It has no use to 

calculate the total number of votes for answer 4 over ten questions, while not all questions really 

have four answers. 

Display 

You can display various sorts of calculations. 

Total number of votes Displays the total number of votes for the indicated questions. You can 

both display the total number of votes for a certain answer and the entire total of all answers. 

Relative number of votes Displays the relative number of votes for the indicated questions. This 

is the percentage of voters for a certain answer compared to the total number of voters. The relative 

number of votes can only be displayed for a single answer. If you would display it for all answers, 

the result would always be 100%. 

Mean value Displays the mean value for the indicated questions. 

Variance Displays the variance for the indicated questions. The variance indicates the extent to 

which the values differ, and thus how far they are from the average. 

Standard deviation Displays the standard deviation for the indicated questions. The standard 

deviation is approximately the average deviation from the average. 

Coefficient of variation Displays the coefficient of variation for the indicated questions again. 

The coefficient of variation is a measure of the relative distribution of values. 

Median Displays the median for the indicated questions. The median is the middle value of a series. 

Mode Displays the mode for the indicated questions. The mode is the value that occurs most often. 

3rd Moment Displays the 3rd moment for the indicated questions. The 3rd moment is used to 

determine the skew. 

4th Moment Displays the 4th moment for the indicated questions. The 4th moment is used to 

determine the kurtosis or flatness. 

Skew Displays the skew for the indicated questions. The skew indicates whether the distribution 

differs to the left or to the right compared to a normal distribution. 

Kurtosis Displays the kurtosis for the indicated questions. The kurtosis indicates the flatness of a 

distribution, whether the distribution is high and narrow, or low and wide. 

For options that can return a fraction, you can specify how many digits after the decimal point you 

want to display. This can range from zero to five decimal places. 

Displaying names of participants 
With the field type Participants you can show the names of each individual participant. Names can 

always be displayed, or only when a participant has voted or even if he or she gave a certain answer. 
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The field op-
tions for the 
field of type 
Participants 

 

With field options you can indicate if you want to show the name of a certain participant or the 

names of all participants that gave a certain answer on a certain question. 

With the option Name of participant you display the name of a certain participant. The sequence 

is the position of a participant in the participant list. Therefore, the name of participant 1 is the first 

name in your participant list. This option is especially useful when you want to display the names of 

the participants in a regular setting. You can combine this option with the option to change the 

background color of a field the moment a participant votes. By doing so you can see exactly who 

voted, who did not vote and even what each participant voted. 

The only other options that can be used, are the Hide name until after voting option and the 

Hide name if not present option. If you enable the Hide name until after voting options, 

the field will start empty. Only after voting, the name of the participant will be shown. If you enable 

the Hide name if not present option, the name of the participant will not be shown if the partic-

ipant list indicates that this participant is not present (any more). 

For each field type you can set a background just like for a standard text object. See also “Setting 

up the background“ on page 50. When selecting Participants as a field type you can not only set up 

a background for it but you can even make is change according to what a participant votes. 

In the tab Background you can indicate the background color for this field. You can choose between 

a transparent background, a single color, a gradient or an image. The group color option is only 
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available when this question is a group question. In that case the background will get the color of 

the chosen group. 

A field of 
type Partici-
pants allows 

its back-
ground to be 

changed at 
the moment 
the partici-
pants have 

voted 

 

On the Interactive background tab you can indicate what should happen with the background when 

the participant has voted. If the option During voting, change the background to is enabled, 

then, as long as the voting is open, the background will be changed in the selected color as soon as 

this participant has voted. If the option After voting, change the background to is enabled, 

then, as soon as the voting is closed, the background will be changed in the selected color. 

You can have the background color change with one of the following options: 

transparent The background of the field will become transparent. 

a single color The background of the field changes to a single color as indicate by the Primary 
color. 
the single color of the given answer The background changes into the single color that was 

set up as the bar color for the answer given by this participant. 

the single color of the correct or wrong answer The background changes into solid red 

when the participant gave the wrong answer or into solid green when the participant gave the cor-

rect answer. 



214 

Various fields 
of type Par-

t icipants have 
been inserted 

 

In the example above hundred fields of the Participant type are inserted. The first field is set up to 

display the name of participant 1 only when the participant has voted on the current question. First, 

the background is set to None. After that, the option After voting, change the background 
to is enabled and after voting the background must change to a single color. Finally, the back-

ground color was set to orange. The other fields are set up the same for participant 2 to 100. 

You see that after the participants have voted, their name appears and the background of the field 

turns orange. For the participants that have not voted yet the name does not appear and the back-

ground stays transparent. 

By setting the background to change the color after voting to the color of the given answer, you can 

also see what these participants have voted. In the next example, the option After voting, change 
the background to is set to the single color of the given answer. 



215 

The back-
ground color 

of the fields is 
based on the 

given an-
swers 

 

The color of answer 1 was set to green, of answer 2 to red, of answer 3 to blue and of answer 4 to 

yellow. In this overview you can see that the majority of the participants have chosen answer 2. 

It is also possible to combine the above two options. This allows you to see who voted, but not yet 

what the participants voted, as long as voting is still open. You can only see what the voted once 

you close the voting. To achieve this, set the background color to None, the During voting, 
change the background to to a single color and the After voting, change the back-
ground color to to the single color of the given answer. 

Finally, it is also possible to have the background change into red or green depending on whether 

the given answer was wrong or correct. For this to happen the option After voting, change the 
background to is set to the single color of the correct or wrong answer. 
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The back-
ground color 
is now based 

on the correct 
or wrong an-

swer 

 

When a participant has given the correct answer the background color of his field turns green. Did 

he or she give the wrong answer the background will turn red. The colors red and green are not 

fixed. You can change them in the properties of the corresponding question. See also “The properties 

of a question“ on page 70. 

Participants that gave a certain answer 
In the previous examples the name of one participant is displayed in one field. It is also possible to 

display several names in one field. This allows you to display the names of all participants that voted 

on answer 1. Or of all participants that did not vote on answer 1. 
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One field with 
participants 

that gave the 
correct an-
swer to the 

previous 
question and 

one field with 
participants 

that gave the 
wrong an-

swer 

 

In the example above, two fields were inserted. The first field has a permanent green background 

color. In this field all participants are displayed that voted for answer 2 on the current question. The 

second field has a permanent red background color. In this field all participants are displayed that 

did not vote for answer 2 on the current question. 

The proper-
ties of field 

set up to dis-
play names of 

participants 
that have 

given a cer-
tain answer 
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The properties of the first field are set to show the names of participants that gave the following 

answer. Answer 2 was selected as the answer, and the current question as the question. 

The following options can also be set: 

Display names under each other When this option is enabled the names are displayed under 

each other instead of side by side. 

Only count participants with the following text in their name If you only want to display 

participants that have a certain text in their name you enable this option. In the text box below you 

can enter the text that must be part of the name in order for this name to be displayed. This text 

must appear in the name exactly as entered, which means that it is case-sensitive. 

Only count participants from this group/these groups You enable this option when you 

only want to display participants from a certain group. You can enter the name of the group in the 

text box below. A group name is also case-sensitive. You can also enter multiple group names by 

separating the names from each other with a semicolon. 

Start with name Here you specify the first name that may be displayed in this field. If you enter 

a 7 for example, the first six names that meet the specified conditions will not be shown. If you 

combine this option with the Number of names option, you can make different panels which show 

the names of the participants. To show the first 20 participants in the first panel, you set the Start 

with name option to 1, and the Number of names option to 20. For the second panel, you set 

the Start with name option to 21 and the Number of names option to 20, etc. 

Number of names Here you specify the maximum number of names you want to display in this 

field. 

The second field is set up like the first one. Only this time the option to show the names of partici-

pants that did not give the following answer was selected. And here too, answer 2 was selected as 

the answer and the current question as the question. 

This way of displaying participants is especially useful if you want to play a knock-out race. For each 

question you can see which participants are still in the race and which ones were “knocked out”. 

For more information see “The knock-out race“ on page 229. 

The question used in this example is not very suitable for a knockout race. In a knockout race there 

can only be one correct answer per question. The question in this example has two correct answers. 

Both answer 2 and answer 4 are correct. A participant gets 10 points for both answers. 

An overview of the score per participant 
With the field type Score you can display the score for each participant. You can display the score of 

each participant so that you can see exactly which participant got how many points. You can sort 

the participants based on their scores and put the best scoring participant at the top of the list. You 

can do the same per group, when participants do not play individually but in groups. 
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The field op-
tions for the 
field of type 

Score  

 

Field options 

Under field options you can indicate from which participant(s) or group(s) you want to show the 

score. 

Participant This option displays the score, voting time or name of a certain participant. If you don’t 

want to show the results per participant, but per group instead, set the participant number to 0. 

Group This option displays the score, voting time or name of a certain group. The score and voting 

time are determined by adding the scores and voting times of each of the participants in this group 

together. If you don’t want to show the results per group, but per participant instead, set the group 

number to 0. 

You can also display the total score and voting time of all participants. To do this, set both the 

participant number and the group number to 0. 

Order With this option you indicate whether the list of participants or groups should be sorted or 

not. 

original order With this setting, the list with participants will not be sorted. It will retain its orig-

inal order. 
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participants on score; groups in original order This settings will sort all participants on their 

score. The participant with the highest score will be at the first position and the participant with the 

lowest score will be at the last position. 

participants on score; groups on score This setting will first combine all participants from the 

same group. Then, a group score is determined for each of the groups, by adding together the scores 

of each of the participants within this group. The groups are sorted on score, so that the group with 

the highest score will be at the first position. The participants within each group are also sorted, so 

that the participant with the highest score is at the first position within this group. 

participants on score; groups on relative score per participants This setting is quite sim-

ilar to the previous setting. However, the groups are not sorted on a total score, but on a relative 

score instead. This is percentage of the total group score versus the score the group could have 

obtained if all participants had chosen the answer with the highest score. 

participants on score; groups on relative score per voters This setting also sorts the 

groups on a relative score. In this case, the relative score is a percentage of the total group score 

versus the score the group could have obtained if everyone who voted had chosen the answer with 

the highest score. Participants that did not vote are not taken into account. 

If multiple participants or groups have the same score while sorting the list, the participant or group 

with the lowest voting time will be on top. 

A position can also be negative. In that case you won’t be displaying the best participant, but instead 

the worst participant. The participant at position -1 is the participant with the lowest score.  

Filter on group This option allows you to filter a specific group or specific groups from the total 

group. To do this, you have to fill in the entire group name. A group name is case sensitive. You can 

also enter multiple group names by separating them from each other with a semicolon. 

Display 

The options under Display determine what you want to show from the selected participant(s) or 

group(s). Depending on the participants or groups you selected, instead of “participant”, you could 

also read “participants”, “group” or “groups”. 

Score The total score of the selected participant. 

Voting time The total time that the selected participant needed to give his vote. 

Name of participant The name of the selected participant. 

Name of group The name of the group of the selected participant. 

Minimal score This option displays the lowest score of one of the participants. This is not a total 

score. If you calculate the minimal score over a series of questions, then this will display the lowest 

score a participant got for one of those questions. If you display the minimal score for a group, then 

this is the lowest score that one of the participants got for one of the questions. 

Maximal score This option displays the highest score of one of the participants. This is not a total 

score. If you calculate the maximal score over a series of questions, then this will display the highest 
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score a participant got for one of those questions. If you display the maximal score for a group, then 

this is the highest score that one of the participants got for one of the questions. 

Score in percentage per number of participants This option displays the relative score of 

the selected participant. The relative score is the obtained score relative to the total obtainable score. 

This option is especially useful when you work with groups of different sizes. Otherwise a group with 

fewer participants would be in a disadvantage compared to a group with more participants. See also 

“An overview of groups with different numbers of participants“ on page 226. The maximum obtain-

able score is the score the participants could have obtained if every participant voted for the answer 

with the highest score. 

Maximum score per number of participants This option displays the maximum obtainable 

score for this participant. The maximum obtainable score is the score the participants could have 

obtained if every participant voted for the answer with the highest score. 

Score in percentage per number of voters This option is almost identical to the Score in 

percentage per number of participants option. However, in this case the total obtainable 

score is the score the participants could have obtained if everyone who voted, voted for the answer 

with the highest score. Participants that did not vote are not taken into account. 

Maximum score per number of voters This option displays the maximum obtainable score for 

this participant. The maximum obtainable score is the score the participants could have obtained if 

everyone who voted, voted for the answer with the highest score. Participants that did not vote are 

not taken into account. 

Average score This option displays the average score obtained by everyone who voted. 

Questions 

Under Questions you can indicate which questions have to be taken to calculate the scores. This 

allows you to present both a half time score and a final score. 
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Various fields 
of type Score  

display the 
name, group, 

score and vot-
ing time of 
the partici-

pants 

 

In the example above, two more questions were inserted. The first question in this script has two 

correct answers. When a participant chooses either of them he gets 10 points. The other two ques-

tions each have one correct answer. And for these answers too, a participant can get 10 points. The 

standard score for these questions is set to -2 points, so that every participant that does not vote 

will get 2 penalty points. 

On this slide an overview is displayed showing the half time score after the first three questions. The 

first column displays the names of the first three participants of each of the four groups. A field is 

inserted with its Field options set to display Participant 1, 2, 3, 51, 52, 53, 101, 102, 103, 151, 152 

and 153. Because the participants are divided into groups of fifty participants each, it is not necessary 

to select a certain group. The option from group is set to 0. 

The Display is set to Name of participant. Under Questions, question 1 was selected as the first 

question and question 3 as the last question. 

The second column displays the group each participant is in. Here too the Field options are set to 

Participant and the from group option is set to 0. The Display is now set to Name of group. 

And finally, for column 3 and 4, the Display is set to Score and Voting time respectively. 

At the top of the slide a text is inserted showing the maximum score for these three questions. A 

standard text object is inserted with, on top of it, a field of type Score. The Field options are set to 

Participant 1 from group 0 and the Display is set to Maximum score per number of par-
ticipants. It does not matter if you select Participant 1 or Participant 200. All 200 participants can 

obtain the same maximum score. 
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If you display the group name of a participant in a score overview, you can also have it display a 

background color. In the properties of a field that displays a group name, you can set the background 

color to Group color. This group color can only be used when you had your audience divide them-

selves into groups by using a group question. The answers of a group question determine the group 

names and the bar colors of these answers determine the group color.  

An overview of the scores made per group 
The quiz in this example has 200 participants. It is impossible to show the results of all 200 partici-

pants on one slide in a decent way. Therefore, in the example, the results of only 12 participants 

were displayed. The 200 participants are divided into four groups. The first three participants of each 

group are displayed. It is also possible to make an overview of the four groups so that you can see 

the results of each group. 

Various fields 
of type Score  

display the 
group score 

and the total 
voting time 

 

The names of the groups are displayed with standard text objects. To show the scores a field of type 

Score is used. The Field options are set to Participant 0 from group 0 and the option Filter on 

group is set to RED, GREEN, BLUE and YELLOW respectively. Display is set to Score. The same was 

done for displaying the voting time. Here, Display was set to Voting time. 

A top-5 of participants 
An overview of the scores of each participant is only useful when you can display the results of all 

participants on one slide. This is no problem for small groups but it does not work for a group of 200 

participants. 

For bigger groups it is more interesting to display a top-3, a top-5 or even a top-10 showing the best 

scoring participants at that time. 
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The top-5 af-
ter three 

questions 

 

In the example above a top-5 is displayed as this would look after having voted the first three ques-

tions. Participants could make a maximum of 30 points for these three questions. You see that eve-

ryone in this top-5 did make 30 points. In this case the total voting time of each participant is also 

taken into account. The participant who answered all three questions correctly and also answered 

them the quickest, will be at position 1. 

The first field on the first row is set to display the name of participant 1 from group 0. The names 

are sorted on score. The second field is set to show the name of the group of participant 1 from 

group 0. Here too the names are sorted on score. The third field is set to display the corresponding 

score and the fourth field to display the corresponding voting time. The same is set for the following 

rows of fields but for participant 2, 3, 4 and 5 respectively. Each field is set to count question 1 to 3. 

You can display a top-3 or top-10, or any desired top in the same way. Under Field options you enter 

the position of the participant that you want to display. You also set the Order to participants on 

score; groups in original order. 

In this test quiz there are four more questions after this overview. For question 4, 5 and 6, a partici-

pant can get 15 points per question and for question 7 a participant can get 20 points. 

After question 7 the same top-5 is displayed as after question 3. Of course the properties of the fields 

are set so that the results for question 1 to 7 are counted. 
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The top-5 and 
bottom-3 af-

ter seven 
questions 

 

Additionally, a bottom-3 is displayed on this slide as well. This gives an overview of the three worst 

scoring participants. The same fields as for the top-5 are used here. Only the participants at position 

-3, -2 and -1 are displayed respectively. 

Should you want to show a top-5 on a slide that also contains a question, you have to be aware of 

the fact that the results are displayed the moment you open the voting. If this would be the first 

question, everyone will have 0 points. The top-5 does not mean anything then. The participant on 

the first position has exactly the same number of points as the one on the fifth position. Only when 

the voting is closed the correct overview of results will be displayed. It is therefore advisable to 

always show a top-5 on a separate slide and not on a slide that is also used for voting. 

A top-4 of groups 
You can display a top-5 of groups the same way you display a top-5 of participants. In this example 

it is a top-4, because there are four groups that participate in this quiz, but you can just as easily 

create a top-5 or a top-10. 
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The four play-
ing groups 

ranked from 
best to worst 

playing group 

 

The first field on the first row is set to display Participant 0 from group 1, while the Order was 

set to participants on score; groups on score. The second field shows the score, the third 

shows the voting time and the fourth the name of the participant. This fourth field was set up to 

display Participant 1 from group 1, to select the best participant from this group. 

The same is done for the other fields for group 2, 3 and 4 respectively. 

An overview of groups with different numbers of participants 
If you play a quiz with groups that have different numbers of participants you cannot show a top-4 

based on the number of points. A group with fewer participants would then have a disadvantage, 

because they cannot make as many points as a group with more participants. That would also mean 

that a group with a larger number of participants would have a better chance to end up higher in 

the top-4. 

When the groups have different numbers of participants, you better show a relative score. This is a 

score in percentages based on the maximum number of points that can be made by a group. Whether 

a group has lots of participants or only a few doesn’t matter anymore, because the maximum number 

of points is related to the size of the group. 

In the following example the same quiz was played. There are still four groups. Group ‘RED’ has 38 

participants, group ‘GREEN’ has 50 participants, group ‘BLUE’ has 25 participants and group ‘YEL-

LOW’ has 35 participants. After answering all seven questions, a top-4 of the groups is displayed. 

First the normal score is displayed. An extra field is inserted to display the maximum score that could 

be made by each group. The groups are sorted on the score in percentages per number of partici-

pants. 
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The four play-
ing groups of 

different sizes 
ranked from 

best to worst 
playing group 

 

You see that when calculating the 1st, 2nd, 3rd and 4th position, the different sizes of the group are 

already taken into account. Even though the ‘GREEN’ group has scored most points, they are still at 

position three. This group has the largest number of participants and therefore could have made a 

much higher score. By showing the relative score instead of the standard score the overview gets 

clearer. 

The score of 
the groups 

displayed in 
percentages 

 

Group ‘RED’ has scored a little over 45% of the total score that this group could make. This makes 

group ‘RED’ the winner. Even though group ‘GREEN’ has scored the most points in absolute figures, 
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this was only 38% of what they could have scored. And that makes group ‘GREEN’ a worse playing 

group than group ‘RED’. 

Still, the overview above isn’t that fair. In calculating the maximum score it is assumed that all par-

ticipants in the group have voted. And when making a participants list, you have to decide how 

many participants there are going to be in each group. Even though in the example above it was 

taken into account that group ‘BLUE’ would have 21 participants, it turned out that the real number 

of participants in this group was a little lower. This would make group ‘BLUE’ to be at a disadvantage. 

You could say that this was tough luck for group ‘BLUE’. They should all have come to play the quiz. 

But it could also be that you didn’t know in advance how many participants would be in group 

‘BLUE’, and so you made a list of 21 participants. If the group turns out to have only 17 participants, 

you would put group ‘BLUE’ at a disadvantage. 

If the group size isn’t known in advance, you can choose to have the relative score calculated based 

on the maximum score per the number of voters. If only 17 participants in group ‘BLUE’ vote, the 

maximum score is calculated for these 17 participants instead of the 21 that were originally in the 

participants list. 

The score of 
the groups 

displayed in 
percentages 

based on the 
number of 

voters 

 

You see that now that the score is calculated based on the number of participants that actually voted, 

the group ‘BLUE’ scored better than group ‘GREEN’. 

A disadvantage of this method however, is that it is now more favorable for a participant that doesn’t 

know the correct answer to not vote at all instead of voting for the wrong answer. If he does vote, 

but gives the wrong answers, his score will not increase, but his maximum score does. If he doesn’t 
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vote at all, his score will not increase, but neither will his maximum score. Relatively seen, the latter 

is more favorable. 

The knock-out race 
In a knock-out race you also play a quiz. Unlike a standard quiz, a knock-out race only allows one 

correct answer for each question. Furthermore, a knock-out race is always played individually and 

never in groups. 

After each question in the knock-out race, participants that gave a wrong answer are “knocked out” 

of the race. They are not allowed to vote for the next questions anymore. Their keypad still opens 

and they can vote with. However, their vote is no longer registered. Only votes from participants that 

are still in the race are registered. 

You play a knock-out race by enabling the Knock-out race option in the properties of each ques-

tion. At the start of a session all participants take part in the race. When someone gives a wrong 

answer to a question he is out of the race. You play the race until only the winner is left. Should it 

happen that, at a certain question, the only remaining participants all give a wrong answer and there 

is no winner, these remaining candidates will not be excluded from the race and can therefore still 

answer the next question. This means that even though all remaining participants are “knocked 

out”, you can still continue playing until there is only one winner left. 

A knock-out race is active during one session. It is not possible to have participants that were already 

out of the race, take part in the race again, when you are still in the middle of your question. Only 

when you start a new session can all participants join again. 

During a knock-out race you can ask questions that can be answered by all participants. Those ques-

tions are not part of the knock-out race. In the properties of these questions you disable the option 

Knock-out race. 

For example, you play a knock-out race with 50 participants. After three questions there are 32 

participants left. You then ask a question that is not part of the knock-out race. All 50 participants 

can answer this question. The next question is part of the knock-out race so only the 32 participants 

left can answer this question. After ten questions there are 5 participants left. Again you ask a ques-

tion that does not belong to the knock-out race. All 50 participants can answer this question. The 

next question is part of the knock-out race again, so only the remaining 5 participants can answer 

this question. After this question there are three participants left. You ask one more question and all 

three of them give the wrong answer. But they can all try again when you ask the next question. In 

the end only one participant is left. 

After each question in a knock-out race you can display a slide with two fields of type Participants. 

The first field is set to Names of participants that gave the following answer. You select 

the correct answer here as the answer. The other field is set to Names of participants that did 
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not give the following answer. Here too you select the correct answer as the answer. After 

each question you can see which participants are still in the race and which were “knocked-out”. 

See also the example in “Participants that gave a certain answer“ on page 216. 

Displaying text from an external application 
With a field of the Text type you can display any arbitrary text from an XML file. If you have this XML 

file written by another application, you can display information from another application in a field. 

The field op-
tions for the 
field of type 

Text  

 

An XML file is divided into a number of blocks, and each block is divided into a number of texts. The 

field options allow you to indicate from which block and from which text you want to display the 

information is this field. If you set the block index to 0, an index will be used that corresponds to the 

question number of the current question. 
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Voting with the smartphone via 

IVS-Online 

In addition to voting with keypads, your participants can also vote via their own smartphone, tablet, 

laptop, desktop or any other device that is connected to the internet and has a browser. To let your 

participants vote online, you connect your script with IVS-Online. Your participants visit an IVS-

Online website, which is linked to your script. As soon as you open voting, your online participants 

will see the question with the corresponding answers. By tapping the answer of their choice, they 

can cast their vote. If you close voting, the question disappears again from the online participants 

and, when this is set up, they see the result in a bar chart. 

There are two steps to preparation for allowing your participants to vote online. First, you must 

connect your script to IVS-Online. Your script is then stored on the IVS-Online server, so that your 

participants can go to the IVS-Online website to participate in the voting. The second step is to 

initialize a virtual Base Station, called the IVS-Online Gateway. Just as a normal Base Station handles 

communication with the keypads, the virtual IVS-Online Gateway takes care of the communication 

with the online participants. 

The votes that your online participants cast are temporarily stored on the IVS-Online server. Every 

time you open the voting, the results of a previous voting are deleted. When you disconnect from 

the IVS-Online server, for example when closing IVS-Professional, the results of the last voting are 

also deleted. Results of an online voting therefore never remain on the IVS-Online server. Just like 

the results of the keypads, they are only stored in a session on the computer on which you use IVS-

Professional. 

To use IVS-Online you need a license for IVS-Professional. This license is an extra license on top of 

the license for using more than 30 keypads. With IVS-Professional’s free license, with which you can 

use up to 30 keypads, you can try out IVS-Online with up to 3 participants. You also need an account 

for the IVS-Online server. You can request an account from IVS-Professional by selecting Request 

IVS-Online account from the Connection menu. 

Configuring the IVS-Online connection 
To connect your script to IVS-Online, you use the configuration wizard. This wizard guides you 

through the configuration in a few steps. To start the wizard, choose Configure IVS-Online con-

nection from the Connection menu. 
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The wizard 
for creating 

an IVS-Online 
connection 
guides you 

through the 
configuration 
in a few steps 

 

Logging in to the server 

The first step is to log in to the IVS-Online server. To be able to do this, you need the account infor-

mation for the server. If you do not have an account yet, you can request one by selecting Request 

IVS-Online account from the Connection menu. A web page will then be opened in which you can 

enter your email address. By clicking on the Send activation code button, you will receive an email 

with further instructions at the indicated email address. This email address is also your IVS-Online 

account user name. 

Logging in to 
the IVS-

Online server 

 

Enter your user name and the corresponding password. When you click on the Next button, a con-

nection is made to the IVS-Online server and you are logged in with the entered data. 
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With the Remember user name and password option you can have the entered user name and 

corresponding password stored on the computer. If you have to log in again later, this information 

will be entered automatically. The password is stored encrypted. The user name is also stored in the 

script. If you open the script again at a later time, a connection is automatically made to the IVS-

Online server with this user name. If the corresponding password is stored on the computer, this 

connection will be completed automatically. If no password has been saved, the password will be 

requested every time you open the script. 

If you have forgotten your password, you can click on the Forgot your password? link. A webpage 

will open in which you can enter your email address. An email will then be sent to this email address 

with instructions on how to reset your password. 

Creating a script 

After connecting to the IVS-Online server, you also have to create a script on the IVS-Online server. 

The questions and answers are stored in this online script, so that they can be shown to the online 

participants when the voting is opened. You only need to create one online script per script. You can 

change the online script at any time by restarting the configuration wizard. 

Creating a 
new online 

script 

 

Create a new script  With this option you can create a new online script on the IVS-Online server. 

If you have not created an online script before, this is the only option. 

Modify the current script  If you restart the configuration wizard after you had previously cre-

ated an online script, you can modify the online script with this option. 
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Naming the script 

You can give your online script a name. This name may match your normal script, but this is not 

required. The name of the script is displayed in the title bar of the browser when your online partic-

ipants visit your script. 

Naming the 
online script 

 

Determining the script type 

An online script can be answered in two ways. With a real-time script, the questions are answered 

in the same way as with a keypad. Only when the voting is opened, the question with the corre-

sponding answers appears and the participant can make a choice. If the voting is closed, it is no 

longer possible to answer and the results of the voting are displayed. 

With an online questionnaire all questions are immediately available. The participant can answer the 

questions at his own time. When he opens the webpage of the script, he immediately sees the first 

question. If he has answered it, he can immediately continue to the next question until he has an-

swered the entire script. The results of the voting are not immediately available, but must be down-

loaded from the IVS-Online server after a certain time. 
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Choosing for 
a real-time 
script or an 

online ques-
tionnaire 

 

This script is a real-time script  With this option you can turn your online script into a real-time 

script. Participants will have to wait until the voting is opened before they can answer a question. 

This script is an online questionnaire  With this option, your online script becomes an online 

questionnaire. Your participants can answer all questions at their own pace. 

Setting up a time frame 

You can make your online script immediately available, but you can also set a time frame within 

which it is available. The latter is especially useful with an online questionnaire, where you allow the 

participants to answer the questionnaire during a certain period of time. But you can also set a time 

frame for a real-time script. 

Setting a time 
frame within 

which the 
script can be 

used 
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This script can always be used  With this option there is no restriction on the script. Your par-

ticipants can visit the web page of your online script at any time. When you have created a real-time 

script, the participants still have to wait until a question is put to the vote. If you have created an 

online questionnaire, participants can immediately start answering the questions. 

This script can only be used within this time frame  With this option you can set a start and 

end date, within which your script is available. When your participants visit the web page of your 

online script outside this time frame, they will be notified that the script is not (yet) available. This 

applies to both a real-time script and an online questionnaire. 

Welcoming the online participants 

When you have created a real-time script, and your online participants go to the web page of your 

online script for the first time, they will see a welcome page, as long as the voting is not open yet. 

In between all questions, when the voting is closed, they will see a standby page. 

For both pages you can set the text that your participants will see. In addition, you can optionally 

upload an image that is displayed with this text. 

If you have created an online questionnaire, this step is skipped, because with an online question-

naire your participants do not have to wait. 

Setting the 
welcome 

texts for your 
online partici-

pants 

 

In the upper part of this window you can enter a text that your online participants will see when they 

first visit the web page of your online script. You can also add an image to this text by clicking on 

the Load Image button. After selecting an image, a preview of this image is displayed in the Preview 

box. To no longer display the selected image, click the Clear Image button. 
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In the lower part of this window you can enter a text that your online participants will see when the 

voting is closed and they must wait until the voting for the next question is opened. You can also 

add an image to this text. 

A placeholder text is displayed for both texts. This text disappears as soon as you place the cursor in 

the text box and enter your own text. If you do not enter your own text, the placeholder text will be 

used. 

By default, an image of a green check mark is displayed along with the custom text for the voting. 

There is no preview of this image, because your online script has not yet been created. If you do not 

want to use an image, you can go through the configuration wizard again at a later time and click 

on the Clear Image button to remove the image of the check mark. 

Showing the results 

When you have created a real-time script, you can choose to also display the results of the voting on 

your online participants’ smartphone. These results are only displayed if they are also displayed in 

IVS-Professional. If you have a result diagram on the same slide as the question, the results will be 

displayed immediately after the voting is closed. If the result diagram is on the next slide, your online 

participants will only see the results when you go to the next slide. 

If you have created an online questionnaire, this step is skipped because no results are available with 

an online questionnaire. 

Showing the 
results to 

your online 
participants 

 

Show results  With this option, the results are displayed to your online participants. The results 

appear as soon as they are displayed in a result diagram in IVS-Professional. They remain visible until 

the next question is opened. 
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Do not show results  With this option the online participants will not see any results. If the voting 

is closed, they will see a standby page. 

For online participants, the total results are always displayed, in absolute numbers or in percentages, 

depending on how they are displayed in the result diagram in IVS-Professional. The results are always 

shown in a bar chart, regardless of how they are shown in IVS-Professional. An crossing or compar-

ison cannot be displayed with the online participants. When you cross or compare in IVS-Profes-

sional, the online participants only see part of the results. 

Determining who is allowed to vote 

Your online script is available to anyone who knows the link to the webpage of your script. This 

corresponds to voting with keypads, where the keypads are freely available in the room, with the 

difference that online participants do not necessarily have to be in the room. This is not always 

desirable, for example if you only want participants to vote in the room and prevent the link from 

being passed on to participants who are not present in the room. 

You can therefore protect your script with a user name and password. You determine in advance 

who can participate and who cannot. If your script contains identified questions, you must also use 

the user name and password combination. Otherwise it is impossible to identify your online partici-

pants. 

Determining 
who are al-

lowed to vote 

 

Anyone can vote  With this option there is no restriction on your online script. Everyone who 

visits the webpage of your online script can vote. 

Anyone can vote after registration  With this option, everyone can still participate. Partici-

pants are asked to register with their email address. You can use this option with an identified vote, 

for example with a quiz, where you let the participants identify themselves. You do not have to 
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create a list of participants in advance. Although they are asked for an email address, participants 

do not necessarily have to enter an email address. Any name can be entered. However, if two par-

ticipants in a quiz both decide to enter the name ‘Santa Claus’, and one of them wins the quiz, then 

it is impossible to determine which of them this is. 

Only a select group of participants can vote  With this option one can only participate after 

entering a user name and password. You must enter a list of user names and passwords in advance. 

Creating a user group 

If you have selected the option Only a select group of participants can vote, you can first 

create a user group. This contains all users who can participate in your online script. You can reuse 

a user group for another online script if you want the same users to participate. In that case you can 

select an existing user group, and you do not have to add all users again to your online script. 

Creating a 
user group 

 

You can select an existing user group from the list of user groups. If you want to create a new user 

group, enter a name for this new user group here. 

With the option This user group is an anonymized group you can make this group anonymous. 

Your participants do not have to log in with a user name and password, but follow a unique link that 

they receive in an email. Moreover, the voting results of each question are returned in a random 

order, so that it is not possible to find out which results belong to which participant. This also means 

that crossing questions is not possible with an anonymous group, because it is not possible to find 

out how the participants answered the reference question. 

You use an anonymous group when you want your users to vote absolutely anonymously, but still 

want to determine who can participate in the vote. This is in contrast to the option Everyone can 
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vote, where the participants also vote anonymously, but where also everyone can participate, who 

knows the link to your online script. 

Editing the user group 

If you have selected an existing user group, the user name, full name, and email address of all users 

in this group are displayed. You can add or remove users or modify the details of certain users. 

If you have created a new user group, then there are of course no users present. You can add new 

users or import them from an existing list. 

Adding users 
to or remov-

ing users 
from a user 

group 

 

With the Add button you can add a new participant to this user group. With the Edit button you can 

edit the data of the selected participant. With the Delete button you can remove the selected partic-

ipant(s) from the user group. 

With the Import button you can import an existing list of participants, so that you do not have to 

add all participants one by one. The list can be a normal text file, with the data of one participant 

on each line, separated by a tab. The list can also be a CSV file, with the data of one participant on 

each line, separated by a list separator. Each line must contain the following information, in this 

order: user name, full name of participant, password, email address, voting group and voting weight. 

Only the user name is required, the other details are optional. If you do not enter a full name, the 

user name will be used as the full name. If you do not enter a password, the IVS-Online server will 

generate a password itself. If you do not enter an email address, you cannot have this participant 

sent an invitation; it’s up to you to ensure that the participant receives his user name and password. 

If you do not enter a voting group, it will remain empty. If you do not enter a voting weight, this 

participant will receive a voting weight of 1. 
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Adding a user 

If you click on the Add button, you can enter the details of a new participant so that it is added to 

the user group. If you click on the Edit button, you can edit the selected participant’s details. The 

current details of this participant has already been filled in. 

Adding a new 
user to the 
user group 

 

Under User Name you enter a name that is unique to this user group, with which the participant 

must log in. If you do not enter a user name, the email address will be used as the user name. 

Under Full Name, enter the participant’s full name. With an identified vote, this name will be used 

as the participant name. If you do not enter a full name, the email address will be used as the full 

name. 

Under Password you enter the password for this user. Under Confirm Password, enter the password 

again. You can optionally check the Show Characters option to verify whether you have entered 

the password correctly. If you do not enter a password, the IVS-Online server will generate a pass-

word itself. 

With the option Send an invitation email to this address you can have the IVS-Online server 

send an email to the participant, containing his user name, password and a link to the web page of 

your online script. This link also contains his login details, so only clicking on the link is sufficient. He 

then does not have to enter a user name and password. 

If you do not send an invitation to the participant, you must inform him of his user name and pass-

word and the link to the webpage of your online script in another way. You will be able to retrieve 

this information later by selecting Export Internet Participants from the Connection menu. 
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Under Group you can enter the voting group and under Weight the voting weight of this participant. 

These data are not used by the IVS-Online server, but they are stored with the participant, so that 

they can be filled in later when you save a participant list of internet participants. 

Sending an invitation 

After having added all participants to the user group, you can have the participants sent an invitation 

by email. This invitation contains a link to the web page of your online script, when necessary the 

time when this page is available, and the user name and password with which the user can log in. 

The email also contains a link that allows the user to log in directly, without having to enter his user 

name and password. This link is also coded in a QR code, which he can scan with his smartphone to 

go directly to the web page. 

Sending the 
participants 

an email with 
an invitation 

 

Yes, send the users an invitation  With this option, an invitation email is sent to all participants 

whose email address has been entered. If you enable the option Send the invitation to newly 
added users only, only participants that you have just added to the user group will receive an 

invitation. Users who were already in the group, and who could have received an invitation earlier, 

will not be invited again. This option is only available if an email address of at least one participant 

is known. 

No, do not invite the users at this moment  Select this option if you do not want to send 

invitations at this time. 

Setting an alias 

An alias is a short name for your script. This alias is used to determine the link that your online 

participants must enter to access the web page of your online script. This link always starts with 

https://ivs.eu/, followed by your online script’s alias. 

https://ivs.eu/
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You can have this alias determined automatically. The IVS-Online server then generates an alias of 

five random letters and numbers. You can also enter the alias yourself. However, the alias must be 

unique because there cannot be two different online scripts that are assigned the same link. If the 

alias that you have entered does not appear to be unique, because someone else has already used 

this alias once for another online script, an alias will still be generated automatically. You will not 

be notified in advance if your alias is not unique. 

Setting an 
alias for your 
online script 

 

Automatically generate an alias  With this option you let the IVS-Online server automatically 

determine an alias for your script. This alias consists of five random lowercase letters and numbers. 

Use a specific alias  With this option you can enter an alias for your online script yourself. The 

alias must be unique to the entire IVS-Online server. For example, if you enter ‘test’ as an alias, then 

there is a big chance that this alias has already been used by someone else for an online script. If the 

alias is not available, an alias will be automatically generated for your script. 

An alias is not only linked to your online script, but also to the selected user group. If you change 

your online script from Only a select group of participants can vote to Everyone can vote, 

a new alias will be generated. 

If you have assigned an alias to your online script yourself and you want to use this alias later for 

another online script, you must first release the alias. You do this by starting the configuration wizard 

again and then selecting the option Automatically generate an alias. The IVS-Online server will 

then automatically generate a new alias for your online script, which will release your own alias so 

that it becomes available for another online script. 
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Setting extra options 

In addition to online voting, you can also offer your online participants the opportunity to send mes-

sages. For more information, see “Configuring message sending” on page 252. 

You can only set these extra options if your online script is a real-time script. It is not possible to use 

extra options for an online questionnaire. 

Setting extra 
options for 
your online 

participants 

 

Message sending  With this option you offer your online participants the possibility to send mes-

sages. 

Meeting evaluation  This option is not currently supported. 

Summary 

Before your online script is actually created, a user group is created and online participants are added, 

a brief summary of the settings is first shown. Only in the next step will all settings actually be sent 

to the IVS-Online server. 
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A summary of 
the settings 

for your 
online script 

 

Completing the wizard 

After all settings have been sent to the IVS-Online server, which can take a while, especially when 

many invitations have to be sent, the link to the web page of your online script is displayed. 

The connec-
tion to the 
IVS-Online 
server has 

been config-
ured 

 

You can copy the link to the clipboard by clicking the Copy the link to the clipboard ( ) button. 

When you have created a user group, you can download a list of participants by clicking the Down-

load button. You will need this list of participants when you use identified questions in your script. 

For more information about participant lists, see “Creating a list of participants“ on page 123. 

When you click Finish, the final step will be to send a list of questions and corresponding answers 

from your script to the IVS-Online server. This may take a while. 
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The account data and information about the online script and user group are stored in your script. 

So don’t forget to save your script after you have connected to IVS-Online. If you do not save the 

script, the online script can no longer be used later. You will then have to create a new online script. 

This also means that your own alias, which you have linked to this online script, is not usable, and 

can no longer be released for use with another online script. 

Initializing the IVS-Online Gateway 
After having configured the connection to the IVS-Online server, you have to initialize the IVS-Online 

Gateway. This is a virtual Base Station, which ensures that the voting is opened and closed among 

online participants. It works in the same way as a Lite Base Station, which ensures communication 

with the keypads. The IVS-Online Gateway is a virtual Base Station, because you do not have to 

physically connect it to your computer. 

To initialize the IVS-Online Gateway, select Settings from the Communication menu. The Commu-

nication Settings wizard appears. Select the option Set up the clusters manually (advanced) 

and click Next. 

You can select the IVS-Online Gateway on any port. If you do not have real serial ports on your 

computer, you can also use the COM255 virtual port to initialize the IVS-Online Gateway. Select the 

IVS-Online Gateway on port COM255 and click Next. 

Click the Initialize button to initialize the IVS-Online Gateway. Then click Next and then Finish. 

For more information about initializing Base Stations, see “Communication with the Base Station“ 

on page 134. 

Voting using the browser 
To be able to vote, your online participants go to the link that they received in an invitation via email, 

or that you passed on to your online participants in another way. 

Logging in 

If your script is set up so that only a select group of participants can vote, the online participants 

must first log in with the user name and password they have received. 
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An online par-
ticipant first 
has to log in 

 

Both the user name and password are case sensitive. These must therefore be carefully copied. 

After the participant has logged in, the welcome text appears, as set in the configuration wizard for 

the IVS-Online connection. 

The welcome 
text is dis-

played after 
the online 

participant 
has logged in 

 

Voting 

When the voting is opened in IVS-Professional, the question with corresponding answers is displayed 

in the browser of the online participant. 
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The question 
with the cor-

responding 
answers is 

shown 

 

The participant can cast his vote by clicking or tapping one of the answers. The chosen answer 

changes color and the bottom of the screen briefly shows that the vote has been received by the IVS-

Online server. 

The partici-
pant has cast 
his vote and 

this has been 
received by 

the server 

 

After the voting is closed, the welcome text for the next question is displayed. If your online script 

was set to also show the results, the results of the voting will be displayed instead of the welcome 

text. 
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The voting is 
closed 

 

Modifying the online script’s layout 
The layout of the online script is based as much as possible on the script in IVS-Professional. The 

settings of the template are taken over where possible. Modifications to individual slides are not 

taken over, as this would generate too much data when opening the voting. 

The examples in this chapter use a script based on the design template “Online script (widescreen 

16:9)”. In this template the background color of the question is set to blue and the background color 

of the answers to green. Besides, the option to only apply these color to slides in IVS-Online has been 

enabled. The question and answers in IVS-Professional therefore do not get a background color. The 

background color of the question is also used as the background for the standby screens. 

The properties of an answer have an extra tab in the template, called Dynamic background, where 

additional background settings can be made, specifically for use with IVS-Online. 
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The proper-
ties of an an-

swer in the 
template 

 

Under Background when hovering you can have the background color of the answer changed when 

the mouse cursor hovers above the answer. This only applies when the webpage is opened on a 

desktop or laptop, where the answer can be pointed at with the mouse before it is clicked. With a 

smartphone or tablet, no mouse is available and an answer cannot be pointed at. This setting there-

fore has no effect on a smartphone or tablet. 

Under Background when selected, you can have the background color of the answer change as soon 

as the answer is selected. This option applies to all devices on which the web page is opened. When 

a participant clicks or taps one of the answer options, this answer will be selected and the choice 

made will be passed on to the IVS-Online server. To make it clear to the participant what answer he 

has given, the background color of this answer can be changed to a different color. 

If the option No Fill is chosen in either the Background when hovering or Background when selected 

option, the background will remain as set on the Background tab. 

In addition to the background color, the formatting of the text of the question and answers is also 

taken over by the online script. Both font and size, color, bold and italics are applied. The font will 

only be used for the online participant if it is available on his device. For example, if you choose the 

Impact font for the answers, this will not be used on the smartphone of an online participant, because 

the Impact font is not installed there. 
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The position and size of the text boxes for the question and the answers are not taken over. A ques-

tion always appears at the top of the screen, with the answers below. The text boxes for the question 

and answers always cover the full width of the screen, with the answers on both the left and the 

right slightly indented relative to the question. 

If you have made changes to the layout, you must save your script to apply these changes to your 

online script. If you have already opened the webpage of your online script in a browser, you must 

first refresh the page in your browser before the changes to the layout will take effect. 

If you make changes to the questions or answers, they will be automatically sent to the IVS-Online 

server when you open the voting. However, this happens every time you open the voting, which 

causes an unnecessary delay. Therefore, after changing questions or answers, or adding additional 

questions or answers, it is better to first save your script before you open the voting. When saving, 

the changes are also sent to the IVS-Online server, which prevents that this has to be done each time 

the voting is opened. 
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Sending messages with the 

smartphone via IVS-Online 

Your online participants can not only vote with the questions that you put to the vote, they can also 

send interim messages to, for example, the presenter or a panel chair. In these messages they can, 

for example, respond to a presentation, but they can also ask questions that could then be answered 

by a panel. 

Participants can send messages from the same web page that they use for voting. With the help of 

two buttons at the top of the page, they can switch between voting and sending messages. When 

you open the voting, the page automatically switches to voting, so that the participants are given 

the opportunity to cast their vote. 

Sending messages is independent of voting with IVS-Professional. Your participants use the same 

webpage, but the messages are only sent to the IVS-Online server and can be viewed and moderated 

via another webpage. This does not require IVS-Professional. However, configuring the option to 

send messages is done from the same configuration wizard that you use to configure online voting. 

Configuring message sending 
If you have not yet connected to IVS-Online, start the configuration wizard by selecting Configure 

IVS-Online connection from the Connection menu. See “Configuring the IVS-Online connection” 

on page 231 on how to do this. 

If your script is already connected to IVS-Online, you can also select the Configure Message Send-

ing option in the Connection menu. This will skip the first steps of the wizard. 

Setting extra options 

If you have selected the Configure Message Sending option, the configuration wizard will start at 

the page for setting additional options. Here you enable the Message sending option to be able 

to configure this option. 
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Configuring 
the sending 
of messages 

 

Creating a message queue 

The messages that your participants send are stored in a message queue. You can create a new 

message queue that is linked to your online script, but you can also link an existing message queue 

to your online script. 

Creating a 
new message 
queue or us-
ing an exist-

ing queue 

 

Create a new message queue  With this option you create a new message queue and link it to 

your online script. 

Use an existing message queue  With this option you can link a previously used message queue 

to your script. If there are any messages in this queue, they will just remain. Your online participants 

can add additional messages to this message queue. 
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The properties of a message queue 

You can set four properties of a message queue. In addition to the name of the message queue, you 

can also adjust the texts that your online participant will see on the message page. This message 

page consists of a text box in which the participant can type his message text and a button with 

which the message is sent. 

Setting the 
properties of 
the message 

queue 

 

If you have selected an existing message queue, this screen will be populated with the data from the 

selected message queue and you can change this information if necessary. 

Under Name, enter a name for this message queue. This name is only an indication of this message 

queue, and is used, for example, when you later want to link this message queue to another online 

script. 

Under Message box caption, enter a text that will appear above the text box on the message page. 

Under Message box placeholder text you enter a text that will be placed in the text box. This text is 

only a placeholder text. This is displayed as long as the user has not entered his own text, and cannot 

be sent. 

Under Submit button caption, enter a text that will be displayed on the send button. 

The texts that appear in the three text boxes when you have created a new message queue are also 

placeholder texts. They disappear as soon as you enter your own text. If you do not enter your own 

text, these placeholder texts will be used for the text box and the submit button on the message 

page. 
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The properties of the message wall 

The messages sent by the participants are displayed on a message wall. You can adjust a number of 

properties of this message wall. 

Setting the 
properties of 
the message 

wall 

 

The message wall is a fairly simple webpage, which displays the messages sent by the online partic-

ipants. You can, for example, display this message wall on the big screen during your meeting. 

By clicking on the Load Image button, you can load an image that is displayed as a logo on the 

message wall. The logo is displayed in a header at the top of the message wall. If you have selected 

an image, you can also set a background color for this header. 

Under Number of message columns you can set in how many columns the messages are displayed 

on the message wall. You can choose from a fixed number of columns, but you can also have the 

number of columns determined automatically. Depending on the amount of messages and the 

amount of text in a message, the messages are automatically divided into several columns. 

Summary 

Before your message queue is actually created and set up, a summary of the settings is first displayed. 

Only in the next step will all settings be actually sent to the IVS-Online server. 

Completing the wizard 

After all settings have been sent to the IVS-Online server, the link to the web page of your online 

script is displayed. In addition, two additional links are displayed. One refers to the message wall, 

the other to a moderator page, on which a moderator can first moderate the messages before they 

appear on the message wall. 
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The connec-
tion to the 
IVS-Online 
server has 

been config-
ured 

 

Sending messages via the browser 
When the online participant logs on to the web page of your online script, two buttons now appear 

at the top of the page. With the Voting button the participant can participate in the voting, with the 

Message button the participant can send a message. 

Sending a 
message to 

the modera-
tor 
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Moderating messages 

The messages sent by the participants are not published directly on the message wall. This is to 

prevent all sorts of nonsensical messages from appearing on the message wall. Instead, the mes-

sages are first sent to a moderator. This moderator determines whether or not a message is published 

on the message wall. 

You can moderate the messages yourself by going to the website https://ivs.eu/moderate and logging 

in with the details of your IVS-Online account. Then select the desired message queue. You will then 

see all messages that are in this message queue. 

When you have someone else do the moderation, it is not useful to give your account details away. 

That is why you can designate a guest moderator who can access your message queue via a special 

link. 

A link to the moderator page of your online script is displayed at the end of the configuration wizard. 

This is a shortened link to a registration page for moderation. On this page you can log in with your 

account information from IVS-Online. You will then see the special link for the guest moderator. 

You can request the link for the moderator page from IVS-Professional by selecting Show Moderator 

Link from the Connection menu. 

The link for 
the modera-

tor 

 

The link displayed in this window is the same short link that was also displayed at the end of the 

configuration wizard. If you follow this link, you still need to log in before you can moderate the 

message queue. If you click on the Copy Link Location button, the full link is copied to the clipboard. 

When you go to the webpage via this full link, you do not have to log in and you can immediately 

moderate only this single message queue. 

https://ivs.eu/moderate
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The full link is also coded in the QR code image. You can scan it directly to open the message queue 

moderation page, or you can copy it to the clipboard by clicking the Copy QR Code Image button. 

You can then, for example, paste this image into an email and mail it to your guest moderator. 

The web page 
for moderat-
ing messages 

in the mes-
sage queue 

 

An overview of all sent messages is displayed on the moderation page. Each message includes the 

user name and IP address used to send the message. The moderator can publish a message on the 

message wall by placing a checkmark at Publish. Optionally, the message can be marked by checking 

Mark. A marked message is displayed on the message wall using a different text color and a slightly 

larger font. 

The moderator can also delete a message by clicking the Delete button. He can change the message 

text by clicking the Edit button. Finally, he can adjust the color of the message by clicking the Color 
button. Every message is assigned a random color by default. 

Showing the message wall 

The messages published by the moderator will be placed on the message wall. The message wall is 

a web page that can be displayed in a browser. 

You can view the message wall yourself by going to the website https://ivs.eu/wall and logging in 

with the details of your IVS-Online account. Then select the desired message queue. You will then 

see the message wall with all messages published by the moderator. 

At the end of the configuration wizard a link is displayed to the web page of the message wall of 

your online script. This is a shortened link to a message page for the message wall. On this page you 

can log in with your account information from IVS-Online. You will then see the special link for the 

message wall. 

https://ivs.eu/wall
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You can request the link for the message wall from IVS-Professional by selecting Show Message 

Wall Link from the Connection menu. 

The link displayed in this window is the same short link that was also displayed at the end of the 

configuration wizard. If you follow this link, you still need to log in before you can view the message 

wall. If you click on the Copy Link Location button, the full link is copied to the clipboard. When you 

go to the webpage via this full link, you do not have to log in and you can immediately view the 

message wall for this single message queue. 

The web page 
for the mes-

sage wall 

 

 



260 

Preferences 

Using the preferences you can change some of the options of IVS-Professional. You can, for instance, 

change what happens when IVS-Professional is started. And for the editing of a script, you can 

change the distance of the grid and the mouse sensitivity. 

You can change the preferences by selecting the option Preferences from the File menu. 

Select the option Preferences from the File menu. 

The dialog box for changing the preferences is displayed. 

Dialog box 
with the pref-

erences 

 

Startup 
On the Startup tab you can choose what you want to happen when IVS-Professional starts. Normally, 

the startup dialog is displayed, but you can also choose to immediately create a new script, or to not 

do anything at all. 

Show the startup dialog When starting up, the startup dialog is shown. Within this dialog, you 

can choose to open one of the last used scripts, or to create a new script. 

Open the last used script When starting up, the last script you used is automatically opened 

again. 
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Open a previously saved script After starting up IVS-Professional, the default dialog box for 

opening is script is displayed. You can then choose which script you want to open. 

Create a new script IVS-Professional starts with a new empty script. 

No action IVS-Professional just starts up, without opening a script or displaying a dialog box. 

Display a warning when the Base Station could not be initialized during the startup 

of IVS-Professional When this option is checked, a warning is displayed upon startup of IVS-

Professional if the Base Station could not be initialized, while IVS-Professional was set up to auto-

matically initialize the Base Station. If this option is not checked, no warning will be displayed when 

initializing fails. 

Display a warning when a connection to IVS-Online could not be established when 
the script is opened If this option is checked, a message will be displayed when IVS-Professional 

is started and a connection to IVS-Online could not be established, while the script is set to connect 

to IVS-Online. If this option is not checked, no notification will be made if the connection to IVS-

Online fails. 

Edit 
On the Edit tab you can set up how far a duplicate should be moved with regard to the original 

object, what the grid size is and what the mouse sensitivity is. 

Duplicate placement 

When duplicating an object, you can have the object moved compared to the original at the same 

time. You can set the horizontal as well as the vertical displacement. The displacement can both be 

positive – the duplicate will be moved down or to the right – and negative – the duplicate will be 

moved up or to the left. The maximum horizontal displacement is half of the screen width, the max-

imum vertical displacement is half of the screen height. This is true for both positive and negative 

displacement. 

When you enable the button between the horizontal and vertical placement, the horizontal and ver-

tical placement are kept the same. 

Grid size 

If you use the grid to easily align objects, you can change the distance between the grid markers 

here. You can set both a horizontal and vertical grid spacing. The minimum distance is 8 points, the 

maximum horizontal distance is half of the screen width and the maximum vertical distance is half 

of the screen height. 

When you enable the button between the horizontal and vertical distance, the horizontal and vertical 

distance are kept the same. 
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Mouse sensitivity 

The mouse sensitivity determines how far you have to move the mouse before an object is moved. 

The default sensitivity is 10, which means that only when you move the mouse 10 points, the object 

moves along with it. The higher the number of the mouse sensitivity, the further you have to move 

the mouse before an object moves along with it. The minimum sensitivity is 1, the maximum sensi-

tivity is 10. 

Snap distance 

If you use the Snap to objects option, the snap distance determines how close the moved object 

needs to approach another object before the moved object is automatically aligned with one of the 

edges of the other object. The minimum distance is 2, the maximum distance is 20. 

View 
On the View tab you can indicate on which monitor you want to show the presentation screen and 

the screen’s aspect ratio. 

Multiple monitors 

When your computer or laptop has multi-monitor support and you set up the second monitor to use 

the extended desktop, you can select on which of the monitors you want the presentation screen to 

be displayed. This allows you to display the presentation screen through a beamer connected to your 

laptop, while the edit screen is displayed on the laptop’s internal display. There is no need to display 

the toolbar in the presentation screen. You can follow the progress of the voting through the edit 

screen. 

If you choose the Automatic option, the presentation screen will be displayed on the first monitor 

that is not the primary monitor when more than one monitor is available. If only one monitor is 

available, the presentation screen will be displayed on this monitor. 

Screen size 

The screen size specifies the size a slide is to be displayed in, when it is set to 100% display. The 

screen size also determines whether the slide is displayed on a wide-screen monitor or on a standard 

monitor. You can choose from a number of standard sizes, but you can also specify a screen size 

yourself. 

Standard (4 : 3) With this setting, the slide is 1,024 pixels wide and 768 pixels high. The ratio is 

4 : 3. This ratio is particularly suitable for older types of projectors. 

Widescreen (16 : 9) With this setting, the slide is 1,280 pixels wide and 720 pixels high. The ratio 

is 16 : 9. This ratio is suitable for the newer types of projectors. 

Widescreen (16 : 10) With this setting the slide is slightly higher, namely 800 pixels. The ratio is 

16 : 10. This ratio is suitable for some types of widescreen monitors. 
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Full HD (16 : 9) With this setting, the slide has the size of a Full HD screen, namely 1,920 pixels 

wide and 1,080 pixels high. The ratio is 16 : 9. This setting is suitable for the newest projector types 

and most monitors. 

Double Full HD (32 : 9) With this setting, the slide is extra wide, which corresponds to two adja-

cent Full HD monitors. The slide is 3,840 pixels wide and 1,080 pixels high. This setting is suitable 

for ultrawide monitors or for two projectors projecting side by side. 

4K Ultra HD (16 : 9) With this setting, the slide has the size of a 4K Ultra HD screen, namely 3,840 

pixels high and 2,160 pixels wide. This setting is suitable for 4K monitors and 4K projectors. 

8K Ultra HD (16 : 9) With this setting, the slide has the size of an 8K Ultra HD screen, namely 

7,680 pixels high and 4,320 pixels wide. This setting is suitable for 8K monitors and 8K projectors. 

Custom With this setting you can set the dimensions of the slide yourself. You can set both the 

screen width and the screen height and thus determine the ratio yourself. 

If you change the screen size while you have one or more scripts opened, some of the objects might 

not or not entirely fit on the slide. 

If you open a script that was made with a different screen size, the software temporarily switches to 

the screen size the script was made in. 

Presenting 
On the Presenting tab you can set up whether you are using a Wireless Presenter to open and close 

the voting. 

Use a Wireless Presenter to open/close the voting Enable this option if you are using a 

Wireless Presenter and want to be able to open and close the voting with it. 

The Presenter alternately sends F5/Esc Most Presenters have a button to start and stop the 

presentation in Microsoft PowerPoint. The first time this button is pressed, it sends an F5 keystroke 

to the computer, the second time you press it, it sends an Esc keystroke. F5 can be used to open the 

voting. By selecting this option, the Esc key is set up to close the voting. Please note that you won’t 

be able to use the  key on the keyboard anymore to cancel the voting. The  will close the voting 

normally. 

The Presenter sends a certain key, namely B Other Presenters have a button that sends a 

specific keystroke to the computer. For instance, this could be the B to blank the screen in Microsoft 

PowerPoint. By selecting this option, the Change voting menu option will be set up to use this key. 

You can then use this button to change the voting, that is, open and close it. 

Please note that when closing IVS-Professional, the Use a Wireless Presenter to open/close 

the voting option is automatically disabled. This is to prevent that the  key would stay set to 

close the voting, which would make it impossible to ever cancel the voting. 
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Language 
On the Language tab you can indicate in which language you want to use the software. To use the 

software in multiple languages, you can install additional language packs. For each language pack 

that you install, the language appears in the list of display languages. 

In the list of display languages you set a priority order for the languages to be used. The software is 

displayed in the language at the top of the list, unless the software is not available in this language. 

In that case the next language in the list, that is available, is used. 

You can select a language in the list and move it up and down the list with the up and down arrow 

buttons. The Set as Default button places the selected language at the top of the list, making it the 

default language for the software. With the Match Microsoft Windows option, the software uses 

the same language that is set for Windows. If you use Windows in a different language, the software 

will also use this language, provided that it is available for the software. 

Note that the language you select in the list is not the language used for the software. To use this 

language, you must first place it at the top of the list with the Set as default button. 

The language setting is a global setting that applies to all IVS software. If you change the language 

of IVS-Professional, the new language also applies to IVS-Risk Analysis (when you have installed this 

package) and to all utilities. An exception is IVS-PowerPoint, which always uses the same language 

that Microsoft Office is used in (provided that this language is available for IVS-PowerPoint). 

Updates 
On the Updates tab you can indicate how often you want the software to check for available updates. 

You can choose from once a day, once a week, once a month, or not at all. You can always manually 

check whether an update is available by choosing the Check for updates option from the Help 

menu. 
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Troubleshooting 

It is possible that you run into trouble during a session. For example, someone could stumble over 

the power cord of your Base Station, which leaves the Base Station disconnected. The following 

scenarios describe what could happen and what you have to do to bring the session to a successful 

ending. 

Scenario 1: Keylock not connected 
You have arrived at the location where you are about to give your session, with plenty of time to 

spare. All keypads are in the charging case and are fully charged. You start IVS-Professional and start 

the initialization of the keypads. You take 100 keypads out of the cases. If you take a look at the 

initialization box, you see that only 30 keypads have been initialized and no more are being initial-

ized. 

Initialization 
stops at 30 

keypads 

 

You check the keylock and discover that you forgot to connect it. To continue the initialization, you 

do the following: 

 Stop the initialization of the keypads. 

 Connect the keylock to a USB port of the computer. 

 Continue initializing the keypads by choosing the option Initialize all keypads from the Commu-

nication menu. 

Scenario 2: Wrong keylock or keylock forgotten 
Just like in scenario 1 it turns out that you cannot initialize more than 30 keypads. While checking 

the keylock you discover that you have connected a keylock that it is not suitable for this version of 

IVS-Professional. On top of that, you forgot to take the correct the keylock. To continue the initiali-

zation, you do the following: 

 Stop the initialization of the keypads. 

 Choose the option Temporary license from the Help menu. With this option you can purchase a 

temporary license without having to connect a keylock. The dialog box for the temporary license 

appears. 



266 

Dialog box 
for request-

ing a tempo-
rary license 

 

 In the Temporary license dialog box you see a program code, consisting of two blocks of five letters 

or numbers. You now call one of Interactive Voting System employees and tell him or her this pro-

gram code. In exchange for this code you will receive a temporary license code, consisting of three 

blocks of five letters or numbers. You enter this in the three edit boxes. 

The tempo-
rary license 

code has been 
entered 

 

 If the temporary license code was entered correctly, you see how many keypads can be used with 

this license and how long this license will remain valid. Click OK to activate this license. 

 Continue initializing the keypads by choosing the option Initialize all keypads from the Commu-

nication menu. 

Scenario 3: Base Station powerless while initializing keypads 
While you are initializing the keypads, someone pulls a plug somewhere, resulting in your Base Sta-

tion becoming powerless. Of course, the initialization stops, but not all keypads have been initialized. 

To continue initializing, you do the following: 

 If it has not been done yet, reconnect the power to the Base Station. 

 Initialize the Base Station by choosing the option Initialize cluster from the Communication menu. 
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 Click the Initialize button in the Communication Settings dialog box. When the Base Station has 

been reinitialized, click on the Finish button. 

 All keypads have to be reset. This is done by placing them in the charging cases, while the charging 

cases are connected to the power supply. If you are using RF-I keypads, these keypads have to stay 

in the charging case for at least 5 minutes. If you are using RF-II keypads, they are reset immediately 

when they are placed in the charging case. If you are using Lite keypads, then they don’t need to be 

reset. 

 Restart the initialization of the keypads by choosing the option Initialize all keypads from the 

Communication menu. 

 Take all keypads you want to use out of the charging cases. 

Scenario 4: Base Station powerless before session has started 
Just like in scenario 3, your Base Station becomes powerless. However, all keypads are already ini-

tialized. You had not yet started your session. 

When the keypads are being initialized, the Base Station keeps a list of all initialized keypads. After 

initializing the keypad, you save this list. When the Base Station becomes powerless, it will lose the 

list of keypads, so that it doesn’t know which keypads are initialized. The keypads themselves are 

still initialized and therefore it is not necessary to reinitialize them. To continue your session, you do 

the following: 

 If it has not been done yet, reconnect the power to the Base Station. 

 Initialize the Base Station by choosing the option Initialize cluster from the Communication menu. 

 Click the Initialize button in the Communication Settings dialog box. When the Base Station has 

been reinitialized, click on the Finish button. 

 You will have to place the list of initialized keypads back into the Base Station. You do this by choos-

ing the option Load initialized keypads from the Communication menu  

 The standard dialog box for opening files appears. Select the list of keypads that you have saved 

before and click Open. 

 A dialog box appears in which you can see how many keypads have already been loaded into the 

Base Station and how many have to be loaded in total. 

The list of 
keypads is 

placed back 
into the Base 

Station 

 

 After the list has been reloaded, you will be asked if you want to test the network. This allows you 

to see if the communication with the keypads has been restored correctly. Click Yes to test the net-

work. The dialog box for testing the network will appear. 
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 After having checked that all keypads function correctly, click Stop to end the testing of the network. 

Scenario 5: Base Station becomes powerless during a session 
Just like in scenario 3 and 4 the Base Station becomes powerless. You already started the session 

and have voted on some of the questions. In the presentation screen, no dialog boxes are displayed 

on screen. You notice that the Base Station became powerless, because in the toolbar at the bottom 

of the screen “Offline” is displayed, instead of “Stand-by”. It could be that “Offline” will appear at 

the moment you open the voting. To continue your session, you do the following: 

 If your projector has a pause mode, use this, so the audience doesn’t see what you are doing. 

 Go back to the edit screen by pressing . 

 Follow the steps as described in scenario 4. 

 Restart the presentation by pressing . 

 Take the projector out of the pause mode. 

Scenario 6: Computer crashes during a session 
While you are doing a session, your computer crashes for whatever reason. You have to restart the 

computer to be able to work with it again. To continue the session, you do the following: 

 If it has not been done yet, restart your computer. 

 Start IVS-Professional. When you start IVS-Professional, the Base Station will be initialized automat-

ically. 

 In the start-up dialog of IVS-Professional, you select the script you were working with. If the script is 

not displayed, you click on the More scripts… button. In the standard dialog for opening files, you 

open the desired script. 

 You open the same session you were working with. You do this by choosing the option Import from 

the File menu. 

Dialog for im-
porting ses-

sions 

 

 Select the session you were working with and click OK to import this session. 

 Go to the slide where you were before the crash. 

 Start the presentation by pressing . 
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Scenario 7: Base Station powerless or computer crashes during 
session 

While you have opened the voting, the Base Station becomes powerless or the computer crashes. To 

continue your session, you do the following: 

 If your Base Station got powerless, follow the steps as mentioned in scenario 5. 

 If your computer crashed, follow the steps as mentioned in scenario 6. 

 Open the voting again for the question where you were. The audience has to vote for this question 

again, because some votes could be lost during the power loss or the crash.
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